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Computers have become the life line of today’s high-tech world. There is no work, in our 
whole day, for which we are not dependent on computers or the technology products. 
The use of computers has overpowered our life and we have got addicted to computers 
to a great extent. Computers have actually brought a revolutionary change in the whole 
way, with which the education and the work culture are practised. Learning the basics of 
computers is highly important for the students to excel in their respective fields. Computers 
help students to learn better and learn the practical aspect of the subject. 

Computer Zone-Book 6 is one of a series on computer science designed for all the categories 
of students of Nepal. The book 10 of this series is recommended for use in class 6.  

This book is designed for the new generation of students who need to acquire knowledge 
on the theory, application and programming aspects of computing. Logical and scientific 
in its approach, the series covers the history of computer, its accessories, applications and 
programming in a step-by-step and graded manner. It has been prepared to focus creativity 
and encourage young children to explore and experiment with learning opportunities. 
The special features of this edition which highlights the important points covered in each 
chapter are given below:

a.	 Learning objectives	 b.	 Expanding your Horizons

c.	 Facts Corner	 d.	 Brainstorming Task

e.	 Trick Terms	 f.	 Solved Exercises

g.	 Chapter Review	 h.	 Lab Exercises

A lot of research and meticulous attention to detail have gone into the making of this book. 
However, there is always scope for improvement. Constructive criticism and suggestions 
which could be incorporated in the future editions of this book, are welcome in my mailing 
address hari99_sapkota@yahoo.com.

We earnestly hope that the students would find the journey through this series an enjoyable 
experience and gain a sound working knowledge on the basic aspects of computing that 
lay the foundation for good and systematic programming. 

-Author
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Objectives

After completing this chapter, you will be 
able to:

		 Define a computer and state the major 
characteristics of a computer.

		 Explain the important characteristics of a 
computer.

	 Identify the basic operations of a 
computer.

	 Explain the impacts of computer usage in 
various sectors of our society.

Computer
Technology
Overview
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Concept-Data Processor
Computers are the central tools in the informational society. Computer is being used 
in every sphere of our everyday life. We see computers everywhere-in schools, homes, 
offices and libraries. But there are also millions of computers working behind the scenes 
in trade and industry. They are also the tools for learning, recreation and are a perfect 
communication medium. They are spreading further and further into our daily lives. 
They have revolutionized the various aspects of life-style in the present era. They have 
become so deeply embedded in our society that almost no activity would be possible 
without them.

Computer is a digital electronic processing device designed to accept input data, process 
them, produce output results and store results for future use. Computer operates under 
the control of instructions stored in its own memory unit. A set of detailed, step-by-step 
instructions that tells a computer how to solve a problem or carry out a task is known as 
computer program. The steps in a computer program are written in a language that the 
computer can interpret or “understand”. Programs usually reside within the computer and 
are retrieved and processed by the computer’s electronics. 

A look to Future

Flexi-Computer
Microchips in computers continue to get smaller, so that the 
biggest parts are the keyboard and screen. Perhaps one day 
these will be contained on a flexible sheet, like a piece of 
cloth or a pocket handkerchief. Unroll it for use, then simply 
roll it away into its pocket-sized tube for storage. The flexi-
computer would operate by solar power, so it would never 
need batteries. 

A humanoid robot is a robot with its overall appearance based on that of the 
human body. A humanoid design might be for functional purposes, such as 
interacting with human tools and environments, for experimental purposes, 
such as the study of bipedal locomotion, or for other purposes.
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Advantages of computer 
•	 Computer is faster than human beings.
•	 Computer is 100% accurate and much more 

reliable.
•	 It is a versatile and can perform various 

types of works.
•	 Computer can store large amount of data 

and information.
•	 Computer provides meaningful information 

to the user.
  

Disadvantages of Computer
•	 It is expensive and beyond the reach of poor people.
•	 It is an electronic machine, so there is much danger of electric shock.
•	 Repair and maintenance is required frequently.
•	 Skilled manpower is required to work in the computer.

•	 It has increased dependency on machine.

Knowledge Update

A facial recognition system is a computer-
driven application for automatically identifying 
a person from a digital image. The German 
Federal Police use a facial recognition system 
to allow voluntary subscribers to pass fully 
automated border controls at Frankfurt Rhein-
Main international airport.

Computer performs the three major tasks, namely, accepting data and instructions as input, 
processing the data according to the instructions to generate a meaningful information 
and communicating this information to the user as output.
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Basic Operations of Computer
The four basic operations of a computer are input, process, storage and output.
Input 
A computer accepts input. Input is any information the computer collects from the outside 
world. The input can be in the form of text, programs, commands and user responses. The 
device that collects the input and sends it to the computer is called an input device. Input 
devices include keyboard, pointing devices, scanners, web camera, digital camera, audio 
and video input devices. 
 
Process
A computer processes data. The manipulation of the raw data on the basis of the instruction 
is called processing. A computer processes data in a device called the Central Processing 
Unit. 

Storage
A computer stores data. Storage is the place where data is held in an electromagnetic or 
optical form for access by a computer processor. Storage has been divided into: 
(1) 	Primary storage, which holds data in memory (sometimes called random access 

memory or RAM) 
(2) 	Secondary storage, which holds data on hard disks, tapes, and other devices requiring 

input/output operations.

Output
A computer produces output. Output is any information the computer sends to the outside 
world. It can appear in a variety of forms such as text, graphics, audio and video. The 
device that supplies information and sends the results of computation to the outside world 
is called an output device. The most common output devices are computer monitors, 
printers and speakers. 
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Characteristics of Computer
All computers have certain common characteristics irrespective of their type and size. 
Computers are capable of doing complex activities and operations. Computers can be 
programmed to do complex tasks. Computers perform a wide variety of activities reliably, 
accurately and quickly. The power and usefulness of this machine are mainly due to 
following characteristics.

Speed

Computers work at an incredible speed. As the power of computer 
increases, the speed also increases. The time used by the computer to 
perform an operation is called the processing speed. Today’s Computer 
can perform its task in speed of light. The speed of computer is calculated 
in MHz(Megahertz)that is one million instructions per second. Today, a 
powerful computer can perform billions of operations in just one second.

Accuracy

The accuracy of a computer is very high i.e. almost 100%. They can perform 
calculations with great accuracy as their circuits have no mechanical parts 
to wear and tear. They only execute instructions input by man. There may 
be errors produced by the computers. Sometimes, it is due to the fault in the 
machine and more often due to ‘bugs’ in the programs. If the input data are 
not correct, this may also lead to incorrect output. The computers follow 
the simple rule of GIGO (Garbage In Garbage Out).

Automation

Computer is   an   automatic   machine,   capable   of functioning 
automatically, once the appropriate set of instruction (program) and data 
are provided to the computer. Once a task is initiated in a computer, it can 
proceed automatically.

Diligence

Human beings suffer from physical and mental fatigue. They cannot 
perform the same task over and over again with the same speed and accuracy 
as in the first time. This will affect the performance. Being a machine, a 
computer does not suffer from such weaknesses. The computer is capable 
of performing task repeatedly at the same level of speed and accuracy even 
if it has to carry complex operation for a long period of time.

Versatile

A computer is a versatile machine. It can be used in various sectors 
to perform a variety of tasks. It has been put to   use for all sorts of 
applications ranging from complex calculations in scientific research 
and space research to routine office work. The invention of computer 
networks and the Internet has made the world a ‘global community’. All 
this is possible because of computers and other related technologies.

Reliability

Computers have high degree of reliability because they carry out the 
calculations with high speed and accuracy. Computers do the calculation 
repeatedly without making mistakes. And their circuits have no 
mechanical parts to wear and tear like in other machines.
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Computers on the Job
Computers have become the technical foundation of information systems. They are 
spreading further and further into our daily lives. It has invaded all types of workplaces, 
from offices to factories. The practical applications of computers are endless. A broad 
classification of its uses in varied fields are explained below:

Computers in Education	
Computers are used as teaching aids, research tools and analyzing systems in educational 
institutions. Teachers use computers to organize and prepare course materials; children 
are being taught to use computers at an early age; and more and more institutions are 
using computer-assisted instruction systems, which offer interactive instruction on a 
one-to-one basis and can be automatically modified to suit the user’s level of ability. 
Educational software has become a major influence at all levels from elementary schools to 
universities. A computer’s voice recognition capabilities and its connection to the Internet 
makes it possible for special education users to participate in learning experiences. Video 
conferencing may be used for lectures, enabling two-way communication and discussion.

Knowledge Update

A video-conference (or Video Conference) is a live video 
connection between people in separate locations for the 
purpose of communication or interaction. Video-conferencing 
allows people to communicate visually from anywhere in the 
world. 

Brainstorming 

  task
Complete each statement in the spaces provided with the help of Clue Box help line.
 Computer, versatile, processing speed, output, Digital

a. 	 Computer is a ……………….electronic processing device

b. 	 …………. provides meaningful information to the user.

c.	 The four basic operations of  a computer are input, process, storage and……….

d.	 A computer is a …………….machine because it can be used in various sectors to 
perform a variety of tasks.

e. 	 The time used by the computer to perform an operation is called the …………….
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Computers at Home
Computers have already changed our lives at home. New gadgets such as automatic 
washing machines, dishwashers and microwaves have made our lives easier. Many 
of the educational software programs are used by children at homes. These programs 
enrich students’ knowledge and skills. Encyclopedia, dictionaries, telephone directories 
and medical references are now available in CD-ROM which contains multimedia 
capabilities. Internet connections also provide electronic mail, discussion groups, and 
other communication options for home users. Apart from learning, computers also offer a 
new form of entertainment. They are used for playing computer games.

Facts Corner One of the world’s leading computer and computer peripheral manufacturer Hewlett Packard was 
first started in a garage at Palo Alto in the year 1939. 

Computers in Entertainment	
Computers have now become an important part of the entertainment industry. They are 
widely used to create special effects in movies. They are used in editing movies and 
multimedia presentations. They help in composing, editing, recording and reproducing 
music and sound effects. They are used by sports professionals to analyze their techniques 
to find their strengths and weaknesses. They are used to simulate games and to try out 
different game strategies. 

Facts Corner The house of Bill Gates was designed using a Macintosh computer. 

Computers in Medicine	
Computers are revolutionizing the medical field. Computers are used in the medical 
field for performing a wide variety of tasks. They are used in medicine from diagnosing 
illnesses and monitoring patients to controlling movements of robotic surgical assistants. 
They provide a complete, accurate, up-to-date and readily available source of information 
about patients’ health. Many medical scanners for exploring inside the body only work 
because of computer power. They are also used to monitor the availability of bed, staff 
payroll, hospital accounting, patient billing, drug inventory and location of doctors 
and patients in large hospitals. They have reduced the barriers of distance and time via 
telemedicine and on-line access to laboratory test results and medical researches.
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Let 
Us Revise
•	 Computer is a digital electronic processing device designed to accept input data, 

process them, produce output results and store results for future use. 
•	 A set of instructions that performs a particular task is called a program.
•	 The major characteristics that make the computer such a powerful machine can 

be enumerated as speed, accuracy, storage, automatic, diligence, versatile and 
reliability.	

•	 Input is any information the computer collects from the outside world. 
•	 The manipulation of the raw data on the basis of the instruction is called processing. 
•	 Storage is the place where data is held in an electromagnetic or optical form for 

access by a computer processor. 
•	 Output is any information the computer sends to the outside world.
•	 Computers can be used for repetitive, time consuming as well as dangerous jobs.
•	 Computers are used as teaching aids, research tools and analyzing systems in 

educational institutions. 
•	 Computers are used in medicine from diagnosing illnesses and monitoring patients to 

controlling movements of robotic surgical assistants.
•	 Computers are used for various tasks such as online enquiry of customer’s balance, 

cheque verification, updating the balance, calculating interests and printing customer 
statements. 

Computer 	 A digital electronic processing device designed to accept input data, 
process them, produce output results and store results for future use.

Program	 A set of instructions that performs a particular task.
Information	 The meaningful data that results from the processing of the unorganized data. 
Output	 Any information the computer sends to the outside world.
Multimedia	 The combination of multiple media such as text, images, video, 

animation and audio.

Tricky Terms

1. 	 Draw a figure of computer with the different parts name and explain the advantages of 
computer on a chart paper.

2. 	 Visit our school or local surrounding and mention the list for what purpose computers 
are used.

Project Work
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Solved Exercises
1.		 Define computer.	
Ans:	 Computer is a digital electronic processing device designed to accept input data, process them, produce output 

results and store results for future use.  

2.		 What is a program?
Ans:	  A set of sequenced instructions used to direct and control the operations of the computer in order to solve a 

problem or perform a particular task is known as computer program. 

3.		 What are the four basic operations of a computer?
Ans:	 The four basic operations of a computer are input, process, storage and output.

4.	 What are the positive impacts of computers?
Ans:		 The positive impacts of computers are listed below:
	 a.	 Computers are incredible learning tools. The students can use computers to access vast knowledge bases on 

almost any topic, search archives of information and even take online courses. Computer communications 
provide new opportunities for distance learning. 

	 b.	 Computers can be used for repetitive, time consuming as well as dangerous jobs.
	 c.	 Computers and the Internet have been responsible for many positive changes that have taken place within 

society. The Internet forms a vast, web-like system around the world, through which computers can exchange 
information at high speed. 

	 d.	 Computer technology has helped to  promote more production and  distribution of products.

5.	  How are computers used in education?
Ans:	 Computers are used in education for processing applications, maintaining academic records and transcripts, 

raising funds, e-mail correspondence, library cataloging, distance learning, direct instruction via educational 
software, sharing of information among academic researchers worldwide, and for word processing and research 
in computer centres.

6.	 How has computer technology helped to improve the quality of patient care?
Ans:	 Information technology has helped to improve the delivery of patient care in a number of different ways. It 

has reduced the barriers of distance and time via telemedicine and on-line access to laboratory test results and 
medical research. It has improved the delivery of health care by making health care information more accessible 
to patients. It has also helped to contribute to the design of better health care programs.
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Chapter Review
1.	 State whether the following statements are true or false. 
a.  	 Computers have become so deeply embedded in our society that almost no activity 

would be possible without them.
b.	 Programs usually reside within the computer and are retrieved and processed by the 

computer’s electronics.
c.	 	Secondary storage is a storage unit that holds data in memory (sometimes called 

random access memory or RAM). 
d.	 Computers are used as teaching aids, research tools and analyzing systems in 

educational institutions. 
e.	 The Internet forms a vast, web-like system around the world, through which computers 

can exchange information at high speed. 

2.	 Fill in the blanks. 
a.  	 _____________________is a digital electronic processing device designed to accept 

input data, process them, produce output results and store results for future use.
b.	 The device that collects the input and sends it to the computer is called 

an________________________.
c.	 The manipulation of the raw data on the basis of the instruction is 

called_____________________.
d.	 ___________________is the place where data is held in an electromagnetic or optical 

form for access by a computer processor. 
e.	 The device that supplies information and sends the results of computation to the 

outside world is called an________________________. 

3.	 Match each term with the statement that best describes it. 
	  Program		 A digital electronic processing device designed to accept 

input data, process them, produce output results and store 
results for future use.

	 Computer		 A set of instructions that performs a particular task.
	 Output		 The meaningful data that results from the processing of the 

unorganized data. 
	 Multimedia		 Any information the computer sends to the outside world.
	 Information		 The combination of multiple media such as text, images, 

video, animation and audio.
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4.	 Give the appropriate technical term for each of the following statements.

a.	 A digital electronic processing device designed to accept input data, process them, 
produce output results and store results for future use. 

b.	 A set of detailed, step-by-step instructions that tells a computer how to solve a 
problem or carry out a task. 

c.	 Any information the computer collects from the outside world.

d.	 The manipulation of the raw data on the basis of the instruction.

e.	 The place where data is held in an electromagnetic or optical form for access by a 
computer processor. 

5.	 Give the full forms of the following abbreviations.

	 a.	 RAM			   b. CD-ROM	  		  c. ATM 

6.	 In your own words, briefly answer the following questions.

a.	 What is a computer?  

b.	 What are the important characteristics of a computer?	

c.	 Discuss the limitations of a computer.

d.	 What are the four basic operations in a computer?	

e.	 What do you understand by the terms: 

	 i) 	 Input  			   ii) 	 Process

	 iii) 	 Storage			   iv) 	 Output

f.	 List any three positive impacts of computer technology in our society.

g.	 What are the two negative impacts of computer technology in our society?

h.	 How have computers affected education?

i.	 What roles do computers play at home?

j.	 What effects have computers had on the practice and enforcement of law?

k.	 How have computers changed entertainment?
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Objectives

After completing this chapter, you will be 
able to:

	Define hardware and list the main 
hardware elements.

	Define CPU and explain the two main 
elements of the CPU.

	Define software and explain the two 
categories of software.

Computer 
Hardware
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Computer Hardware
Computer hardware is one of the most important element of a computer system which 
carries out different vital computer operations. Hardware refers to the physical components 
of the computer system. It consists of interconnected devices that are capable of computing 
and processing information. It is controlled by software. It includes all the input, output 
and storage devices plus physical media used to tie computer systems together. Hardware 
does the task of entering the raw data, manipulating the data, storing the data and finally 
displaying the output on the screen or printer.

A look to Future

Chip in the brain
One day it may be common for people to have microchips 
inserted into their brains so that they can communicate 
directly with their computer. Radio waves link the chip to a 
computer, so that the brain and the computer can send and 
receive signals between them. They could share memories 
and knowledge, even feelings and experiences. It may 
become difficult to decide where a human being ends and 
where a machine begins.

Both the components are essential for the successful operation of a computer system. 
Either of them is useless without the other. Computers cannot do any useful work without 
instructions from software; thus a combination of software and hardware (the computer) 
is necessary to do any computerized work.

John Robinson Pierce was an American engineer and author. He worked 
extensively in the fields of radio communication, computer music and science 
fiction. He supervised the Bell Labs team which invented the transistor, and 
at the request of one of them, Walter Brattain, coined the term transistor.
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A typical computer system consists of the following hardware components to accomplish 
the task:
• 	 Input devices
• 	 Central Processing Unit
• 	 Output devices
• 	 Storage devices

Input Devices
Input can also be defined as the data entered into a computer for processing or the 
available data for solving a technical problem. The input can be in the form of text, 
programs, commands and user responses. The device that collects the input and sends 
it to the computer is called an input device. There are a variety of input devices, which 
are used by computers. Input devices include keyboard, pointing devices, scanners, web 
camera, digital camera, audio and video input devices. 

Facts Corner A flexible keyboard is a keyboard usually made of soft silicone that is highly portable and attaches 
to a computer through a USB connection or serial port. 

Electronic Keyboard
Electronic keyboard is one of the primary input devices in a personal computer. It contains 
alphanumeric keys, special keys and function keys. It designed for the input of text and 
characters and also to control the operation of a computer. The layout of keys on the 
modern-day English keyboard is called the QWERTY design. 

Pointing Devices
Pointing device is a device with which you can control the movement of a pointer to 
select items on a display screen. It is an element of the graphical user interface. The 
examples of pointing devices include mouse, trackball, joystick, touchpad and light pen. 

Mouse
Computer mouse is a small palm-sized pointing 
device connected to the system unit by a thin cable. 
It has two or three buttons on the top with either a 
rotating ball or an optical sensor at the bottom. The 
mouse is used to make menu selection and draw 
images. It controls movement of mouse pointer on 
the screen. The cursor on the screen moves in the 
direction of the mouse’s movement.
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Joystick
Joystick is an input device consisting of a stick that pivots 
on a base and reports its angle or direction to the device it is 
controlling. Joysticks are often used to control video games, 
and usually have one or more push-buttons whose state can 
also be read by the computer. Joysticks are also used for 
controlling machines such as cranes, trucks, underwater 
unmanned vehicles, wheelchairs, surveillance cameras and 
zero turning radius lawn mowers. 

Light Pen
Light pen is a small, photosensitive device used to point to 
displayed objects and to draw images on the screen. The tip 
of the light pen contains a light-sensitive element which, 
when placed against the screen, detects the light from the 
screen enabling the computer to identify the location of the 
pen on the screen.

Video Input Devices
A video input device is any device that sends video. There are several types of video input 
devices that allow you to play video from an external device on a video display. There are 
several types of video input devices that allow you to play video from an external device 
on a video display. The examples of  video input devices include media players, Video 
Game Consoles, digital camera and webcam.

Media Players
Media players are devices that play any sort of media. These 
include physical media players such as VCRs, DVD players 
and Blu-ray players, as well as digital media players such as 
DVRs and streaming video players such as the Roku Netflix 
player and other Netflix-supported devices.

Video Game Consoles
Video game consoles play video game media. These include 
the PlayStation 3, Xbox 360 and Nintendo Wii. Some hand-
held consoles such as the PlayStation Portable can also 
function as a video input device with an optional video 
output cable. Also, some video game consoles can play other 
video media such as videos from a media server or streaming 
Netflix or Hulu.
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Central Processing Unit
The Central Processing Unit (CPU) is the primary 
processor of a computer. It controls the working 
of the entire computer system. The computer’s 
CPU is responsible for handling all the instructions 
and calculations it receives from other hardware 
components in the computer and software programs 
running on the computer.  The CPU has two basic 
parts.
They are: 
•	 The Control Unit (CU), responsible for 

controlling all the operations of the computer.
•	 The Arithmetic and Logic Unit (ALU), where all the calculations and logical decisions 

are made.

Digital Camera
Digital camera is an electronic device used to capture and 
store photographs digitally, instead of using photographic 
film like conventional cameras. This allows you to take 
pictures and to store a digital photographic image that can 
be read by a computer. You can transfer the images directly 
from your camera on to your computer.

Webcam
Webcam is a camera connected to a computer that allows 
anyone connected to the Internet to view still pictures or 
motion video of a user. Webcam software typically captures 
the images as JPEG or MPEG files and uploads them to the 
Web server. Webcam capabilities have been added to instant 
messaging text chat services such as Yahoo Messenger and 
one-to-one live video communication over the Internet.
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Let us now understand  how the CPU processes the input using the two main parts-the control unit and the arithmetic logic unit; working in 
close cooperation with the computer’s RAM.

User

Input Device

CU ALU

CPU

Output Device

User

Storage Devices

RAM

2. 	 The CU controls the flow of 
data inside the computer.

3. 	 The CU checks an input stored in the RAM 
to see if any comparisons/calculations are 
required or not to process the data.

4. 	 If comparisons/calculations are 
required then the CU sends the data 
to the ALU. The ALU performs the 
required calculations/comparisons.

5. 	 The CU retrieves the results from the 
ALU and stores them in the RAM.

9. 	 The user gives instructions to store the output permanently to 
an external storage device for future reference.

6. 	 The RAM temporarily stores the data 
and information while the processing 
is being undertaken by the CPU.

1. 	 The CU of the CPU receives input from 
the input devices and stores them into 
the computer’s RAM.

7. When the processing is complete, the 
CU retrieves the final results from the 
RAM and sends them to an output 
device to be shown to the user.

8. 	 The output can be seen by the user 
temporarily on an output device 
while it is being held by the RAM.

Working of CPU

Output Devices
Output is any information the computer sends to the outside world. It might be in the form 
of words, numbers, graphics, sounds, videos and animations. The device that converts the 
binary coded data into human acceptable form and presents it to the user in the desired 
form is called an output device. The monitor, printer and speakers are some of the popular 
output devices. Output sent to a monitor is called soft copy while output sent to a printer 
is called hard copy.	

Computer Monitor
The monitor works with a video card, located inside the computer 
case, to display images and text on the screen. Newer monitors 
usually have LCD (liquid crystal display) or LED (light-emitting 
diode) displays. These can be made very thin, and they are often 
called flat-panel displays. Older monitors use CRT (cathode ray 
tube) displays. CRT monitors are much larger and heavier, and 
they take up more desk space. Most monitors have control buttons that allow you to 
change your monitor’s display settings, and some monitors also have built-in speakers.
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Facts Corner LED displays are actually LCDs that are backlit with light-emitting diodes. This allows for greater 
contrast than a traditional LCD.

Printer
A printer is an output device that produces text 
and graphics on a physical medium such as paper. 
Printed information is called hard copy because the 
information exists physically and is a permanent 
form of output. Printers can be grouped into two 
categories: impact and non-impact. Impact printers 
include all printers that work by striking an ink 
ribbon. Daisy-wheel and dot matrix printers are 
impact printers. Non-impact printers use laser beam 
or inkjet technology for printing. Laser and inkjet 
printers are non-impact printers. The important 
difference between an impact and a non-impact 
printer is that the former is slow and noisy with a 
poorer output quality.

Brainstorming 

  task
Complete each statement in the spaces provided with the help of Clue Box help line.
CPU, input device, Hardware, printer, keyboard

a.	 …………..refers to the physical components of the computer system.

b.	 The device that collects the input and sends it to the computer is called an…………….

c.	 …………………. contains alphanumeric keys, special keys and function keys etc.

d.	 A …………..is an output device that produces text and graphics on a physical 
medium such as paper.

e.	 …………… controls the working of the entire computer system.
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Computer Memory/Storage device
Computer memory refers to devices that are used to store data or programs (sequences of 
instructions) on a temporary or permanent basis for use in an electronic digital computer.  
Computer memory can be divided into two broad categories: 

1. Primary Memory 			 

2.  Secondary Memory

Primary Memory
Primary memory is also called internal storage 
or the main memory of a computer. It operates at 
a very high speed and can be accessed directly 
by the Central Processing Unit. The primary 
memory of a computer system is made up of 
a set of memory chips. Some of the common 
example of primary memory is RAM(Random 
Access Memory) and ROM(Read Only 
Memory)

Secondary Memory
Secondary memory is a non-volatile memory which 
provides a very large capacity for storage of data 
and instructions for future use. It can hold much 
more data and is much less expensive. It is also 
known as backing storage or external memory. The 
popular secondary storage media used in a personal 
computer are hard disk, optical disk, memory cards 
and pen drive.

1.	 Collect the different parts of computer and write their function.
2.	 Identify the difference between input device and output device. 
3.	 Draw a figure of 1-1 input and output device used at your home it may be digital camera, 

speaker so on.

Project Work
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•	 A system is a set of related parts that operates together to perform a specific function.
•	 Hardware refers to the physical components of the computer system.
•	 The device that collects the input and sends it to the computer is called an input 

device.
•	 Pointing device is a device with which you can control the movement of a pointer to 

select items on a display screen.
•	 Joystick is an input device consisting of a stick that pivots on a base and reports its 

angle or direction to the device it is controlling.
•	 Light pen is a small, photosensitive device used to point to displayed objects and to 

draw images on the screen. 
•	 A video input device is any device that sends video. 
•	 Digital camera is an electronic device used to capture and store photographs digitally, 

instead of using photographic film like conventional cameras. 
•	 The Central Processing Unit (CPU) is the primary processor of a computer. It controls 

the working of the entire computer system. 
•	 The device that converts the binary coded data into human acceptable form and 

presents it to the user in the desired form is called an output device.

Hardware  	 The physical components of the computer system.
CPU  	 The brain of the computer which controls all the activities of the 

computer. 
RAM 	 A computer memory where program are store temporally. It is also called 

volatile memory
ROM 	 A computer memory where program are store permanently. It is also 

called non-volatile memory
Input device	 Through which we supply data and instruction to the computer for 

processing.
Output device	 Through which we are able to get the result after processing inside the 

computer.
Storage device	 It is the blank space of a computer for storing different data, program, 

software for the temporally or permanently

Tricky Terms

Let 
Us Revise
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Solved Exercises
1.	 Define computer hardware. 
Ans: 	 The physical part of a computer is called hardware. It is the most important component of a computer system 

which carries out different vital computer operations.  

2.	 What is input device? 
Ans: 	 Those devices through which we supply data and instruction to the computer for the processing is called input 

device. Some of the common input devices are keyboard, mouse, light pen, microphone, scanner etc. 

3.	 What is output device? 
Ans:   	 Those devices through which we display or get the result after processing by the CPU is called output device. The 

common output devices are monitor, speaker, printer, plotter etc.

4.	 What is storage device? 
Ans: 	 The device which is used to store the data, information, program as well as software for the future reference is 

called storage device. Some of the common storage devices are hard disk, floppy disk, CD/DVD, pen drive, etc.

5.	 What is pointing device?
Ans: 	 Pointing device is a device with which you can control the movement of a pointer to select items on a display 

screen.

6.	 What is Digital camera?
Ans: 	 Digital camera is an electronic device used to capture and store photographs digitally, instead of using photographic 

film like conventional cameras.

7.	 What is a computer mouse? What are the functions of a computer mouse? 
Ans: 	 Computer mouse is a small, palm-sized, plastic device that rolls around on a flat surface and controls the movement 

of the pointer on a display screen. Computer mouse enables the user to:
•	 Point to icons.
•	 Point to items in lists.
•	 Draw freehand shapes on  a screen.

8.	 What is CPU?
Ans: 	 The Central Processing Unit (CPU) is the primary processor of a computer. It controls the working of the entire 

computer system

9.	 What is printer?
Ans: 	 A printer is an output device that produces text and graphics on a physical medium such as paper. Printed 

information is called hard copy because the information exists physically and is a permanent form of output.



22 Computer Zone - Book 6

Chapter Review
1.	 State whether the following statements are true or false. 
a.   	Hardware is the collection of physical elements that constitutes a computer system. 
b.	 Mouse is an input device consisting of a stick that pivots on a base and reports its 

angle or direction to the device it is controlling.
c. 	 The computer’s CPU is responsible for handling all the instructions and calculations 

it receives from other hardware components in the computer and software programs 
running on the computer. 

d. 	 Digital camera is an electronic device used to capture and store photographs digitally, 
instead of using photographic film like conventional cameras.

e. 	 The device that collects the input and sends it to the computer is called an output 
device.

f.	 Pointing device is a device with which you can control the movement of a pointer to 
select items on a display screen.

2. 	 Fill in the blanks with the help of clue box:
Digital Camera, printer, Pointing device, mouse, ROM, RAM

a.   __________________ is a small, photosensitive device used to point to displayed 
objects and to draw images on the screen. 

b. 	 __________________ is a camera connected to a computer that allows anyone 
connected to the Internet to view still pictures or motion video of a user.

c. 	 A ________________is an output device that produces text and graphics on a physical 
medium such as paper. 

d. 	 ___________________ is  a volatile memory.
e. 	 __________________ is a non volatile memory.
f. 	 _________________ is a device with which you can control the movement of a 

pointer to select items on a display screen.

3. 	 Match each term with the statement that best describes it.  
Printer	 A small palm-sized pointing device connected to the system 

unit by a thin cable.  
ROM  	 The primary processor of a computer that controls the 

working of the entire computer system.
Computer mouse 	 An output device that produces text and graphics on a 

physical medium such as paper. 
CPU  	 A read/write memory used to store the data and programs 

currently in use.  
RAM  	 A  non volatile memory of a computer.
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4.	 Give the appropriate technical term for each of the following statements. 
a. 	 The device that collects the input and sends it to the computer. 
b. 	 The physical parts of a computer.
c.  	 The volatile memory of a computer.
d. 	 The non- volatile memory of a computer.
e. 	 An electronic device used to capture and store photographs digitally, instead of using 

photographic film like conventional cameras. 
f. 	 An output device that produces text and graphics on a physical medium such as 

paper.

5.	 Give the full forms of the following abbreviations. 
a. 	 CPU 		    b. ALU  			   c. CU 			   d. RAM
e.   	ROM		    f. LCD  			   g. LED			  h. CRT

6. 	 In your own words, briefly answer the following questions.
a.	 What is a computer?
b. 	 What is hardware? Name the three hardware elements. 
c. 	 What is an input device? Name some of the popular input devices.
d. 	 What is Central Processing Unit? State the functions of two main elements of the 

Central Processing Unit. 
e. 	 What is an output device? Name some of the popular output devices. 
f. 	 What is a printer? What are the two different types of printer?
g. 	 What is storage device? Write down its types.
h.	 What is primary memory?
i. 	 What is secondary memory?
j. 	 What is Video Input Device?
k. 	 What is Pointing Device?
l. 	 Write short notes on:
	 i. 	 Keyboard			   ii. Mouse		
	 iii. Light Pen			   iv.Monitor
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Objectives

After completing this chapter, you will be 
able to:

	 Define  software  and  describe  the  
different types of software.

 	 Explain the different types of system 
software.

	 List out the major functions of an 
operating system.

	 Describe the different types of 
translators. Explain  the  different  types  
of  application software.

Computer
 Software
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Microsoft Corporation is the world’s leading software-producing company, 
headquartered in Redmond, Washington, and founded by Bill Gates and 
Paul Allen in 1975. It develops, manufactures, licenses and supports a wide 
range of software products for computing devices. Its best selling products 
are the Microsoft Windows operating system and the Microsoft Office suite 
of productivity software.
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Concept: Putting Machine To Life
A computer cannot do anything on its own. Both hardware and software are necessary 
for a computer to do useful job. It must be instructed to do a desired job. Hence, it is 
necessary to specify a set of instructions, which a computer must perform to solve a 
problem. A set  of instructions that perform a particular task is called a computer program. 
The instructions in a program direct the computer to perform input operations, process the 
data and output the results. 
Software is a set of electronic instructions consisting of one or more programs that govern 
the operations of the computer and make the hardware operate. Computer software is 
what makes a computer so valuable as a problem-solving tool. Without the instructions 
provided by software, computer hardware is unable to perform any of the tasks we 
associate with computer.  
The software is broadly classified into two types:
a.  System software
b. Application software
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System Software
System software is the chief manager of the computer system. It is a specialized software 
designed to manage the resources of the personal computer system and its overall operations. 
These programs are written to assist usage of the personal computer system. It serves as 
an intermediary between hardware and application software. It makes the operation of the 
computer system more effective and efficient. It is written by the computer manufacturer 
related to that computer’s mechanism. System software are further classified into: 
a.	 Operating systems
b.	 Language translators
c.	 Device drivers
d.	 Utility programs 

Operating System Software
An operating system is the most important software that runs on a computer. It manages 
the computer’s memory, processes, and all of its software and hardware. It also allows 
you to communicate with the computer without knowing how to speak the computer’s 
“language.” It acts as a medium between the hardware and the user or application program. 
Modern computer operating systems are becoming increasingly machine-independent, 
capable of running on any hardware platform. Microsoft Windows, Linux and Mac OS 
are some of the most popular operating systems.

Utility Program
Utility program is a specialized program designed to make computing easier. It performs 
a specific task related to the management of computer functions, resources, or files, as 
password protection, memory management, virus protection and file compression. Many 
operating systems have utility programs built directly into the operating system itself. 
Other utility programs are sold separately Examples of utility software’s include Disk 
defragmenters, System Profilers, Network Managers, Application Launchers and Virus 
Scanners. 

Knowledge Update

The next major release of the Microsoft Windows operating 
system, Windows 8 officially debuted on October 26th, 2012 
following a release to manufacturing on August 1st.  According 
to Microsoft, Windows 8 is a completely redesigned operating 
system developed from the ground up with touchscreen use 
in mind as well as near-instant-on capabilities that enable 
a Windows 8 PC to load and start up in a matter of seconds 
rather than in minutes.
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Assembly Language

Assembler

Machine Code

High Level Language

Compiler

High Level Language

Interpreter

Device Driver
Device driver is a computer program that allows other programs to interact with 
computer hardware. The driver communicates with the device through the computer bus 
or communications subsystem that the hardware is connected to. Drivers are hardware-
dependent and need operating system software.	

Translator Program
Translator program is a computer program that converts the programming instructions 
written in human convenient form into machine language codes that computers understand 
and process. The translating programs are loaded into the computer’s memory at the 
time of translation process. There is one translating program for each programming 
language. There are three basic kinds of translator programs: assembler, compiler and 
interpreter.	

Assembler	 Assembler is a computer program which translates the program 
written in assembly language into machine language. The 
assembly language program is called source program and the 
machine language program is called object program.  	

Compiler	 Compiler is a computer program that translates a high level 
language program into a machine language program at once. It 
reports all the errors of the program along with the line numbers. 
Some of the programming languages such as C, C++, and Fortran 
use compilers. 

Interpreter	 Interpreter is a computer program that translates and executes a 
program written in high level language, line by line. If an error is 
found on any line, it is immediately reported to the user and the 
execution of the program is stopped. The programming language 
BASIC normally uses an interpreter.
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Application Software
Application software is a computer program designed to help the user in performing 
a certain type of work. It helps the user to work faster, more efficiently and more 
productively. Application software may be written by a large software house which 
distributes its products widely and addresses a general class of problems, or may be 
written by an individual and addresses a particular problem. Application software can 
further be subdivided into two categories: packaged software and customized software.

Packaged Software
Packaged software is a generalized set of programs that allow the computer to perform a 
specific data processing job for the user. These programs are user friendly and designed 
for use in more than one environment.Packaged software may be purchased from software 
vendors. Some of the most commonly used packaged software are Microsoft Word, 
Microsoft Excel, Microsoft Access and Microsoft Frontpage. 

Customized Software
Customized software is a software designed to meet the user’s specific needs. It can be 
very expensive. It is written on the demand of individual’s need and serves only a single 
organization. It is written in high-level language such as Visual Basic or Visual C++. 
Some of the customized software are Inventory Management System, Payroll System, 
Financial Accounting and Library Information System.

Brainstorming 

task
Complete each statement in the spaces provided.
a.	 ______________________is a set of electronic instructions consisting of one or 

more programs that govern the operations of the computer and make the hardware 
operate. 

b.	 ______________________is a specialized software designed to manage the 
resources of the personal computer system and its overall operations. 

c.	 __________________is a specialized program designed to make computing easier.

d.	 A________________________is a generalized set of programs that allow the 
computer to perform a specific data processing job for the user. 

e.	 _____________________is a software designed to meet the user’s specific needs. 
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Software 	 A set of electronic instructions consisting of complex codes that 
make the computer perform tasks.

Operating system	 An operating system is the most important software that runs on 
a computer. It manages the computer’s memory, processes, and 
all of its software and hardware.

Device driver 	 Device driver is a computer program that allows other programs 
to interact with computer hardware.

Translator program 	 Translator program is a computer program that converts the 
programming instructions written in human convenient form into 
machine language codes that computers understand and process.

Customized software 	 Customized software is software designed to meet the user’s 
specific needs.

Let 
Us Revise
•	 Software is a set of electronic instructions consisting of one or more programs that 

govern the operations of the computer and make the hardware operate.
•	 System software is the chief manager of the computer system. It is specialized software 

designed to manage the resources of the personal computer system and its overall 
operations.

•	 An operating system is the most important software that runs on a computer. It manages 
the computer’s memory, processes, and all of its software and hardware.

•	 Microsoft Windows, Linux and Mac OS are some of the most popular operating systems.
•	 Utility program is a specialized program designed to make computing easier.
•	 Device driver is a computer program that allows other programs to interact with 

computer hardware.
•	 Assembler is a computer program which translates the program written in assembly 

language into machine language.
•	 Compiler is a computer program that translates a high level language program into a 

machine language program at once.
•	 Interpreter is a computer program that translates and executes a program written in high 

level language, line by line.
•	 Packaged software is a generalized set of programs that allow the computer to perform 

a specific data processing job for the user.
•	 Customized software is software designed to meet the user’s specific needs. It can be 

very expensive.

Tricky Terms
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Solved Exercises
1.	 What is software? Who creates computer software?
 Ans:  	 Software is a set of electronic instructions consisting of one or more programs that control the operation of 

computer hardware. Computer programmers write the instructions for the computer programs and support 
modules that become the components of a computer software product.

2.  	 What is an operating system? What does an operating system do? 
Ans:   	 Operating system (abbreviated OS) is the master controller for all the activities that take place within a computer 

system. It controls the operation of a computer, directs the input and output of data, keeps track of files and 
controls the processing of computer programs. Every operating system performs three basic functions: managing 
resources, providing a user interface and running application. 

3.	 What is Device driver?
Ans:  	 Device driver is a computer program that allows other programs to interact with computer hardware.

4.	 What is Translator program?
Ans: 	 Translator program is a computer program that converts the programming instructions written in human 

convenient form into machine language codes that computers understand and process.

5. 	 What is an Assembler?
Ans: 	 An assembler is a computer program which translates the program written in assembly language into machine 

language.

6.	 What is compiler?
Ans: 	 Compiler is a computer program that translates a high level language program into a machine language program 

at once

7.	 What is system software?
Ans: 	 System software is the chief manager of the computer system. It is specialized software designed to manage the 

resources of the personal computer system and its overall operations.

8.	 What is packaged software?
Ans: 	 Packaged software is a generalized set of programs that allow the computer to perform a specific data processing 

job for the user.

9.	 What is application software? What are the two categories of application software?
 Ans:  	 Application software is a complete, self-contained program designed to perform a specific task. Application 

software can further be subdivided into two categories: packaged software and customized software.
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Chapter Review
1.	 State whether the following statements are true or false.
a.	 Operating system is a type of system software.
b.	 Device driver is a type of application software.
c.	 Utility program is a specialized program designed to make computing easier.
d.	 Interpreter is a computer program that translates and executes a program written in 

high level language, line by line.
e.	 Customized software is a generalized set of programs that allow the computer to 

perform a specific data processing job for the user.
f.	 Application software can further be subdivided into two categories: packaged 

software and customized software.

2.	 Fill in the blanks with the help of clue box.
Compiler, Translator program, An assembler, Software, System software, Interpreter

a.	 ……………..is a set of electronic instructions consisting of one or more programs 
that govern the operations of the computer and make the hardware operate.

b.	 …………………is a computer program that converts the programming instructions 
written in human convenient form into machine language codes that computers 
understand and process.

c.	 ………………..is the chief manager of the computer system.
d.	 …………..is a computer program that translates a high level language program into 

a machine language program at once.
e.	 ……………is a computer program that translates and executes a program written in 

high level language, line by line.
f.	 …………..is a computer program which translates the program written in assembly 

language into machine language.

3.	 Match each term with the statement that best describes it. 
	 Translator program	 A set of electronic instructions consisting of complex codes 

that make the computer perform tasks.
	 Device driver	 An operating system is the most important software that 

runs on a computer. It manages the computer’s memory, 
processes, and all of its software and hardware.

	 Operating system	 Device driver is a computer program that allows other 
programs to interact with computer hardware.

	 Software	 Translator program is a computer program that converts 
the programming instructions written in human convenient 
form into machine language codes that computers 
understand and process. 
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4.	 Give the appropriate technical term for each of the following statements.
a.	 The collection of program.
b.	 The program which translate the program written in assembly language into machine 

language.
c.	 The program which translate the program written in high level language into machine 

language line by line.
d.	 The program which translate the program written in high level language into machine 

language at once.
e.	 Computer program that allows other programs to interact with computer hardware.
f.	 A set of electronic instructions consisting of complex codes that make the computer 

perform tasks.

5.	 Give the full forms of the following abbreviations.
a.	 OS		  b. BASIC			   c.  CPU    		    d.  PC	
 
6.  	 In your own words, briefly answer the following questions.
a. 	 What is software?
b. 	 What are the types of software?
c. 	 What is system software?
d. 	 What is application software?
e. 	 What is operating system (OS)?
f. 	 What are the examples of operating system?
g. 	 What is language translator? Write down its types.
h. 	 What are the difference between complier and interpreter?
i. 	 What is device driver?
j. 	 What is Customized software?
k. 	 What is packaged software?
l. 	 What is Utility program?
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Objectives

After completing this chapter, you will be 
able to: 

	Define Memory with its types.

	Define the types of primary memory.

	Identify the differences between primary 
and secondary memory.

	Define the different types of secondary 
memory.

Storage Device
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The computer memory is an essential component of a computer system. Memory is a 
blank space where we can store data, program.  In a computer system to keep the data, 
programs temporarily as well as permanently, we need two different memories they are 
primary memory and secondary memory.

Primary memory
Primary memory is the internal storage within the computer which stores both the 
processed and the unprocessed data as well as the program instructions. It operates at a 
very high speed and can be accessed directly by the Central Processing Unit. The primary 
memory of a computer system is made up of a set of memory chips. There are two types 
of memory chips. Each type of memory chip is used for a different purpose in a computer 
system. They are: 

Random Access Memory 
Random Access Memory is a read/write memory. It is 
used to store the data and programs currently in use. 
It is a volatile memory because the data in RAM stays 
there only as long as the computer is on, and electricity is 
flowing through the machine. The information stored on 
the RAM gets lost when the power supply is turned off. 

Read Only Memory 
Read Only Memory is a permanent memory. It is used to 
store permanent programs and other instructions which are 
needed by the computer to execute the application programs. 
Its contents are not lost even when the power supply is 
switched off. It is read-only memory, i.e., information can 
only be read from the memory. The user cannot write onto a 
ROM. Its contents are written at the time of manufacturing 
computer hardware. 
Difference between: RAM and ROM

RAM ROM
RAM stands for Random Access Memory ROM stands for Read Only Memory
It is a read/write memory It is a read only memory

It is used to store the data and programs 
currently in use

It is used to store permanent programs.

It is a volatile memory It is a non- volatile memory
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Secondary Memory
Secondary memory is a non-volatile memory which provides a very large capacity for 
storage of data and instructions for future use. It can hold much more data and is much 
less expensive. It is also known as backing storage or external memory. Secondary storage 
devices are broadly categorized into following types. They are:
i.	 Magnetic storage device like Hard disk, Floppy disk, Magnetic tape etc.
ii.	 Optical storage device like CD-ROM, DVD ROM, Blu-Ray Disk  etc.
iii.	  Flash memory like pen drive, memory chip.

Magnetic storage
Magnetic storage device use principle of electromagnetism for storing and retrieving data. 
The surface of magnetic device is coated with magnetic material. The writing process is 
done by generating magnetic fields in the surface by using read/write arm. The reverse 
process is implemented for reading data.

Hard disk: Hard disk is one of the most versatile forms 
of secondary storage media. It is a data storage device 
used for storing and retrieving digital information using 
rapidly rotating disks (platters) coated with magnetic 
material. It consists of one or more metallic platters 
sealed inside a container. The container includes the 
motor for rotating the disks. It also contains an access 
arm and read-write heads for writing data to and reading 
data from the disks. It provides faster access to data and 
are capable of storing a large quantity of data. 

Floppy Disk: It is a round and flat disk which is made of 
mylar (a plastic  material )coated with magnetic material. It 
is a read/write memory as we read from as well as write to 
it. We can access the information from floppy randomly. We 
can use floppy disk to store data and programs, backup files, 
transfer data from one computer to another computer etc. It 
is also called diskette. It is a removable disk so it is very 
useful to transfer small amount of data from one computer 
to another.

Magnetic Tape: It is a secondary storage device of computer which is made of mylar 
(a tape of plastic material) coated with magnetic material only one side of the tape. It is 
similar to the tape used in a tape recorder except that it is of a higher quality and is more 
durable. It is a low cost storage device and it has large storage capacity. It is mainly used 
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to back up the large amount of data and 
information .It is also used to transfer 
data from one computer to another. The 
main disadvantage of magnetic tape 
is that we can access its contents only 
sequentially.

Optical storage device
Optical disk is an electronic data storage medium from which data is read and written to 
by using a low powered laser beam. It is flat, circular, plastic or glass disk on which data is 
stored in the form of light and dark pits. Optical memory is very useful for the distribution 
of large amount of data to a large number of users. It can be easily transferred from one 
place to another   place as it is small in size and is not attached to computer like hard disk. 
It is most commonly used for storing music, video, or data and programs for personal 
computers. CD-ROM (Compact Disk Read Only Memory), DVD (Digital Versatile Disk) 
and Blu-ray are the common types of optical disks.

CD-ROM: CD-ROM stands for compact disk 
read only memory, because of the optical storage 
medium. Laser beam is used to access data from 
the disk. It can store about 700 MB of data or 80 
minutes of video or audio.CD-ROM cannot be 
written again once they are written.

DVD: DVD stands for ‘digital versatile disk’ 
or digital video disk’. It is also a type of 
optical memory device which has a very large 
storage capacity. It is also considered as the 
improved form of CD. DVD also uses the same 
technology as a CD for reading and writing data. 
DVD delivers movies with impressive picture and sound quality and it can be randomly 
accessed like audio CD’s by a DVD drive or DVD player.

Blu-Ray Disk (BD) : BD is the name of the 
new generation optical disk. It is developed 
to enable recording, rewriting and play back 
of high definition video (HD), as well as 
storing large amount of data. The disk offers 
more than 5 times of the storage capacity of 
present DVDs. It can hold up to 5o GB on a 
dual layered disk.
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Flash memory
Flash memory is a non-volatile data storage device. Flash memory is used in enterprise 
server, storage and networking technology, as well as in a wide range of consumer 
devices, including USB flash drives, mobile phones, digital cameras, tablet computers, 
PC cards in notebook computers and embedded controllers.

Pen drive: Pen drive is a flash memory card that plugs into the 
computer’s USB port. They are typically small, lightweight, 
removable and rewritable. A flash drive consists of a small 
printed circuit board encased in a plastic or metal casing. The 
USB connector is usually covered by a removable cap.

Memory	  It is a blank space where we can store data, program.  
Primary memory	 It is the memory accessed directly by the Central Processing Unit.
RAM	 A computer memory where programs, application software, and 

data are stored.
ROM	 A computer memory contains a set of start-up instructions for the 

computer system.
Secondary memory	 It is also known as backing storage or external memory.
Pen drive	 It  is a flash memory card that plugs into the computer’s USB port.

Tricky Terms

Let 
Us Revise
•	 Memory is a blank space where we can store data, program.  
•	 Primary memory is directly accessed d by the Central Processing Unit. 
•	 RAM is a volatile memory because it stores data as long as the computer is in ON state. 
•	 The user cannot write onto a ROM. Its contents are written at the time of manufacturing 

computer hardware.
•	 Secondary memory is a non-volatile memory which provides a very large capacity for 

storage of data and instructions for future use.
•	 Magnetic storage device use principle of electromagnetism for storing and retrieving data.
•	 Optical disk is electronic data storage medium from which data is read and written to 

by using a low powered laser beam.
•	 Flash memory is a non-volatile data storage device.
•	 Pen drive is a flash memory card that plugs into the computer’s USB port.
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Solved Exercises
1.	 What is memory?	
Ans:	 Memory is the blank space where we can able to store different data, program temporally or permanently.

2.	  What is primary memory? 
Ans:	 Primary memory is the internal storage within the computer which stores both processed and unprocessed data 

as well as the program instructions.

3.	 What is secondary memory?
Ans:	 Secondary memory is a non-volatile memory which provides a very large capacity for storage of data and 

instructions for future use.
	
4.	 What is the difference between primary and secondary memory?
Ans:  	 The difference between primary and secondary memory are:

Primary Memory Secondary Memory
- It is also called internal memory - It is also called external memory

-It is directly accessible to CPU - It is not directly accessible to CPU

-It is usually volatile memory except ROM - It is a non volatile memory

-Example of primary memory are RAM, ROM - Example of Secondary memory are Hard disk, CD,DVD, 
Pen drive

5.	 What is Optical disk?
Ans: 	 Optical disk is an electronic data storage medium from which data is read and written to by using a low powered 

laser beam.

6.	 What role does ROM play in a computer system? 
Ans:   	 ROM contains a small set of instructions called the ROM BIOS (Basic Input/Output System). These instructions tell 

the computer how to access the hard disk, find the operating system, and load it into RAM. Once the operating 
system is loaded, the computer can understand your input, display output, run software, and access your data.
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Chapter Review
1.	 State whether the following statements are true or false. 
a.	 Memory is a blank space where we can store data, program.  
b.	 Secondary  memory is directly accessed d by the Central Processing Unit. 
c.	 Primary memory is a non volatile memory.
d.	 BD is the name of the new generation optical disk.
e.	 Magnetic storage device use principle of electromagnetism for storing and retrieving 

data.
f. 	 DVD stands for ‘digital versatile disk’ or digital video disk’. It is also a type of 

optical memory device which has a very large storage capacity.
g.	 Hard Disk is a round and flat disk which is made of mylar (a plastic  material )coated 

with magnetic material.  
h.	 CD-ROM, DVD ROM, Blu-Ray Disk etc are the example of Optical storage device.
i.	 Pen drive is a flash memory card that plugs into the computer’s USB port.
 
2.	 Fill in the blanks. 

Magnetic storage, Memory, Pen drive, Secondary Storage, RAM
a.	 ______________ is used to store the data and programs currently in use.
b.	 ______________ also known as backing storage or external memory.
c.	 ______________ device use principle of electromagnetism for storing and retrieving 

data.
d.	 ______________ is a blank space where we can store data, program.  
e.	 ______________ is a flash memory card that plugs into the computer’s USB port.

3.	 Match each term with the statement that best describes it. 
	 RAM	 It is a blank space where we can store data, program. 
	 Secondary  memory 	 It is the memory accessed directly by the Central Processing 

Unit. 
	 Memory	 A computer memory where programs, application software, 

and data are stored. 

	 Pen drive	 A computer memory contains a set of start-up instructions 
for the computer system.

	 Primary memory	 It is also known as backing storage or external memory. 
	 ROM	 It  is a flash memory card that plugs into the computer’s 

USB port.
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4.	 Give the full forms of the following abbreviations.
a.	 RAM		  b. ROM        	 c. CD       	 d. DVD       		  e. BD
f.	 HD                   	 g. MB            	 i. GB      	  j.USB	    		  k. CPU

5.	 Give the appropriate technical term for each of the following statements.
a.	 The device that is used to store the data and information temporally
b.	 The volatile memory of a computer.
c.	 The Read only memory of a computer.
d.	 The memory that is directly access by the CPU.
e.	 The storage device use principle of electromagnetism for storing and retrieving data.
f.	 The electronic data storage medium from which data is read and written to by using 

a low powered laser beam.

6.	 In your own words, briefly answer the following questions.
a.	 What is computer memory?
b.	 What are the types of memory?
c.	 What is secondary memory? Write its example.
d.	 Differentiate between RAM and ROM.
e.	 Differentiate between primary and secondary memory.
f.	 Why RAM is called volatile memory?
g.	 Draw the figure of a Hard disk.
h.	 What is floppy disk?
i.	 What is pen drive? What is the use of it?
J.	 Why hard disk is popular than floppy disk?
k. 	 What is flash memory? Write the examples of it.
l. 	 What is the difference between CD and DVD?
m. 	 What are the examples of optical storage disk?



Objectives

After completing this chapter, you will be able 
to:

	Describe analog, digital and hybrid computer.
	Describe Super, Mainframe, Mini and 
Microcomputer.

5 Classification of 
Computer
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Classification of Computers
A computer system exists in a wide range of sizes and ranges of power, and different types 
of computer systems have varying capabilities. The classification of computers varies with 
the advancement of technology. They are classified in the following categories: analog, 
digital and hybrid.	

Analog Computer
Analog computer is a computer that represents data by measurable quantities, as voltages 
or, formerly, the rotation of gears, in order to solve a problem, rather than by expressing 
the data as numbers. It is a single problem oriented machine. It is widely used in simulating 
the operation of aircraft, nuclear power plants and industrial chemical processes.

Examples: Examples of Analog devices are:
Thermometer Automobile speedometer

An	 instrument	 for	 measuring	
and monitoring human body temperature.

A device used to measure the travelling speed of a 
vehicle.

Digital Computer
Digital computer is an electronic computer in which the input is discrete rather than 
continuous, consisting of combinations of numbers, letters, and other characters written 
in an appropriate programming language and represented internally in binary notation. 
These computers are multipurpose machines. They are used in business, banking system, 
engineering and many other fields. All modern general-purpose electronic computers are 
digital.	Examples: IBM PC, Apple/Macintosh

Tower model refers to a computer in which the power supply, motherboard, 
and mass storage devices are stacked on top of each other in a cabinet. This 
is in contrast to desktop models, in which these components are housed in 
a more compact box. 
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Hybrid Computer
Hybrid computer is a computer which combines the best features of both analog and 
digital computers. The digital component normally serves as the controller and provides 
logical operations, while the analog component normally serves as a solver of differential 
equations. It is a special purpose machine. It is generally used in scientific applications, 
aeroplanes and industrial control processes. 

Examples:  HRS-100  
(Serbian: Hibridni Raunarski Sistem - Hybrid Computer System) model 100 was a third 
generation hybrid computer developed by Mihajlo Pupin Institute (Serbia) and engineers 
from USSR. It was deployed in Academy of Sciences of USSR in 1971.

Brainstorming 

task
Complete each statement in the spaces provided.
a.	 Digital computer works with ......................................... .
b.	 Analog computers works with ............................... and ............................... values. 
c.	 ............................... computer combination of qualities of analog as well as digital 

computers.
d.	 ............................... computers are the computers designed for a specific task or a 

narrow range of tasks.

The Difference between Digital and Analog computer:
Digital computer Analog computer

i. 	 These computers works with digits. i. 	 These computers  works with natural 
and physical values.

ii. 	 It works upon discrete data. ii.	 It works upon continuous data.
iii.   It is general purpose machine. iii.   It is special purpose computer.
iv.    Its accuracy is high. iv.    Its accuracy is low.
v. 	 Desktop,  laptop etc are  the 

Example of digital computer.
v.	 Example of Analog computer is Presley.

Facts Corner The first microprocessor created by Intel was the 4004. It was designed for a calculator, and in that time 
nobody imagined where it would lead.
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Size and performance wise digital computers
The digital computers that are available nowadays vary in their sizes. The computers are 
broadly classified into four categories based on their size: 

1. 	 Microcomputers 
A Computer, which is based on microprocessor, is called Microcomputer.  It is small, 
low-cost and single-user digital computer. It is mainly used in office, house, school, 
shop, department center, hospital etc. Microcomputers include desktop computers, 
notebook computers or laptop, tablet computer, handheld computer, smart phones.

2. 	 Minicomputers
Minicomputers are digital computers, generally used in multi-user systems. They 
have high processing speed and high storage capacity than the microcomputers. The 
users can access the minicomputer through their PCs or terminal. They are used for 
real-time applications in industries, research centers, etc. PDP 11, IBM (8000 series) 
are some of the widely used minicomputers.

3. 	 Mainframe Computers
Mainframe computers are multi-user, multi-programming and high performance 
computers. They operate at a very high speed, have very large storage capacity 
and can handle the workload of many users. Mainframe computers are large and 
powerful systems generally used in centralized databases. Mainframe computers are 
used in organizations like banks or companies, where many people require frequent 
access to the same data. Some examples of mainframes are CDC 6600 and IBM 
ES000 series.

4. 	 Supercomputers
Supercomputer is the most powerful and fastest computer among digital computers. 
This computer is special purpose and is capable of handling huge amount of 
calculations that are beyond human capabilities. The speed of a supercomputer 
is generally measured in FLOPS (FLoating point Operations Per Second). 
Supercomputers are used for highly calculation-intensive tasks, such as, weather 
forecasting, climate research (global warming), biological research, nuclear research 
and aircraft design. They are also used in major universities, military agencies and 
scientific research laboratories. Some examples of supercomputers are CRAY, IBM 
Roadrunner, IBM Blue gene and Intel ASCI red, PARAM is a series etc.
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Analog Computer	 These computers are used for measuring purpose.
Digital Computer	 These computer works with digits. Only two digits i.e. 0 

and 1 are used to represent OFF and  ON.
Hybrid Computer	 Combine form of Analog and Digital computer.
Super Computer	 Super computer are extremely powerful computers 

capable of manipulating huge amounts of data in a 
relatively short time.

Tricky Terms

•	 A computer system is an electronic machine capable of accepting and processing data 
in a fast, efficient and reliable manner.

•	 Analog Computer works on the supply of continuous electrical signals and displays 
output in the form of readings on dials or graphs.

•	 Hybrid computer is a computer which combines the best features of both analog and 
digital computers.

•	 Purpose-wise digital computer is classified into two types.
•	 Size and performance wise digital computers are classified into four types.
•	 Super computer are extremely powerful computers capable of manipulating huge 

amounts of data in a relatively short time.
•	 Mainframe computer are the second largest, expensive and ultra-fast computers.
•	 Micro computer is a small digital computer whose central processing unit consists of a 

microprocessor, a single semiconductor integrated circuit chip.

Let 
Us Revise

Knowledge Update

Tianhe-2 or TH-2  is a 33.86 petaflops supercomputer 
located in Sun Yat-sen University, Guangzhou, China. It was 
developed by a team of 1300 scientists and engineers.
It is the world’s fastest supercomputer according to the 
TOP500 list for June and November 2013.

1.	 Collect any 2-2 analog and digital tools from your school or your home.
Project Work
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Solved Exercises
1.	 How computers are classified into different types?
Ans:  	 Computers are classified according to working principle, size, brand and purpose.

2.	 What are the classifications of computer on the basis of working principle? 
Ans:  	 The classifications of computer on the basis of working principle are:
	 i. Analog computer
	 Analog computers are special purpose computer which are designed to measure the continuous physical values 

such as speed, pressure, humanity, temperature etc.

	 ii. Digital Computer
	 Digital computers are general purpose computer which works on binary digits by accepting discontinuous data.

	 iii. Hybrid Computer
		 Hybrid computer is a computer which combines the best features of both analog and digital computers

3.	 List the Characteristics of Hybrid computer. 
Ans:  	 The Characteristics of Hybrid computer are:
	 • It is the combination of qualities of analog as well as digital computers.
	 •It can process both continuous and discrete data.
	 • It is the special purpose computer.
	 • It usually has high cost compared to analog and digital computer.

4.	 What are the types of digital computer based on Size and performance? 
Ans:  	 The types of digital computer based on Size and performance are:
	 i. Super Computer	 ii. Mainframe Computer
	 iii. Mini computer	 iv. Micro Computer

5.	 Write the difference between analog and digital computer.
Ans:	 The Difference between Digital and Analog computer:

Digital computer Analog computer
i. 	 These computers works with digits. i. 	 These computers  works with natural 

and physical values.
ii. 	 It works upon discrete data. ii.	 It works upon continuous data.
iii.   It is general purpose machine. iii.   It is special purpose computer.
iv.    Its accuracy is high. iv.    Its accuracy is low.
v. 	 Desktop,  laptop etc are  the 

Example of digital computer.
v.	 Example of Analog computer is 

Presley.
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Chapter Review
1.	 State whether the following statements are true or false. Rewrite each false 

statement to make it a true statement.
a.	 Micro computers are digital computer.
b.	 Laptop computer are not portable computer.
c.	 All the computers are general purpose computer.
d.	 Hybrid computers is used in hospital.
e.	 Super computer is very slow in processing as compare with microcomputer.

2.	 Match the following.
Column A Column B

i.	 Hybrid Computer i.	 These computers are used for measuring purpose.

ii.	 Super Computer ii.	 These computer works with digits. Only two digits 
i.e. 0 and 1 are used to represent OFF and ON.

iii.	 Analog Computer iii.	 Combine form of Analog and Digital computer.

iv.	 Digital Computer
iv.	 Super computer are extremely powerful 

computers capable of manipulating huge 
amounts of data in a relatively short time.

	 	
3. 	 Circle the word or phrase that best completes each statement. 
a.	 ………………Computer works on the supply of continuous electrical signals and 

displays output in the form of readings on dials or graphs.
	 i. Analog       				    ii. Digital		
	 iii. Hybrid       				    iv. Super Computer

b. 	 …………..computer is a computer which combines the best features of both analog 
and digital computers.

	 i. Analog       				    ii. Digital		
	 iii. Hybrid       				    iv. Both i & ii

c.	 ………are extremely powerful computers capable of manipulating huge amounts of 
data in a relatively short time.

	 i. Micro computer			   ii. Mini computer
	 iii. Super computer			   iv. None of the above

d. 	 ……………. is a small digital computer whose central processing unit consists of a 
microprocessor, a single semiconductor integrated circuit chip.

	 i. Micro computer			   ii. Mini computer
	 iii. Super computer			   iv. Mainframe computer
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e.	 Thermometer is a example of…………………………. device.
	 i.	 Digital					    ii. Analog	
	 iii. Hybrid					    iv. None of them.

4.	 Write the full form of the following.
a.	 IBM		  b. PDP			  c. IBM PC		  d. FLOPS

5.	 Give the appropriate technical term for each of the following statements.
a.	 The computer which possess continuous data
b.	 The device which converts analog signal to digital and vice versa.
c.	 The computer which are used in school for general purpose.
d.	 The very powerful computer.
e.	 The digital device that is either strapped to or carried on a user’s body.

6.	 In your own words, briefly answer the following questions.
a.	 What is Analog computer? How does it differ from digital computer?
b.	 What is hybrid computer? Write any 3 characteristics of hybrid computer.
c.	 What is Super Computer?
d.	 What are Main frame computers? Where are they mainly used?
e.	 Classify the computer on the basis of size.
f.	 Write the difference between super computer and micro computer.
g. 	 Write the difference between analog and digital computer.
h.	 Write the examples of any 2-2 analog and digital devices.
i. 	 Write short notes on:
		 a. Mini Computer			  b. Micro Computer
		 c. Super Computer		  d. Hybrid Computer
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Objectives

After completing this chapter, you will be able 
to:

	Explain the main advantages of Microsoft 
Windows 7.

	Discuss the different components of 
Windows 7 Desktop.

	Define Windows Explorer.

	Discuss the file and folder management 
techniques.
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Introduction
An operating system, or “OS,” is software that communicates with the hardware and 
allows other programs to run. It is comprised of system software, or the fundamental 
files your computer needs to boot up and function. Every desktop computer, tablet, and 
smartphone includes an operating system that provides basic functionality for the device.
The faster and more powerful the CPU and the greater the amount of memory; the more 
the operating system can do. The more the operating system can do, the more useful it 
can make a computer for its users. The most popular operating systems used on personal 
computers are MS-DOS, Microsoft Windows, Mac OS and Linux.

Some of the important functions of an operating system are listed below:
•	 Provides the instructions to display the on-screen elements with which you interact. 

Collectively, these elements are known as the user interface.	
•	 Loads programs (such as word processing and spreadsheet programs) into the 

computer’s memory so that you can use them.
•	 Controls the flow of data into and out of the computer, as well as to and from 

peripheral devices. 
•	 Responsible for managing the data stored on the secondary storage.
•	 Provides security by preventing unauthorized access to the computer’s resources.
•	 Assigns processors to different tasks being performed by the computer system.

A look to Future

Compu-Style
Some days it is difficult to decide what to do, eat or wear. 
Could a computer style program choose for you? It asks you 
questions, such as what’s the weather like, are you happy 
or sad? You input the answers or data by pressing various 
buttons. Then the computer searches through its lists, or 
database, of the things you like and dislike and the clothes 
in your cupboard. Today’s compu-style choice: shorts and 
trainers for a game of football.

Windows 8 is a personal computer operating system developed by Microsoft 
as part of Windows NT family of operating systems. The operating system 
was released to manufacturing on August 1, 2012, and was released for 
general availability on October 26, 2012.
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Windows 7
Windows 7 is an operating system that 
was produced by Microsoft for use on 
personal computers. It is a GUI-style 
operating system produced by US-based 
Microsoft, the world’s largest software 
company. It is the operating system 
designed for businesses of all sizes and 
for advanced home computing. Windows 
7 made its official debut to the public on 
October 22, 2009.

It provides the following advantages:
•	 It is easier for a new user to learn and use the computer.
•	 It has the ability to run more than one program at the same time on the same computer.
•	 It manages computer’s memory and storage, enhancing their performance and 

extending their capabilities. 
•	 It enables to exchange information between different applications.  

Windows Desktop
The Windows Desktop is the opening screen for Windows and is the place where you 
begin your work using the computer. It is called the Desktop because windows uses your 
whole screen in a way that is similar to the way you use the top of your desk. The different 
components of Windows 7 Desktop are listed below:

The different components of Windows Desktop are listed below:

Facts Corner Windows 8 is a personal computer operating system developed by Microsoft as part of Windows NT 
family of operating systems.

Components of the Desktop		 Explanation

Icons	 Small pictures that represent commands and 
programs in Windows.

Taskbar	 The bar at the bottom of the Windows screen where 
active applications appear along with the system 
clock.

Start button	 The button at the left of the taskbar that allows you 
to open or to use several other Windows programs.
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Windows Explorer
Windows Explorer is an application program included with Windows 7. It allows you to 
efficiently manage files and folders present in the computer’s disk and view the contents 
of the computer. It is divided vertically into two sections. The left side displays the disk 
drives and folders in the form of a folder tree and the right side displays folders and files 
you have chosen from the left pane.

To view files using Windows Explorer, do the following:

1.	 Click on the Start button (or press CTRL+ESC) to see the Start menu.

2.	 Choose All Programs  | Accessories | Windows Explorer. 

3.	 Click the plus sign (+) next to the first folder that you want to investigate on the left 
side of the Windows Explorer window. 

4.	 Keep clicking the plus signs until you arrive at the folder you are looking for.

5.	 Click the folder’s name or icon to see its folders and files on the right side of the 
window. When you have found the folder you want, click a folder or file on the right 
side of the window and delete or copy or rename it.

Creating a New Folder
You can create a new folder to organize the information stored on your computer. Creating 
a folder is like placing a new folder in a filing cabinet. We can create a folder on the 
desktop so as to have quick and easy access to it.

To create a new folder, do the following:

1.		 Right-click an empty area of the desktop. A menu appears:

2.		 Click on New.

3.		 Click on Folder on the submenu. Type a name for the new folder and then press Enter 
key.
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Creating a file
A file is a collection of related records of data. You can instantly create, name and store a 
new file in the location you want.	

To create a file, do the following:

1.		 Right-click an empty area on the desktop. A menu appears:

2.	 Click on New.

3.	 Click on the type of the file that you want to create. Type a name for the new file and 
then press Enter key.

Renaming a File or Folder
Windows 7 allows you to give a file/folder a new name to better describe the contents of 
the file. Renaming a file/folder can make the file easier to find.

To rename files and folders, do the following: 

1.	 Right-click the file/folder which you want  to rename. A menu appears: 

2.	 Click Rename on the shortcut menu.

3.	 Type a new name for the file or folder.

4.	 Press Enter key.

Moving or Copying Files or Folders
Windows 7 offers different techniques for copying and moving files and folders stored on 
your computer to new locations. The most common techniques are menu command, and 
drag and drop.

To move or copy  files and folders, do the following: 

1.	 Right-click the file/folder which you want to move or copy.
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2.	 Click Cut on the shortcut menu to move the files or folders.

Or

	 Click Copy on the shortcut menu to copy the files or folders.

3.	 Display and double click the folder that is to receive the files or folders.

4.	 Right-click and then select Paste on the shortcut menu.

Deleting Files and Folders
Windows 7 allows you to delete files or folders that you no longer need. There are many 
ways to delete files and folders from My Computer and Windows Explorer windows, as 
well as from the Windows 7 desktop.

To delete files or folders, do the following: 

1.	 Select the file or folder that you want to delete.

2.	 Press the Delete key. The Confirm File Delete dialog box appears.

3.	 Click Yes to delete the file. The file disappears.

	 Windows places the file in the Recycle Bin in case you later want to restore the file.
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Restoring or Emptying a Deleted Files and Folders
The Recycle Bin stores all the files you have deleted. Except for files deleted from 
removable disks, such as removable disks, Windows stores items you delete in the Recycle 
Bin, where they can be restored to their original locations, if needed. 	

To restore files or folders, do the following:  
1.	 Double-click the Recycle Bin on the desktop. The Recycle Bin opens.
2.	 Examine the files and folders that you want to restore.
3.	 Select the files and folders you want to restore.

4.	 Right-click an item you’ve selected and choose Restore from the shortcut menu. The 
items you restore will be placed in the same old folders.

To empty the Recycle Bin, do the following:  
1.	 Right-click the Recycle Bin icon on the desktop.
2.	 Choose Empty Recycle Bin from the shortcut menu.

Creating Shortcuts
A shortcut is created for a program, file or folder that is most frequently used. It is created 
at a location which is most convenient for the user to access (mostly it is the Desktop 
of your computer), so that the user can quickly open the program or file. Shortcut that 
appears on the desktop can be copied or moved to another location also.		

To create a shortcut, do the following: 
1.	 Right-click an empty area of desktop or folder workspace.
2.	 Click on New.
3.	 Click Shortcut on the submenu.
4.	 In the box provided, type the location of the item, then click Next.
5.	 In the box provided, type the name for the shortcut, then click Next.
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Operating System :	 A set of system programs that control and coordinate the operation 
of a computer system.

Desktop	 :	 An on-screen work area that uses icons and menus to simulate the 
top of a desk.  

Windows 7	 :		 An operating system that is produced by Microsoft for use on 
personal computers. 

Icon	 :	 A representation of an element in Windows.
Window	 :	 A rectangular area on the screen that contains its own data.
Taskbar	 :	 A long horizontal bar located at the bottom of the screen when 

you start Windows for the first time.

Tricky Terms

Let 
Us Revise
•	 Operating system is software, consisting of programs and data, that runs on computers, 

manages computer hardware resources, and provides common services for execution 
of various application software.

•	 Windows 7 is an operating system that was produced by Microsoft for use on personal 
computers, including home and business desktops, laptops and media centers. 

•	 Windows 7 Desktop is the main background area on a Windows screen where you 
start the work.

•	 An icon is a graphic image, a small picture or object that represents a file, program, 
web page, or command. 

•	 Taskbar is a long horizontal bar located at the bottom of the screen when you start 
Windows for the first time.

•	 A mouse pointer, or a cursor, is a visible indicator displayed on a computer screen. 
•	 A file is a complete, named collection of information, such as a program, a set of data 

used by a program, or a user created document.
•	 In computing, a directory, also referred to as a folder is a virtual container within a 

digital file system, in which groups of computer files and possibly other directories 
can be kept and organized.

•	 Windows stores items you delete in the Recycle Bin, where they can be restored to 
their original locations, if needed. 
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Solved Exercises
1.		 What is an operating system? What purpose does the operating serve to the computer and the user?
Ans:	 An operating system is a software that controls the operation of a computer, directs the input and output of data, 

keeps track of files, and controls the processing of computer programs. The operating system narrows the gap 
between the user and the computer by receiving and interpreting user’s request and then getting the required 
work done through the hardware.

2.		 What is Microsoft Windows XP? What are the advantages of Microsoft Windows XP? 
Ans:	 Windows XP is an operating system that is produced by Microsoft for use on personal computers, including home 

and business desktops, laptops, and media centers. It provides the following advantages:
		 •	 It is easier for a new user to learn and use the computer.
		 •	 It has the ability to run more than one program at the same time on the same computer.
		 •	 It manages computer’s memory and storage, enhancing their performance and extending their capabilities. 
		 •	 It enables to exchange information between different applications.  	
		
3.		 What is a desktop? What are the main elements of Windows desktop? 
Ans:	 Desktop is an on-screen work area that uses icons and menus to simulate the top of a desk. The main elements of 

Windows desktop are: My Documents, My Computer, Recycle Bin and My Network Places.
		
4.		 What is an icon?
Ans: 	 Icon is a graphical representation of an element in Windows, such as a disk drive, folders, application, documents 

and other computers.

5.		 What is a mouse pointer?
Ans: 	 A mouse pointer on the screen is controlled by moving the device called mouse, which has one or more push-

buttons that transmit instructions to the computer.

6.		 What is a Window? 
Ans: 	 Window is an enclosed, rectangular area on a display screen. 

7.		 What is a file? 
Ans:	 A file is a complete, named collection of information, such as a program, a set of data used by a program, or a user 

created document.

8.		 What is a folder? 
Ans:	 In computing, a directory, also referred to as a folder is a virtual container within a digital file system, in which 

groups of computer files and possibly other directories can be kept and organized.
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Chapter Review
1.	 State whether the following statements are true or false. 

a.  	 The faster and more powerful the CPU and the greater the amount of memory; the 
more the operating system can do. 

b.	 Icons  is the bar at the bottom of the Windows screen where active applications 
appear along with the system clock.

c.	 A folder is a collection of related records of data. 

d.	 Windows 7 allows you to give a file/folder a new name to better describe the contents 
of the file. 

e.	 The Recycle Bin stores all the files you have deleted. 

 

2.	 Fill in the blanks. 

a.  		 An ________________________is software that communicates with the hardware 
and allows other programs to run. 

b.	 Windows 7 is an operating system that was produced by __________________for 
use on personal computers.

c.	 The __________________________is the opening screen for Windows and is the 
place where you begin your work using the computer. 

d.	 ______________________allows you to efficiently manage files and folders present 
in the computer’s disk and view the contents of the computer.

e.	 A_______________________is created for a program, file or folder that is most 
frequently used.

3.	 Give the appropriate technical term for the following.	

a.	 The main background area on a Windows screen where you start the work. 

b.	 The bar at the bottom of the Windows screen where active applications appear along 
with the system clock.

c.	 The program which allows you to efficiently manage files and folders present in the 
computer’s disk or any other secondary storage media.

d.	 A storage area on some storage medium in which you can store files and other folders.

e.	 A collection of related information referred by a name and stored on a disk.
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4.	 Match the following.
	 Group A	 Group B
	 Folder	 An interface for issuing commands to a computer 

utilizing a pointing device.
	 File	 The opening screen for Windows and it is the 

place where you begin your work using the 
computer.	  

	 Desktop	 The small pictures that represent commands and 
programs in Windows.

	 Icons	 A storage area on some storage medium in which 
you can store files and other folders.	  

	 GUI	 A collection of related records of data.

5.	 	In your own words, briefly answer the following questions.
a.		 What is an operating system?	
b.	 State any three important functions of an operating system.
c.	 What is Windows 7? What are the advantages of Windows 7?
c.	 What is Windows Desktop? What are the different components of Windows Desktop?
d.	 What is an icon?
e.	 What is Taskbar? Name the components of Taskbar.	
f.	 What is Windows Explorer?
g.	 Define the following terms:
	 i. Folder 			   ii. File
h.	 What does the Recycle Bin icon on the Desktop represent? How do you use it.

Lab Exercises
a.		 Create a folder Publisher on the Desktop.
b.	 Create a text file named Sun inside the folder Publisher.	
c.	 Create a shortcut for this file on the Desktop.
d.	 Open the file using the Shortcut.
e.	 Close the file.
f.	 Delete the folder and Shortcut you have created on the Desktop.
g.	 Shut down the computer.



Microsoft Office
Word 20107

Objectives

After completing this chapter, you will be able 
to:

	Define word processing and list some of the 
popular word processing software.

	Explain the advantages of Microsoft Office 
Word 2010.

	Identify the different parts of Microsoft 
Word 2010.

	Discuss how to format text and paragraphs.
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Concept: Word Processing
Word processing refers to the use of a computer and specialized software to write, edit, 
format, print, and save text. It has various functions that allow a person to revise text 
without retyping an entire document. As the text is entered or after it has been retrieved, 
sections ranging from words and sentences to paragraphs and pages can be moved, copied, 
deleted, altered, and added to while displayed. As word processors have become more 
sophisticated, such functions as word counting, spell checking, a document’s format-type 
size, line spacing, margins and page length can be easily altered. There are many word 
processing software packages available for use with personal computers. Some of the 
popular word processing software are Word Star, Word Perfect and Microsoft Word.. 

Microsoft Office Word 2010 is a full-featured word processing program that allows you 
to create professional looking documents. It is one of the products under the MS-Office 
packages developed by Microsoft Corporation, USA. 

Microsoft Office Word 2010 has the following advantages:
•	 Word allows to edit a document.	
•	 Word has many features that controls the appearance or format of the document.
•	 Word provides tools that enable you to create Web pages with ease.
•	 Word provides you with powerful desktop publishing tools to use as you create 

professional looking brochures, advertisements, and newsletters.
•	 The drawing tools in Word allows you to design impressive 3-D effects by including 

shadows, textures and curves. 
	 Microsoft Word offers an easy-to-use navigation pane at the top. This allows you to 

see visual representations of many of the functions that you might need.

A look to Future

More bits per bytes
A bit is a binary digit, 0 or 1. In a computer, bits are put 
together in groups called bytes. Bigger, more powerful 
computers can process more bits per second, allowing more 
combinations and computations per byte. As computers get 
faster, humans may not be able to keep up. A future computer 
may need dozens of people rushing between its many screens 
and keyboards to keep it satisfied.

Facts Corner Microsoft Office 2013 (formerly Office 15) is a version of Microsoft Office, a productivity suite 
for Microsoft Windows.
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Launching Microsoft Word
Microsoft Word can be opened in the same way as you open any other office application.

To load Microsoft Word, follow these steps:	

•	 Click on Start menu |Programs |Microsoft Office|Microsoft Office Word 2003. The 
Microsoft Word program window opens up with the components as shown below:

Word 2010 is a word processor that allows you to create various types of documents 
such as letters, papers, flyers, and faxes. Word 2010 interface include the Ribbon and the 
Quick Access Toolbar. Unlike Word 2007, commands such as Open and Print are housed 
in Backstage view, which replaces the Microsoft Office Button.

The Ribbon
The new, tabbed Ribbon system was introduced in Word 2007 to replace traditional menus. 
The Ribbon contains all of the commands you’ll need in order to perform common tasks. 
It contains multiple tabs, each with several groups of commands, and you can add your 
own tabs that contain your favorite commands. Some groups have an arrow in the bottom-
right corner that you can click to see even more commands.
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Backstage view
Backstage view gives you various options for saving, opening a file, printing, or sharing 
your document. It is similar to the Office Button Menu from Word 2007 or the File Menu 
from earlier versions of Word. However, instead of just a menu, it is a full-page view, 
which makes it easier to work with.
To get to Backstage view:
1.	 Click the File tab. 
2.	 You can choose an option on the left side of the page.
3.	 To get back to your document, just click any tab on the Ribbon.

The Quick Access Toolbar
The Quick Access Toolbar is located above the Ribbon, and it lets you access common 
commands no matter which tab you’re on. By default, it shows the Save, Undo, and 
Repeat commands. You can add other commands to make it more convenient for you.

To add commands to the Quick Access Toolbar:
1.	 Click the drop-down arrow to the right of the Quick Access Toolbar.
2.	 Select the command you wish to add from the drop-down menu. It will appear in 	
	 the Quick Access toolbar.

The Ruler
The Ruler is located at the top and to the left of your document. It makes it easier to adjust 
your document with precision. If you want, you can hide the Ruler to free up more screen 
space.
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Creating and opening documents
Word files are called documents. Whenever you start a new project in Word, you’ll need 
to create a new document, which can either be blank or from a template. You’ll also need 
to know how to open an existing document.
To create a new, blank document:
1.	 Click the File tab. This takes you to Backstage view.
2.	 Select New.
3.	 Select Blank document under Available Templates. It will be highlighted by default.
4.	 Click Create. A new, blank document appears in the Word window.

To open an existing document:
1.	 Click the File tab. This takes you to Backstage view.
2.	 Select Open. The Open dialog box appears.
3.	 Select your document, then click Open.
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Working with text
If you’re new to Microsoft Word, you’ll need to learn the basics of working with text so 
you can type, reorganize, and edit text. You’ll need to know how to insert, delete, and 
move text, as well as how to find and replace specific words or phrases.

To insert text:
1.	 Move your mouse to the location where you wish text to appear in the document.
2.	 Click the mouse. The insertion point appears. 
3.	 Type the text you wish to appear.

To delete text:
1.    Place the insertion point next to the text you wish to delete.
2.	 Press the Backspace key on your keyboard to delete text to the left of the insertion 

point.
3.    Press the Delete key on your keyboard to delete text to the right of the insertion point.

To select text:
1.	 Place the insertion point next to the text you wish to select.
2.	 Click the mouse, and while holding it down drag your mouse over the text to select 

it.
3.	 Release the mouse button. You have selected the text. A highlighted box will appear 

over the selected text.

To copy and paste text:
1.	 Select the text you wish to copy.
2.	 Click the Copy command on the Home tab. You can also right-click your document 

and select Copy.
3.	 Place your insertion point where you wish the text to appear.
4.	 Click the Paste command on the Home tab. The text will appear.

To cut and paste text:
1.	 Select the text you wish to copy.
2.	 Click the Cut command on the Home tab. You can also right-click your document 	
	 and select Cut. 
3.	 Place your insertion point where you wish the text to appear.
4.	 Click the Paste command on the Home tab. The text will appear.
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Formatting Font
A font, also commonly referred to as a typeface, is a set of characters with a specific 
design. Each font has one or more sizes. Size is the height and width of the character and 
is commonly measured in points, abbreviated “pt”. One point equals about 1/72 inch, and 
the text in most documents is 10 pt or 12 pt. Microsoft Word provides a huge variety of 
fonts to improve the appearance of your document. The default font in Word is Times 
New Roman. 

To format font, follow these steps:	  

1.	 Open an existing Word document or start a new document and type your text.

2.	 If you’d like to change a portion of the text to a different font, it will need to be 
selected or highlighted first. When the mouse pointer is moved over a text area, it will 
change from an arrow to a ‘text select’ or ‘I-beam’ icon.3.Move the mouse pointer 
over the various fonts. A live preview of the font will appear in the document. 

3.	 Select your text so that it’s highlighted.

4.	 To change the font style, click the arrow next to the font style in the ribbon at the top 
of your document.

5. 	 Choose your font style from the drop-down list given.

6. 	 Next to the font style box is a box containing a number and an arrow. This changes 
the size of the font. Click on the arrow.

7. 	 Choose the size of font from the drop-down list of options.

8. 	 If you’d like the same size and style of font set up every time you start a new document, 
you can set a ‘default font’. Click on the ‘Font’ arrow just above the main screen.
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9. 	 A dialogue box will pop up. In this, choose your font size and style from the options.

10. 	Click Set As Default in the bottom left-hand corner of the dialogue box.

11.	 Another dialogue box will pop up asking if you’re sure you want to change the font 
for all Word documents. Click Yes. Now, whenever you open a new document in 
Word, the default font will be used.

 12.	If you want to change the default font in an earlier version of Word, click Format at 
the top of your document to open the ‘Format’ menu. Choose Font from the menu 
list. Then follow steps 9 to 11.

The MiniBar or Mini Toolbar in MS Word 2010
Another feature in Word 2010 is the MiniBar, more 
formally known as the Mini Toolbar. The MiniBar is a 
set of formatting tools that appears when you first select 
text. It is not context-sensitive, and always contains an 
identical set of formatting tools. There is no MiniBar for 
graphics and other non-text objects.

When you first select text, the MiniBar appears as a ghostly apparition. When you move 
the mouse pointer closer to it, it becomes more solid, as shown in Figure 1-13. If you 
move the mouse pointer far enough away from it, it fades away completely.

Character-Formatting Shortcut Keys
The table provides a quick reference of keyboard shortcuts related to character formatting.

Command	 Keystroke	

All Caps	 Ctrl+Shift+A

Small Caps	 Ctrl+Shift+K

Bold	 Ctrl + B, Ctrl + Shift + B

Copy Formatting	 Ctrl + Shift + C

Font Dialog box	 Ctrl + D, Ctrl + Shift + F

Highlighting	 Alt + Ctrl + H

Italics	 Ctrl + I

Underline	 Ctrl + B

Font Size	 Ctrl + Shift + P
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Formatting Paragraphs
Formatting paragraphs allows you to change the look of the overall document. You can 
access many of the tools of paragraph formatting by clicking the Page Layout Tab of the 
Ribbon or the Paragraph Group on the Home Tab of the Ribbon.

Indentation
Indentation is the distance between text boundaries and page margins. By default, a 
paragraph’s left and right indents are set equal to the document’s left and right margins. 
However, a document’s left and/or right indents can be modified without changing the 
document’s margins. There are four types of indent you can use to stylize your documents. 
They are: 
First Line: Controls the left boundary for the first line of a paragraph
Hanging: Controls the left boundary of every line in a paragraph except the first one
Left: Controls the left boundary for every line in a paragraph
Right: Controls the right boundary for every line in a paragraph

To indent paragraphs, follow these steps:

1.	 Click the Indent buttons to control the indent.

2. 	Click the Indent button repeated times to increase the size of the indent.

3.	 Click the dialog box of the Paragraph Group

4.	 Click the Indents and Spacing Tab

5.	 Select your indents.
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Changing the Line Spacing
Line spacing is the amount of white space between lines of text in a paragraph. It is 
measured in lines or in points. It is set to a single line spacing by default in Microsoft Word. 
The line spacing affects all lines of the text in the selected paragraph or the paragraph that 
contains the cursor.

To change the line spacing, follow these steps: 

1.	 Select the paragraph or paragraphs you wish to change.

2. 	On the Home Tab, Click the Paragraph Dialog Box

3. 	Click the Indents and Spacing Tab

4.	 In the Spacing section, adjust your spacing accordingly

Paragraph Alignment
The paragraph alignment allows you to set how you want text to appear. Text starts out 
positioned evenly along the left margin, and uneven, or ragged, at the right margin. Left-
aligned text works well for body paragraphs in most cases, but other alignments vary 
the look of a document and help lead the reader through the text. Right-aligned text, 
which is even along the right margin and ragged at the left margin, is good for adding a 
date to a letter. Justified text spreads text evenly between the margins, creating a clean, 
professional look, often used in newspapers and magazines. Centered text is best for titles 
and headings. 

To change the alignment, follow these steps:

1.	 Click the Home Tab

2.	 Choose the appropriate button for alignment on the Paragraph Group.

3.	 Align Left: the text is aligned with your left margin

4.	 Center: The text is centered within your margins

5.	 Align Right: Aligns text with the right margin

6.	 Justify: Aligns text to both the left and right margins.

They can be set with CTRL+L, CTRL + R, CTRL + E and CTRL + J.
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Adding Borders and Shading
Word lets you add borders and shading to the text in your document to make it look 
attractive. You can apply a border to selected text or to individual paragraphs. To surround 
a paragraph with a border, click anywhere in the paragraph. To surround only specific 
text, such as a word, with a border, select the text. By default, MS-Word applies a 1/2 pt 
(point) black solid line border around all table cells.

To add borders to text, follow these steps: 

1.	 Select the text or paragraph to which you want to add border. You can use any of the 
text selection method to select the paragraph(s).

2.	 Click the Border Button to display a list of options to put a border around the 
selected text or paragraph. You can select any of the option available by simply 
clicking over it.

Paragraph Decoration
A second kind of paragraph formatting is something that might be termed paragraph 
decoration. This includes shading, boxes, bullets, and other semi-graphical elements that 
help the writer call attention to particular paragraphs, or that help the reader understand 
the text better.

Changing a Bulleted and Numbered Lists
A bulleted list displays one of several styles of bullets before each item in the list. A 
numbered list displays numbers or letters before the text. Bulleted and numbered lists are 
used to organize information and to make your writing clear and easy to read. A list can 
be used whenever you present three or more related pieces of information. By default, 
Microsoft Word uses a simple black dot as a bullet.	

To create a bulleted and numbered list, follow these steps: 
1	 Select the items that you want to add bullets or numbering to.
2.	 On the Home tab, in the Paragraph group, click Bullets or Numbering.
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3.	 Add different borders like left, right top or bottom by selecting different options from 
the border options.

4.	 To delete the existing border, simply select No Border option from the border options.
	 Note
	 You can add a horizontal line by selecting Horizontal Line option from the border 

options. 

Spacing between Paragraphs
The appearance of your documents improves if some blank spaces are left between the 
end of one paragraph and the start of the next. You can accomplish this by pressing Enter 
twice at the end of a paragraph. By using paragraph dialog box, you can have greater 
control over your paragraph spacing and save time, too.	

To change spacing between paragraphs, follow these steps: 

1.	 Click the Line and Paragraph Spacing command on the Home tab.

2.	 Select Add Space Before Paragraph or Remove Space After Paragraph from the drop-
down menu. 
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Adding a Drop Cap
Drop cap is a large, uppercase character with the top part of the letter even with the line 
and the rest of the letter extending into the paragraph below it. The character is changed 
to a graphic object in a frame and the text wraps to the side of the object. The drop cap 
effect emphasizes the beginning of the paragraph and makes the columns appear more 
like those in a magazine.

To add a drop cap, follow these steps: 

1.	 Click in the paragraph that you want to begin with a drop cap. 

	 The paragraph must contain text.

2.	 On the Insert tab, in the Text group, click Drop Cap. 

3.	 Click Dropped or In margin.

Changing the Case of Letters
Microsoft Word provides facilities to change the case of the text in a document. There are 
five case options in Microsoft Word. They are: Sentence case, Lowercase, UPPERCASE, 
Title Case and tOGGLE cASE.

To change the case of letters, follow these steps: 
1.	 Select the text that you want to change to a bold font. You can use any of the text 

selection method to select the text.
2.	 On the Home tab, in the Font group, click Change Case. 
3.	 Choose an option from the dropdown list, which includes Sentence case, lowercase, 

UPPERCASE, Capitalize Each Word, and tOGGLE cASE.
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Working with Shapes
Word’s large shape collection allows you to organize and design the image you desire. 
While you may not need shapes in every document you create, they can add visual appeal. 
To use shapes effectively, you’ll need to know how to insert a shape and format it by 
changing its fill color, outline color, and shape style, as well as add 3D effects.

To insert a shape, follow these steps: 

1.	 Select the Insert tab.

2.	 Click the Shapes command. 

3.	 Select a shape from the drop-down menu.

4.	 Click and drag the mouse until the shape is the desired size.
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Text boxes
Text boxes are useful for helping to organize your document. They are basically treated 
the same as shapes, so when you insert a text box you can format it by changing its fill 
color, outline color, and shape style, as well as create WordArt and add 3D effects.

To insert a text box, follow these steps: 
1.	 Select the Insert tab on the Ribbon.
2.	 Click the Text Box command in the Text group. A drop-down menu will appear.
3.	 Select Draw Text Box.

4.	 Click and drag on the document to create the text box.

5.	 You can now start typing to create text inside the text box



Computer Zone - Book 6 75

Creating WordArt
In addition to adding effects to a text box, you can also add effects to the text inside the 
text box, which is known as WordArt. For the most part, the types of effects you can 
add are the same as the ones you can add to shapes or text boxes (shadow, bevel, etc.). 
However, you can also Transform the text to give it a wavy, slanted, or inflated look.

To apply a Quick Style to text, follow these steps: 

1.	 Select the text box, or select some text inside of the text box. The Format tab will 
appear.

2.	 Click the Format tab.

3.	 Click the Quick Styles command in the WordArt Styles group. A drop-down menu 
will appear. 

4.	 Select the desired style preset to apply the style to your text.

To convert regular text into WordArt, follow these steps: 

1.	 Select the text you wish to convert.

2.	 Click the Insert tab.

3.	 Click the WordArt command. The Quick Styles drop-down menu will appear.

4.	 Select the desired Quick Style.

5.	 Word will automatically create a text box for your text and apply the style to the text
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Tricky Terms

Let 
Us Revise
•	 Word processing refers to the use of a computer and specialized software to write, 

edit, format, print, and save text. 

•	 Microsoft Office Word 2010 is a full-featured word processing program that allows 
you to create professional looking documents.

•	 Backstage view gives you various options for saving, opening a file, printing, or 
sharing your document.

•	 A font, also commonly referred to as a typeface, is a set of characters with a specific 
design. 

•	 The MiniBar is a set of formatting tools that appears when you first select text.

•	 Formatting paragraphs allows you to change the look of the overall document. 

•	 Indentation is the distance between text boundaries and page margins.

•	 Line spacing is the amount of white space between lines of text in a paragraph. 

•	 Word lets you add borders and shading to the text in your document to make it look 
attractive. 

•	 Drop cap is a large, uppercase character with the top part of the letter even with the 
line and the rest of the letter extending into the paragraph below it. 

•	 Microsoft Word provides facilities to change the case of the text in a document. 

•	 Text boxes are useful for helping to organize your document.

Word processing	 :	 The use of a computer and specialized software to write, 
edit, format, print and save text.

Word wrap	 :	 A word processing feature that automatically determines 
where to end a line and wrap text to the next line.

Font	 :	 A set of characters with a specific design.	
Indentation	 :	 The distance between text boundaries and page margins. 
Drop cap	 :	 A large, uppercase character with the top part of the letter 

even with the line and the rest of the letter extending into the 
paragraph below it.

Line spacing	 :	 The amount of white space between lines of text in a 
paragraph.
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Solved Exercises
1.		 What is word processing software? Give examples.
Ans:	 Word processing refers to the use of a computer and specialized software to write, edit, format, print, and save 

text. It has various functions that allow a person to revise text without retyping an entire document. 
	 Some of the popular word processing software are Word Star, Word Perfect and Microsoft Word.
		
2.		 What are the advantages of Microsoft Office Word?
Ans: 	 The advantages of Microsoft Office Word are listed below:
	 • 	 Word allows to edit a document.	
	 •	 Word has many features that controls the appearance or format of the document.
	 •	 Word provides tools that enable you to create Web pages with ease.
	 •	 Word provides you with powerful desktop publishing tools to use as you create professional looking brochures, 

advertisements, and newsletters.
	 •	 The drawing tools in Word allows you to design impressive 3-D effects by including shadows, textures and 

curves.

3.		 What is a font? What  is the default font of MS-Word?
Ans: 	 A font, also commonly referred to as a typeface, is a set of characters with a specific design. The default font in 

Word is Times New Roman.

4.		 What is a paragraph alignment? What are the four types of paragraph alignment?
Ans: 	 Paragraph alignment refers to the way text is set with respect to the margins. There are four types of paragraph 

alignment style. These styles are: left alignment, right alignment, center alignment and justified.

5.		 What is indentation? What are the four types of indents you can use to stylize your document?
Ans: 	 Indentation is the distance between text boundaries and page margins. There are four types of indent you can use 

to stylize your documents. They are: left, right, first line and hanging.

6.		 What is drop cap?
Ans:	 Drop cap is a large, uppercase character with the top part of the letter even with the line and the rest of the letter 

extending into the paragraph below it. 

7.		 What is Word Art?
Ans:	 WordArt is decorative text that you can add to a document. You can make changes to WordArt, such as the font 

size and the text color, by using the drawing tools options available automatically after you insert or select the 
WordArt in a document. 
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Chapter Review
1.	 State whether the following statements are true or false. 

a.  	 Microsoft Office Word 2010 is a full-featured presentation program that allows you 
to create professional looking documents.

b.	 Word provides tools that enable you to create Web pages with ease.

c.	 The MiniBar is a set of formatting tools that appears when you first select text.

d.	 Line spacing is the distance between text boundaries and page margins.

e.	 The line spacing affects all lines of the text in the selected paragraph or the paragraph 
that contains the cursor.

 
2.	 Fill in the blanks. 

a.  	 __________________refers to the use of a computer and specialized software to 
write, edit, format, print, and save text. It has various functions that allow a person to 
revise text without retyping an entire document. 

b.	 ____________________view gives you various options for saving, opening a file, 
printing, or sharing your document.

c.	 A_____________________, also commonly referred to as a typeface, is a set of 
characters with a specific design. 

d.	 ____________________is the distance between text boundaries and page margins.

e.	 _______________________is a large, uppercase character with the top part of the 
letter even with the line and the rest of the letter extending into the paragraph below 
it. 

3.	 Give the appropriate technical term for the following.	

a.	 A word processing feature that automatically determines where to end a line and 
wrap text to the next line.

b.	 A set of characters with a specific design.	

c.	 The distance between text boundaries and page margins. 

d.	 A large, uppercase character with the top part of the letter even with the line and the 
rest of the letter extending into the paragraph below it.

e.	 The amount of white space between lines of text in a paragraph.
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4.	 Match the following.
	 Group A		 Group B
	 Font	 A word processing feature that automatically 

determines where to end a line and wrap text to the 
next line.

	 Indentation		 A set of characters with a specific design.	
	 Word wrap	 The distance between text boundaries and page 

margins. 
	 Line spacing	 A large, uppercase character with the top part of the 

letter even with the line and the rest of the letter 
extending into the paragraph below it.

	 Drop cap	 The amount of white space between lines of text in a 
paragraph.

5.	 Answer the following questions.
a.		 What is word processing? Name any three word processing software.
b.	 What is Microsoft Office Word? State any three advantages of Microsoft Office 

Word.
c.	 What is a backstage view in Microsoft Office Word 2010?	
d.	 What is a font? What are the different font style options available in Microsoft Word?
e.	 What is a minibar in Microsoft Office Word 2010?
f.	 What is indentation? What are the four types of indents Microsoft Office Word 2010?
g.	 What is a paragraph alignment? Name the different types of paragraph alignments 

available in Microsoft Word.	
h.	 What is meant by : 	
	 i. Paragraph alignment
		 ii. Line spacing
		 iii. Drop cap ?
i.	 Write the steps to perform the following tasks.
	 i. To indent paragraphs
	 ii. To change line spacing
	 iii. To add a drop cap
	 iv.	To change the case of letters
	 v.	 To insert a shape
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Lab Exercises
Lab Exercise 1
a.	 Start MS-Word.  
b. 	 Type in the following text given below:
		  Namaste

	 The traditional form of salutation in Nepal is called ‘Namaste’ or ‘Namaskar’. The word Namaste comes from the 
Sanskrit language. Namaste could be an amalgam of Namsya (or Namaha) meaning obeisance and ‘Te’ which 
means you or to you. Thus Namaste as an amalgam of Namasyate could be translated as obeisance to youc.  	
Correct any spelling or grammar errors.

c.	 Format the heading “Namaste” to 16 point bold and centered.
d.  	 Format the entire document to the Arial black.  
e.  	 Format the important words of your text to italics.
f.  	 Set the character spacing to expanded and check the effect.
g.  	 Change the alignment as justified.
h.  	 Change the line spacing into 1.5 lines.
i.  	 Save the document as Lab1. 

Lab Exercise 2
a.	 Start MS-Word.  
	 The Power of Positive

	 All of our feelings, beliefs and knowledge are based on our internal thoughts, both conscious and subconscious. We 
can be positive or negative, enthusiastic or dull, active or passive. Our present attitudes are habits, built from the 
feedback of parents, friends, society and self, that form our self-image and our world-image.

b.	 Bold, colour and increase the font size of a title to 14 pt.	
c. 	 Set the line spacing to 1.5.
d.	 Drop the first letter “A” to three lines.
e.	 Change the case of:
	 i. All the characters to capital letter.
	 ii. First character of sentence to capital letter.
	 iii. First letter of every word to uppercase.
f.	 Insert the graphic clip from your data disk below the title.	
g. 	 Save the document as Lab2.
h.	 Close the document and exit Microsoft Word.
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Objectives

After completing this chapter, you will be able 
to:

	Define an electronic spreadsheet and list out 
some of the popular spreadsheet software.

	List out some important advantages of 
Microsoft Excel.

	Define workbook and worksheet.

	Define cell and explain how to select cell.

	Explain how to use formula and function in 
Microsoft Excel.

	Explain how to create chart in Microsoft 
Excel.

Microsoft Office
Excel 2010
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Concept: Spreadsheet Software
With the expansion of computer technology and the widespread use of business software, 
electronic spreadsheets were born. A spreadsheet, also known as a worksheet, contains 
rows and columns and is used to record and compare numerical or financial data. Originally, 
spreadsheets only existed in paper format, but now they are most likely created and 
maintained through a software program that displays the numerical information in rows 
and columns. Spreadsheets can be used in any area or field that works with numbers and 
are commonly found in the accounting, budgeting, sales forecasting, financial analysis, 
and scientific fields. The popular electronic spreadsheet software are:LOTUS 1-2-3, 
Quattropro and Microsoft Excel.

Microsoft Excel is a commercial spreadsheet application written and distributed by 
Microsoft for Microsoft Windows and Mac OS X. The current versions are 2010 for 
Windows and 2011 for Mac. It was developed by Microsoft Corporation for computers 
using the Microsoft Windows operating system. It is a part of the suite of Office package. 
The important features of Microsoft Excel are listed below:
1.	 It allows you to perform calculations on data quickly and accurately. 
2.	 The built-in functions in Microsoft Excel make calculations easy and fast.
3.	 It lets you instantly convert a set of data into a graph or a chart.
4.	 It recalculates the result of a mathematical formula automatically if you make a 

change in a value or number in a cell.
5.	 It enables you to analyze data by changing the data in different ways and seeing the 

impact of these changes in different situations.

A look to Future

Real Virtual Reality
Could virtual reality become true really? Imagine a world 
covered with cameras, microphones and scent-detectors, 
which feed all sights, sounds and smells into a giant computer 
network. Everyone wears a headset. At the flick of a switch we 
could experience any scene, even going back in time.

Facts Corner VisiCalc was the first spreadsheet computer program, originally released for the Apple II. IDan 
Bricklin and Bob Frankston invented VisiCalc. 
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What’s New in Excel 2010?
Excel is a spreadsheet program that allows you to store, organize, and analyze information. 
Microsoft Office Excel 2010 provides several methods for starting and exiting the program. 
You can open Excel by using the Start menu or a desktop shortcut. When you want to exit 
Excel, you can do so by using the File tab, the Close button, or a keyboard shortcut. 

To starting Excel 2010 from the Start menu, do the following:

To start Excel 2010 from the Windows Start menu, choose Start→All Programs→Microsoft 
Office→Microsoft Excel 2010. A new, blank workbook appears, ready for you to enter 
data.

Exiting Excel 2010
When you’re ready to quit Excel, you have several choices for shutting down the program:

•	 Choose File→Exit.

•	 Press Alt+F4.

•	 Click the Close button (the X) in the upper-right corner of the Excel 2010 program 
window.

If you try to exit Excel after working on a workbook and you haven’t saved your latest 
changes, Excel displays an alert box asking whether you want to save your changes. To 
save your changes before exiting, click the Save button. If you don’t want to save your 
changes, click Don’t Save.
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Working with your Excel environment
The Ribbon and Quick Access Toolbar are where you’ll find the commands you need to 
perform common tasks in Excel. If you are familiar with Excel 2007, you will find that 
the main difference in the Excel 2010 Ribbon is that commands such as Open and Print 
are now housed in Backstage view.

The Ribbon
The Ribbon contains multiple tabs, each with several groups of commands. You can add 
your own tabs that contain your favorite commands.

The Quick Access Toolbar
The Quick Access Toolbar is located above the Ribbon, and it lets you access common 
commands no matter which tab you are on. By default, it shows the Save, Undo, and 
Repeat commands. You can add other commands to make it more convenient for you.

To add commands to the Quick Access Toolbar:

1.	 Click the drop-down arrow to the right of the Quick Access Toolbar.

2.	 Select the command you wish to add from the drop-down menu. To choose from 
more commands, select More Commands. 
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Understanding Workbooks and Worksheets
The work you do in Excel is performed in a workbook file, which appears in its own 
window. You can have as many workbooks open as you need. By default, Excel 2010 use 
an .xlsx file extension.

Each workbook comprises one or more worksheets, and each worksheet is made up 
of individual cells. Each cell contains a value, a formula, or text. A worksheet also has 
an invisible draw layer, which holds charts, images, or diagrams. Each worksheet in a 
workbook is accessible by clicking the tab at the bottom of the workbook window. In 
addition, workbooks can store chart sheets. A chart sheet displays a single chart and is 
also accessible by clicking a tab.

Column letter

Row number

Worksheet

Row

Column

Cell

Exploring Data Type
The worksheet cell can contain text, value, formula and function entries. Text entries are 
any combination of characters that you can type on the keyboard including symbols ($, #, 
@, and so on), numbers, letters, and spaces. By default, text is automatically left-aligned 
in a cell. Values are numbers that represent a quantity, date or time. Formula is an entry 
that performs a calculation using numbers or data contained in other cells. Every formula 
must begin with an equal to sign (=). A function is a built-in or prerecorded formula that 
provides a shortcut for complex calculations. Excel has hundreds of functions available 
for your use.

To enter data in a cell, do the following:
1.	 Click in the cell in which you want to enter data.
2.	 Type in the required data. The data fills the active cell and the formula bar at the same 

time.
	 The formula bar buttons are activated only when you are entering data into a cell.
3.	 The      button is called the Cancel button and can be used to cancel data entry.
4.	 The       button is called the Enter button and can be used to accept data entry.
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Worksheet Basics
When you open an Excel workbook, there are three worksheets by default. The default 
names on the worksheet tabs are Sheet1, Sheet2, and Sheet3. To organize your workbook 
and make it easier to navigate, you can rename and even color code the worksheet tabs. 
Additionally, you can insert, delete, move, and copy worksheets. 

To rename worksheets, do the following:
1.	 Right-click the worksheet tab you want to rename. The worksheet menu appears.
2.	 Select Rename.

3.	 The text is now highlighted by a black box. Type the name of your worksheet.
4.	 Click anywhere outside of the tab. The worksheet is renamed.

To insert new worksheets, do the following:
1.	 Click the Insert Worksheet icon. A new worksheet will appear. 
	 You can change the setting for the default number of worksheets that appear in Excel 

workbooks. To access this setting, go into Backstage view and click on Options.
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To delete worksheets, do the following:

Worksheets can be deleted from a workbook, including those that contain data.

1.    Select the worksheets you want to delete.

2.    Right-click one of the selected worksheets. The worksheet menu appears.

3.  	 Select Delete. The selected worksheets will be deleted from your workbook. 

To copy a worksheet, do the following:

1.   	Right-click the worksheet you want to copy. The worksheet menu appears.

2.	 Select Move or Copy.

3.	 The Move or Copy dialog box appears. Check the Create a copy box.

4.	 Click OK. Your worksheet is copied. It will have the same title as your original 
worksheet, but the title will include a version number. 
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4.	 Select the font you want to use.

To change the font size:
1.	 Select the cells you want to modify.
2.	 Click the drop-down arrow next to the font size command on the Home tab. The font 

size drop-down menu appears.
3.	 Move your mouse over the various font sizes. A live preview of the font size will 	

	appear in the worksheet. 
4.	 Select the font size you want to use.

Formatting text
Many of the commands you will use to format text can be found in the Font, Alignment, 
and Number groups on the Ribbon. Font commands let you change the style, size, and color 
of text. You can also use them to add borders and fill colors to cells. Alignment commands 
let you format how text is displayed across cells both horizontally and vertically. Number 
commands let you change how selected cells display numbers and dates.
To change the font:
1.	 Select the cells you want to modify.
2.	 Click the drop-down arrow next to the font command on the Home tab. The font 

drop-down menu appears.
3.	 Move your mouse over the various fonts. A live preview of the font will appear in the 

worksheet. 
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To use the bold, italic, and underline commands:
1.	 Select the cells you want to modify.
2.	 Click the Bold (B), Italic (I), or Underline (U) command on the Home tab.

To add a border:
1.	 Select the cells you want to modify.
2.	 Click the drop-down arrow next to the Borders command on the Home tab. The 	

	border drop-down menu appears. 

3.	 Select the border style you want to use.

To change the font color:
1.	 Select the cells you want to modify.
2.	 Click the drop-down arrow next to the font color command on the Home tab. The 	

	color menu appears.
3.	 Move your mouse over the various font colors. A live preview of the color will 	

	appear in the worksheet. 
4.	 Select the font color you want to use.
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To add a fill color:
1.	 Select the cells you want to modify.
2.	 Click the drop-down arrow next to the fill color command on the Home tab. The color 

menu appears.
3.	 Move your cursor over the various fill colors. A live preview of the color will appear 

in the worksheet. 

4.	 Select the fill color you want to use.

To change horizontal text alignment:
1.	 Select the cells you want to modify.
2.	 Select one of the three horizontal Alignment commands on the Home tab.
	 - Align Text Left: Aligns text to the left of the cell.
    		 - Center: Aligns text to the center of the cell.
    	 - Align Text Right: Aligns text to the right of the cell.
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To change vertical text alignment:

1.	 Select the cells you want to modify.

2.	 Select one of the three vertical Alignment commands on the Home tab.

	 - Top Align: Aligns text to the top of the cell.

    	 - Middle Align: Aligns text to the middle of the cell.

   	 - Bottom Align: Aligns text to the bottom of the cell.

Formatting numbers and dates
One of the most useful features of Excel is its ability to format numbers and dates in a 
variety of ways. For example, you might need to format numbers with decimal places, 
currency symbols ($), or percent symbols (%).

To format numbers and dates:

1.	 Select the cells you want to modify.

2.	 Click the drop-down arrow next to the Number Format command on the Home tab.

3.	 Select the number format you want. For some number formats, you can then use 
the Increase Decimal and Decrease Decimal commands (below the Number Format 
command) to change the number of decimal places that are displayed.
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Understanding Range
A cell range in an Excel worksheet refers to a group or a block of cells which have been 
selected or highlighted. When cells have been selected they are surrounded by a black 
outline or border. Normally there is only one cell in the worksheet with a black outline. 
This is the active cell. Whatever command is executed by Excel affects the active cell. 
Using the mouse, keyboard or Name Box, more than one cell can be selected to create a 
range, and commands executed by Excel will affect the entire range. 

To select a cell or range using the mouse, do the following:

•	 To select a single cell, click it.

•	 To select adjacent cells (a range), click the upper-left cell in the group and drag down 
to the lower-right cell to select additional cells.

•	 To select nonadjacent cells, press and hold the Ctrl key as you click individual cells.

•	 To select an entire row or column of cells, click the row or column header.

•	 To select adjacent rows or columns, drag over their headers.

•	 To select nonadjacent rows or columns, press Ctrl and click the header for those you 
want to select.

Adjacent range consisting of 
cells B4 through F4
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Understanding Formula Basics
A formula consists of special code entered into a cell. It performs a calculation of some 
type and returns a result, which is displayed in the cell. Formulas use a variety of operators 
and worksheet functions to work with values and text. The values and text in formulas 
can be located in other cells, which makes changing data easy and gives worksheets their 
dynamic nature. For example, you can see multiple scenarios quickly by changing the 
data in a worksheet and letting your formulas do the work.
A formula can consist of any of these elements:
a.	 Mathematical operators, such as + (for addition) and * (for multiplication)
b.	 Cell references (including named cells and ranges)
c.	 Values or text
d.	 Worksheet functions (such as SUM or AVERAGE)

The table given below shows the examples of formulas.
Formula	 Description
=150*.05	 Multiplies 150 times 0.05. This formula uses only values, 

and it always returns the same result. Alternatively, you 
could enter the value 7.5 into the cell.

=A1 + A2	 Adds the values in cells A1 and A2.
=SUM (A1:A12)	 Adds the values in the range A1:A12

To enter a formula, do the following:
1.	 Select the cell in which you want the formula’s calculation to appear.
2. 	Type the equal to sign (=).
3.	 Type the formula. The formula appears in the Formula bar.
4.	 Press Enter to complete the formula.
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To create a formula using cell references, do the following:

1.	 Select the cell where the answer will appear (B3, for example). 

2.	 Type the equal sign (=).

3.	 Type the cell address that contains the first number in the equation (B1, for example). 

4.	 Type the operator you need for your formula. For example, type the addition sign (+).

5.	 Type the cell address that contains the second number in the equation (B2, for example). 

6	 Press Enter. The formula will be calculated, and the value will be displayed in the cell.

To create a formula using the Point and Click method, do the following: 

1.	 Select the cell where the answer will appear (B4, for example). 

2.	 Type the equal sign (=).

3.	 Click on the first cell to be included in the formula (A3, for example). 

4.	 Type the operator you need for your formula. For example, type the multiplication 
sign (*).

5.	 Click on the next cell in the formula (B3, for example). 

6.	 Press Enter. The formula will be calculated, and the value will be displayed in the cell.
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Performing Calculations with Functions
A function is a predefined formula that performs calculations using specific values in a 
particular order. The basic syntax to create a formula with a function is to insert an equals 
sign (=), a function name (SUM, for example, is the function name for addition), and an 
argument. Arguments contain the information you want the formula to calculate, such as 
a range of cell references.

=Function name(argument1, argument2,...)

The function name identifies the type of calculation to be performed. Most functions 
require that you enter one or more arguments following the function name. An argument 
is the data the function uses to perform the calculation. The type of data the function 
requires depends upon the type of calculation being performed. Most commonly, the 
argument consists of numbers or references to cells that contain numbers. The argument 
is enclosed in parentheses, and multiple arguments are separated by commas. 

Excel has many built in functions for specific categories of applications. Some of the 
common Excel functions are listed below:

Function	 Purpose

SUM	 Adds all the numbers in a range of cells.

AVERAGE	 Returns the average (arithmetic mean) of the arguments.

MAX	 Returns the largest value in a set of values.

MIN	 Returns the smallest number in a set of values.

COUNT	 Counts the number of cells that contain numbers and numbers within 
the list of arguments.

IF	 Returns one value if a condition you specify evaluates to True and 
another value if it evaluates to False.

AND	 Returns True if all its arguments are True; returns False if the arguments 
are False. 

To create a basic function in Excel, do the following: 

1.	 Select the cell where the answer will appear (F15, for example).

2.	 Type the equals sign (=) and enter the function name (SUM, for example). 
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3.	 Enter the cells for the argument inside the parentheses. 

4.	 Press Enter and the result will appear.

Using AutoSum to select Common Functions, do the following:

The AutoSum command allows you to automatically return the results for a range of cells 
for common functions like SUM and AVERAGE.

1.	 Select the cell where the answer will appear.

2.	 Click on the Home tab.

3.	 In the Editing group, click on the AutoSum drop-down arrow and select the function 
you desire (Average, for example). 

4.	 A formula will appear in the selected cell E24. If logically placed, AutoSum will select 
your cells for you. Otherwise, you will need to click on the cells to choose the argument 
you desire. 

5	 .Press Enter and the result will appear.
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Workbook	 :	 An Excel file that stores the information you enter using the 
program.

Cell pointer	 :	 A highlighted cell boundary that specifies which cell is active 
at that moment. 

Formula	 :	 Equations that perform calculations on values in your 
worksheet.

Functions	 :	 The prewritten formulas that perform certain types of 
calculations automatically. 

Spreadsheet	 :	 A program that accepts data in a tabular form (in rows 
and columns) and allows user to manipulate, calculate and 
analyze data in the desired manner.

Tricky Terms

Let 
Us Revise
•	 A spreadsheet, also known as a worksheet, contains rows and columns and is used to 

record and compare numerical or financial data. 
•	 Spreadsheets can be used in any area or field that works with numbers and are 

commonly found in the accounting, budgeting, sales forecasting, financial analysis, 
and scientific fields. 

•	 The popular electronic spreadsheet software are:LOTUS 1-2-3, Quattropro and 
Microsoft Excel.

•	 Microsoft Excel is a commercial spreadsheet application written and distributed by 
Microsoft for Microsoft Windows and Mac OS X. 

•	 The Quick Access Toolbar is located above the Ribbon, and it lets you access common 
commands no matter which tab you are on.

•	 Excel is a spreadsheet program that allows you to store, organize, and analyze 
information.

•	 Text entries are any combination of characters that you can type on the keyboard 
including symbols ($, #, @, and so on), numbers, letters, and spaces. 

•	 Formula is an entry that performs a calculation using numbers or data contained in 
other cells. 

•	 A cell range in an Excel worksheet refers to a group or a block of cells which have 
been selected or highlighted.

•	 A function is a predefined formula that performs calculations using specific values in 
a particular order. 
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Solved Exercises
1.	 What is Microsoft-Excel? List any three features of Microsoft-Excel.
Ans:  	 Microsoft Excel is the popular Windows spreadsheet software developed by Microsoft Corporation.
	 The important features of Microsoft Excel are listed below:
	 a.	 It helps to create well-designed spreadsheets that produce accurate results.
	 b.	 The built-in functions in Microsoft Excel make calculations easy and fast.
	 c.	 It helps to produce a visual display of the data in the form of graphs or charts.
	 d.	 It recalculates the result of a mathematical formula automatically if you make a change in a value or number 

in a cell.
	 e.	 It helps to open and use multiple spreadsheet files at the same time.	

2.	 Define a worksheet. How many rows and columns are there in an MS-Excel worksheet?
Ans:  	 Worksheet is the primary document that you use in Microsoft Excel to store and work with data. In Excel 2010, the 

maximum size of a worksheet is 1,048,576 rows by 16,384 columns.

3.	 Define a workbook. How many rows and columns are there in an MS-Excel worksheet?
Ans:	 A workbook is an Excel file that contains one or more worksheets. Each of the workbook’s worksheets are in 

separate tabs on the bottom of the Excel window. By default, a new Excel workbook will contain three worksheets. 
You can switch between worksheets by clicking on the worksheet’s tab on the bottom of the Excel window. In Excel 
2010 the number of worksheets in a workbooks is limited only by your computer’s available memory.

4.	 What do you mean by a range of cells? How is it defined?
Ans:   	 A range of cells is a rectangular block of two or more cells.  A range is defined by the address of two opposite or 

diagonally paired corner cells separated by a colon (:).

5.	 What is a formula? Which sign is used before giving any formula?
Ans:   	 Formula is an entry that performs a calculation using numbers or data contained in other cells. An equal to sign 

(=) is used before giving any formula. 

6.	 What are functions?
Ans:	 Functions are pre-written formulas that perform certain types of calculations automatically. 

7.	 What are the different types of functions in Excel?
Ans:   	 Excel has many built in functions for specific categories of applications. Some of the common Excel functions are 

SUM, AVERAGE, MAX, MIN and COUNT.
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Chapter Review
1.	 State whether the following statements are true or false. 
a.	 Spreadsheet is a program that accepts data in a tabular form (in rows and columns) 

and allows user to manipulate, calculate and analyze data in the desired manner.
b.  	 Each workbook comprises one or more worksheets, and each worksheet is made up 

of individual cells. 
c.	 Formulas use a variety of operators and worksheet functions to work with values and 

text. 
d.	 MIN function returns the largest value in a set of values.
e.	 The AutoSum command allows you to automatically return the results for a range of 

cells for common functions like SUM and AVERAGE.

2.	 Fill in the blanks. 
a.  	 A________________________, also known as a worksheet, contains rows and 

columns and is used to record and compare numerical or financial data.
b.	 ________________________is an entry that performs a calculation using numbers 

or data contained in other cells. 
c.	 A _______________________in an Excel worksheet refers to a group or a block of 

cells which have been selected or highlighted.
d.	 A______________________is a predefined formula that performs calculations using 

specific values in a particular order. 
e.	 ____________________function returns True if all its arguments are True; returns 

False if the arguments are False. 

3.	 Match the following.
	 Group A	 Group B
	 Formula	 An Excel file that stores the information you enter 

using the program.
	 Functions	 A highlighted cell boundary that specifies which cell 

is active at that moment. 
	 Workbook	 Equations that perform calculations on values in your 

worksheet.
	 Spreadsheet	 The prewritten formulas that perform certain types of 

calculations automatically. 
	 Cell pointer	 A program that accepts data in a tabular form (in rows 

and columns) and allows user to manipulate, calculate 
and analyze data in the desired manner.
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4.	 Select the best answer from the list of choices.

a.		 A program that accepts data in a tabular form (in rows and columns) and allows user 
to manipulate, calculate and analyze data in the desired manner.

		 i.	 Spreadsheet 	 ii.	 Presentation

		 iii.	 None of the above	 iv.	All of the above

b.		 A(n) _________________ range is a rectangular block of adjoining cells.

		 i.	 selected 	 ii.	 adjacent

		 iii.	 nonadjacent	 iv.	block

c.	 The value on which a numeric formula performs a calculation are  called _________.

		 i.	 operators	 ii.	 operands		

		 iii.	 accounts	 iv.	data

d.	 The prewritten formulas that perform certain types of calculations automatically. 

		 i.	 Formula 	 ii.	 Function

		 iii.	 None of the above	 iv.	All of the above

5.	 Answer the following questions.

a.		 What is an electronic spreadsheet? Give two examples of spreadsheet software.

b.	 What is Microsoft Excel? What are the important features of Microsoft Excel?

c.	 What is a workbook? What is the extension of Excel 2010 file?

d.	 What are the different types of data that MS-Excel recognizes?

e.	 What is a formula?

f.	 What is meant by ‘range of cells’? How is it defined?

g.	 What are functions? Give the usage and syntax of SUM function.

h.	 Write the steps to perform the following tasks.

	 i. To rename worksheets

	 ii. To select a cell or range of cells.

	 iii. To enter a formula.

	 iv. To create a basic functions



Computer Zone - Book 6 101

Lab Exercises
Lab Exercise 1
a.	 Create the following worksheet.

Guinness Publication Pvt. Ltd

S.No	 Employee	 Post	 Salary	 P.F.	 Net Sal	

1			  Rajesh	 Director	 12000		  ?	

2			  Kriti	 Manager	 8000		  ?

3			  Sulav	 Accountant	 6000		  ?

4			  Rajani	 Accountant	 6000		  ?

5			  Umesh	 Peon	 3000		  ?

b. 		 Supply the grid lines for the table.

c.	 Compute the P.F. which is 10% of salary.

d. 	 Compute Net Sal where Net = Salary - P.F.

e.	 Add formatting, such as color fill and font color of your choice, to the worksheet.

f.	 Save the workbook file as Worksheet1.

Lab Exercise 2
a.	 Create a new worksheet and type the following data.

Sales Report 
Sales_Id	 Salesman Name	 Qtr 1	 Qtr2	 Qtr3	 Total	 Average
S1001	 Bijay	 70	 56	75
S1002	 Paras	 50	 75	45
S1003	 Swapna	 90	 97	88
S1004	 Tshering	 67	 87	56
b.	 Compute total sales of each salesmen.
c.	 Compute average sales of all salesmen.
d.	 Compute average sales of each salesman.
e.	 Write text ‘Max. sales’ in cell F7 and compute maximum sales in cell G7.
f.	 Write text ‘Min. sales’ in cell F8 and compute minimum sales in cell G8.
g.	 Save the workbook file as Worksheet2.
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Power Point 20109

Objectives

After completing this chapter, you will be able 
to:

	Define presentation software.

	Explain the major advantages of Microsoft 
Office PowerPoint.

	Explain how to create new presentation.

	Explain the different layouts of a slide.

	Explain how to add new slide to a 
presentation and add content to a slide.

	Explain how to add transitions and 
animations to a presentation.
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Concept: Presentation Software
A presentation software is a computer software package used to display information, 
normally in the form of a slide show. A slide is the presentation output that contains text, 
charts, graphics, audio and video. The incorporation of graphics, audio and video makes 
the topic more interesting and effective. It helps the speaker with an easier access to his 
ideas and the participants with visual information which complements the talk. Some 
most popular graphics, multimedia and presentation packages are Coreldraw, Macromedia 
Director and Microsoft PowerPoint.

Microsoft Office PowerPoint 2010 is a complete presentation graphics program 
developed by Microsoft Corporation, USA. It allows you to produce professional-looking 
presentations.

Microsoft PowerPoint is a slide-based presentation program developed 
by Microsoft. It was officially launched on May 22, 1990, as a part of the 
Microsoft Office suite. Originally designed for the Macintosh computer, 
the initial release was called “Presenter”, developed by Dennis Austinand 
Thomas Rudkin of Forethought, Inc 
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 Microsoft Office PowerPoint has the following advantages:
•	 It can create paper printouts of the individual slides, outlines and speaker notes. 
•	 It gives you the flexibility to make presentations using a projection device attached 

to a personal computer.
•	 It helps you to quickly create presentations for many purposes, including lectures, 

research reports, meeting handouts and agendas, speaker introductions, and other 
events.	

•	 It allows to animate objects and add narrations, video or music to the presentation.

A look to Future

Computerized Cars
The car of tomorrow may have a choice of drivers - human 
or computer. Just climb in and key in your destination. The 
on-board computer maps out the best route and takes the 
controls. Helped by satellite navigation and radio links with 
a central traffic computer, it drives the car, takes the correct 
turns and avoids other vehicles. You can relax or even take a 
nap. If there is a problem, the computer flashes and beeps a 
warning to wake you up!
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Starting a New Presentation
You can start a blank presentation from scratch, or you can base the new presentation 
on a template or on another presentation. Using a template or existing presentation can 
save you some time. However, if you have a specific vision you’re going for, starting a 
presentation from scratch gives you a clean canvas to work them.

When you start PowerPoint, a new blank presentation begins automatically with one slide. 
Just add your content to it, add more slides if needed, change the formatting and go for it.

To create a new blank presentation at any time, do the following:

1.	 Click on the File tab and choose New on the left-hand side of the screen.

2.	 Ensure Blank Presentation is selected and then click on the Create button.

You will see the default opening screen is actually composed of three parts: 

1. 	 Each page of the working area of the presentation is called a slide. New presentations 
open with a Title slide in Normal view ready for editing.

2.	 This area toggles between Slides view and Outline view. Slides view shows a tiny 
picture of all the slides in your presentation. Outline view shows the hierarchy of the 
text in your slides.

3.	 The area to the right is the Task pane . Its contents vary depending on the current task. 
Initially, PowerPoint recognizes that you are just starting this presentation and lists 
appropriate options for you. To give yourself more room to work on your slide close 
this pane by clicking on the small X in the upper right corner.
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The PowerPoint Environment
When you open PowerPoint, a new presentation is created, and a blank slide appears in 
the PowerPoint window. The slide has placeholders for you to add a title and subtitle.

The tabbed Ribbon menu system is how you access the various PowerPoint commands. If 
you’ve used previous versions of PowerPoint, the Ribbon system replaces the traditional 
menus. Above the Ribbon in the upper-left corner is the Microsoft Office Button. From 
here, you can access important options such as New, Save, Save As, and Print. By default, 
the Quick Access Toolbar is pinned next to the Microsoft Office Button and includes 
commands like Undo and Redo.

On the left side of the window, you will see a task pane with slides and outline tabs, which 
appears by default. On the bottom-right of the screen, you will find View commands 
(Normal, Slide Sorter, and Slide Show), as well as the zoom tool.

The Quick Access Toolbar

The Save, Undo, and Redo commands appear by default on the Quick Access Toolbar. 
You may wish to add other commands to make using specific PowerPoint features more 
convenient for you. 

The Ribbon

The new, tabbed Ribbon system replaces traditional menus in PowerPoint 2007. It is 
designed to be easy to use and responsive to your current task; however, you can choose 
to minimize the Ribbon if you would prefer to use different menus or keyboard shortcuts.
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Backstage view
Backstage view gives you various options for saving, opening a file, printing, or sharing 
your document. It is similar to the Office Button Menu from PowerPoint 2007 or the File 
Menu from earlier versions of PowerPoint. However, instead of just a menu it is a full-
page view, which makes it easier to work with.

To get to Backstage view:
1.	 Click the File tab.
2.	 You can choose an option on the left side of the page.
3.	 To get back to your document, just click any tab on the Ribbon.

Creating and Opening Presentations
PowerPoint files are called presentations. Whenever you start a new project in PowerPoint, 
you’ll need to create a new presentation. You’ll also need to know how to open an existing 
presentation.

To create a new, blank presentation:
1.	 Click the File tab. This takes you to Backstage view.
2.	 Select New.
3.	 Select Blank presentation under Available Templates and Themes. It will be 		
	 highlighted by default.
4.	 Click Create. A new, blank presentation appears in the PowerPoint window. 
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Components of a Typical Presentation
A presentation contains many components among which the important ones are:

Slide
A slide is an individual page of a presentation. It is the container of information present in 
the form of text, pictures, diagrams, charts, etc. A presentation is, in fact, a collection of a 
number of slides conveying an idea.

Handouts
Handouts are the compressed version of presentations given to the audience. They act as 
supporting material.

Speaker’s Notes
The set of notes, which aid the speaker during the course of presentation, are called 
Speaker’s Notes.

Outlines
An outline is the summary of a slide displaying only title, subtitles and a part of main text. 
It does not contain any picture or table or chart, etc. 

Applying a Theme
A theme is a set of colors, fonts, effects, and more that can be applied to your entire 
presentation to give it a consistent, professional look. You’ve already been using a theme, 
even if you didn’t know it: the default Office theme, which consists of a white background, 
the Calibri font, and primarily black text. Themes can be applied or changed at any time. 

To apply a theme, do the following:
1.    Go to the Design tab.
2.    Locate the Themes group. Each image represents a theme.

3.    Click the drop-down arrow to access more themes.
4.    Hover over a theme to see a live preview of it in the presentation. The name of the 

theme will appear as you hover over it.
5.    Choosing a theme
6.    Click a theme to apply it to the slides.
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Slide Basics
PowerPoint is an excellent tool for presentations of any kind, either in the classroom 
or at a conference. A PowerPoint presentation is made up of a series of “slides” that 
can be projected (displayed electronically) or printed in a variety of handout formats. 
A slide is a single page of a presentation created with software such as PowerPoint or 
OpenOffice Impress. A presentation is composed of several slides. The best presentations 
use approximately ten to twelves slides to get the message across. 

Overview of slide layouts
Slide layouts contain formatting, positioning, and placeholders for all of the content that 
appears on a slide. Placeholders are the containers in layouts that hold such content as text 
(including body text, bulleted lists, and titles), tables, charts, SmartArt graphics, movies, 
sounds, pictures, and clip art (clip art: A single piece of ready-made art, often appearing 
as a bitmap or a combination of drawn shapes.). And a layout contains the theme (colors 
(theme colors: A set of colors that is used in a file. Theme colors, theme fonts, and theme 
effects compose a theme.), fonts (theme fonts: A set of major and minor fonts that is 
applied to a file. Theme fonts, theme colors, and theme effects compose a theme.), effects 
(theme effects: A set of visual attributes that is applied to elements in a file. Theme effects, 
theme colors, and theme fonts compose a theme.), and the background) of a slide as well.

PowerPoint includes nine built-in slide layouts, or you can create custom layouts that meet 
your specific needs, and you can share them with other people who create presentations 
by using PowerPoint. 
When you open a blank presentation in PowerPoint, the default layout called Title Slide 
(shown below) appears, but there are other standard layouts that you can apply and use.
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Adding a New Slide to a Presentation
The standard, built-in layouts available in PowerPoint 2010 are similar to those available in 
PowerPoint 2007 and earlier versions. When you open a blank presentation in PowerPoint, 
the default layout called Title Slide appears, but there are other standard layouts that you 
can apply and use. Some placeholders allow you to double-click the placeholder and then 
access other objects, such as media clips, charts, diagrams and organization charts.

To add a new slide to a presentation, do the following:

1.	 From the Home tab, click the bottom half of the New Slide command to open the 
menu of slide layout options. 

2.	 Select the slide you want to insert. 

3.	 A new slide will be added your presentation. 

Adding content
To add text, click in any box that says Click to add text and start typing. If there is a bullet, 
push Enter on the keyboard to get a new bullet; to get a sub point, push Tab on that blank 
line and the text will indent further and become smaller. 
To add graphics, charts, etc., click on the appropriate icon (before you type text in the 
box) and choose the file you would like on the slide. Notice that it will re-size to fit into 
the box.
Also note that when you add one type of content, the other options disappear. You can 
always go to the Insert Ribbon to add more images, text boxes, etc. 
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Apply a new layout to a slide
PowerPoint includes nine built-in slide layouts, or you can create custom layouts that meet 
your specific needs, and you can share them with other people who create presentations 
by using PowerPoint. The slide layout arranges your content using different types of 
placeholders, depending on what kind of information you might want to include in your 
presentation.

To change the layout of an existing slide, do the following:

1.    On the View tab, in the Presentation Views group, click Normal.

2.	 In Normal view, in the pane that contains the Outline and Slide tabs, click the Slides 
tab.

3.	 Click the slide that you want to apply a layout to.

4.	 On the Home tab, in the Slides group, click Layout, and then select the layout that 
you want.

PowerPoint Views
A powerpoint view is the mode in which the presentation appears on the screen. Each 
view provides you a different look and capabilities. Microsoft PowerPoint has three main 
views: normal view, slide sorter view and slide show view. You can select a view, based 
on these main views, to be your default view in PowerPoint. 

PowerPoint views are found in two places:

•	 On the View tab, in the Presentations Views and Master Views groups.

•	 On an easy to use bar at the bottom of the PowerPoint Window where the main views 
(Normal, Slide Sorter, Reading, and Slide Show) are available.

Views for editing your presentation 
There are many views in PowerPoint that can help you create a professional presentation.
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Normal 
Normal is set to be the default presentation view (but you can change default view) and 
you will be working on this view most of the time when making any changes to the 
current slide. Normal view is the main editing view, where you write and design your 
presentations. 

Slide Sorter
Slide Sorter view gives you a view of your slides in thumbnail form. This view makes 
it easy for you to sort and organize the sequence of your slides as you create your 
presentation, and then also as you prepare your presentation for printing. It also allows 
users to navigate easily between different slides. You can add sections in Slide Sorter 
view as well, and sort slides into different categories or sections. 

Master views
The master views include, Slide, Handout, and Notes view. They are the main slides 
that store information about the presentation, including background, color, fonts, effects, 
placeholder sizes and positions. The key benefit to working in a master view is that on the 
slide master, notes master, or handout master, you can make universal style changes to 
every slide, notes page, or handout associated with your presentation.

Views for delivering your presentation 
There are many views in PowerPoint that can help you in delivering your presenttion.

Slide Show view
Slide Show view is used to deliver your presentation to your audience. Slide Show view 
occupies the full computer screen, exactly the way your presentation will look on a big 
screen when your audience sees it. You can see how your graphics, timings, movies, 
animated effects, and transition effects will look during the actual presentation. 

Presenter view
Presenter view is a key slide show-based view that you can use while delivering your 
presentation. By using two monitors, you can run other programs and view speaker notes 
that your audience cannot see. 

Reading view
Reading view is used to deliver your presentation to someone viewing your presentation 
on their own computer. Or, use Reading view on your own computer when you want to 
view a presentation in a window with simple controls that make the presentation easy to 
review. You can always switch from Reading view to one of the other views if you want 
to change the presentation.
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Text basics
If you’re new to Microsoft PowerPoint, you’ll need to learn the basics of working with 
text so you can add and arrange text on your slides. You’ll need to know how to insert, 
delete, move, and format text, as well as how to use text boxes.

To insert text:
1.    Click the placeholder or text box where you want to insert text.
2.    The insertion point appears. 
3.	 Type directly into the placeholder or text box.

To delete text:
1.   Place the insertion point next to the text you wish to delete.
2.   Press the Backspace key on your keyboard to delete text to the left of the insertion 	

point.
3.   Press the Delete key on your keyboard to delete text to the right of the insertion point. 

To select text:
1.   Place the insertion point next to the text you wish to select.
2.   Click the mouse button. While holding it down, drag the mouse over the text.
3.   Release the mouse. The text will be selected. A highlighted box will appear over the 	
	 selected text. 
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To copy and paste text:
1.   	Select the text you wish to copy.
2.	 Click the Copy command on the Home tab. You can also right-click your selection 

and choose Copy. 
3.	 Place your insertion point where you wish the text to appear.
4.	 Click the Paste command on the Home tab. The text will appear.

To cut and paste text:
1.   	Select the text you wish to cut.
2.	 Click the Cut command on the Home tab. You can also right-click your selection and 

choose Cut. 
3.	 Place your insertion point where you wish the text to appear.
4.	 Click the Paste command on the Home tab. The text will reappear. 

To drag and drop text:
1.   	Select the text you wish to copy.
2.		 Click, hold, and drag your mouse to the location where you want the text to appear. 

The cursor will have a rectangle underneath it to indicate that you are moving text. 
3.	 Release the mouse button, and the text will appear.
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Working with text
As you create your presentation, you can add text boxes to help organize your slides. 
You’ll also need to know how to format text to create the look you need.

To add a text box:
Text can be inserted into both placeholders and text boxes. A placeholder is a kind of 
text box, but is unique because it is part of the slide layout and often contains formatting 
specific to the slide (for example, a larger font size for the title of your presentation). 
Inserting an extra text box allows you to add to the slide layout, so you can include as 
much text as you want.
To add a text box, do the following:
1.  	 From the Insert tab, click the Text Box command.
2.	 Your cursor will turn into an upside-down cross text box cursor. 
3.	 Click the area on your slide where you want to add a text box. A text box will appear 

with an insertion point inside.

To move a placeholder or text box:
1.  	 Click the box you would like to move.
2.	 Position your mouse on the border of the box so it changes to a cross with arrows.
3.	 Click and hold the mouse button as you drag the box to the desired location.
4.	 Release the mouse button.The box will be moved. 

To resize a placeholder or text box:
1.  	 Click the box you wish to resize.
2.	 Position your mouse over any one of the sizing handles that appear on the corners and 

sides of the box. The cursor will become a pair of arrows resize cursor. 
3.	 Click, hold, and drag your mouse until the text box is the desired size.
4.	 Release the mouse button. The box will be resized.
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Working with images
Adding clip art and pictures to your presentation can be a great way to illustrate important 
information or add decorative accents to existing text. You can insert images from your 
computer, search Microsoft’s large selection of clip art to find the image you need, or add 
a screenshot of your own. Once an image has been inserted, you can resize and move it 
to the location you want.
To insert an image from a file:
1.	 Select the Insert tab.
2.	 Click the Picture command in the Images group. The Insert Picture dialog box 

appears. 

3.	 Select the desired image file, then click Insert. 
4.	 The picture will appear in your slide.

To locate clip art:

1.	 Select the Insert tab.

2.	 Click the Clip Art command in the Images group. 

3.	 The clip art options appear in the task pane to the right of the document.

4.	 Enter keywords in the Search for: field that are related to the image you wish to 
insert.

5.	 Click the drop-down arrow in the Results should be: field.

6.	 Deselect any types of media you do not wish to see.

7.	 If you would like to also search for clip art on Office.com, place a check mark next 
to Include Office.com content. Otherwise, it will just search for clip art on your 
computer.

8.	 Click Go.
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Adding Transitions
Transitions are special effects used to introduce a slide during the slide show. You can 
choose the transitions you want, and you can vary the speed of each transition. There are 
three categories of unique transitions to choose from, all of which can be found on the 
Transitions tab:

•	 Subtle (slight transitions) 

•	 Exciting (strong transitions)

•	 Dynamic Content (strong transitions that affect only the content, such as text or 
images)

To apply a transition, do the following:
1.    Select the slide you wish to modify.
2.    On the Transitions tab, in the Transition to This Slide group, click the transition you 

want.
3.	 Click Effect Options, and select any options for the chosen effect transition as desired.
4.	 In the Timing group, mark or clear the check boxes for:

	 a.	  On Mouse Click	  - 	 Transitions when you click the mouse
	 b. 	 Automatically 	 - 	 Transitions alter a specified amount of time 

has passed. (Enter the time, in seconds, in the 
associated text box).

5.    (Optionally) Adjust the duration setting to specify how quickly the transition effect 
will occur.

6.	 (Optionally) If you want a sound associated with the transition, select it from the 
sound drop-down list.

7.	 (Optionally) If you want these same transition settings to apply to all slides in the 
presentation, click Apply to All.
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To preview a transition, do the following:

You can preview the transition for a selected slide at any time, using either of these two 
methods:

1.    Click the Preview command on the Transitions tab.

2.	 Click the star Play Animations icon. The icon appears on the Slides tab in the left 
pane beside any slide that includes a transition. 

To add sound, do the following:

1.    Select the slide that includes the transition you wish to modify.

2.    Click the Sound drop-down menu in the Timing group.

3.    	You will hear the sound and see a live preview of the transition as you hover over 
each sound.

4.    	Click a sound to apply it to the selected slide.

To remove a transition, do the following:

1.    Select the slide you wish to modify.

2.    Choose None from the gallery in the Transition to This Slide group.

3.    Removing a transitionRemoving a transition

4.    Repeat this process for each slide you want to modify.
To remove transitions from all slides, select a slide that uses None, and click the Apply 
to All command.
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Adding Animation
In PowerPoint you can animate text and objects such as clip art, shapes, and pictures. 
Animation is a special visual effect that you can add to parts of the slides that enable 
the presenter to focus on important points as they are being presented. Animation, or 
movement, on the slide can be used to draw the audience’s attention to specific content or 
to make the slide easier to read. 
To apply an animation to an object, do the following:
1.    Select an object.
2.    Click the Animations tab.
3.  In the Animation group, click the More drop-down arrow to view the available 

animations.

4.    Select the desired animation effect.
5.    The object will now have a small number next to it to show that it has an animation. 

Also, in the Slide pane, the slide will now have a star symbol next to it.

Viewing the Presentation in Slide Show View
The Slide Show view allows you to show a presentation using a computer. The computer 
acts like a slide projector, displaying each slide on a full screen. The full-screen slide 
hides the toolbars, menus, and other PowerPoint window elements. When making a 
presentation, you use slide show view. You can start slide show view from normal view 
or slide sorter view.
To view the presentation, do any of the following:
1.	 In the Start Slide Show group on the Slide Show tab, click either From Beginning or 

From Current Slide.
2.	 Click the Slide Show View button in the bottom-right corner of the screen (to begin 

from the current slide).
3.	 Press F5 (to begin from the beginning).
4.	 Press Shift + F5 (to begin from the current slide)
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Animation	 :	 Special sound or visual effects that can be added to objects 
on a slide.

Slide	 :	 The individual page of PowerPoint presentation.
Placeholder	 :	 The box with dotted outlines that appear when you create a 

new slide.
Presentation	 :	 The process of presenting a topic to an audience.
Transitions	 :	 The special effects used to introduce a slide during the slide 

show.
Powerpoint view 	 :	 The mode in which the presentation appears on the screen. 

Each view provides you a different look and capabilities. 

Tricky Terms

Let 
Us Revise
•	 A presentation software is a computer software package used to display information, 

normally in the form of a slide show. 
•	 A slide is the presentation output that contains text, charts, graphics, audio and video.
•	 Microsoft Office PowerPoint 2010 is a complete presentation graphics program 

developed by Microsoft Corporation, USA. It allows you to produce professional-
looking presentations.

•	 PowerPoint is an excellent tool for presentations of any kind, either in the classroom 
or at a conference. 

•	 Slide layouts contain formatting, positioning, and placeholders for all of the content 
that appears on a slide.

•	 PowerPoint includes nine built-in slide layouts, or you can create custom layouts 
that meet your specific needs, and you can share them with other people who create 
presentations by using PowerPoint.

•	 A powerpoint view is the mode in which the presentation appears on the screen. 
•	 Normal view is the main editing view, where you write and design your presentations.
•	 Transitions are special effects used to introduce a slide during the slide show. 
•	 In PowerPoint you can animate text and objects such as clip art, shapes, and pictures. 

Animation is a special visual effect that you can add to parts of the slides that enable 
the presenter to focus on important points as they are being presented.

•	 The Slide Show view allows you to show a presentation using a computer.
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Solved Exercises
1.	 What is a presentation software?
Ans: 	 A presentation software is a computer software package used to display information, normally in the form of a 

slide show. 

2.	 What is Microsoft Office Powerpoint 2010? 
Ans: 	 Microsoft Office PowerPoint 2010 is a complete presentation graphics program developed by Microsoft 

Corporation, USA. It allows you to produce professional-looking presentations.

3.	 What are the advantages of Microsoft Office PowerPoint?

Ans:	 Microsoft Office PowerPoint has the following advantages:

	 •	 It can create paper printouts of the individual slides, outlines and speaker notes. 

	 •	 It gives you the flexibility to make presentations using a projection device attached to a personal computer.

	 •	 It helps you to quickly create presentations for many purposes, including lectures, research reports, meeting 
handouts and agendas, speaker introductions, and other events.	

	 •	 It allows to animate objects and add narrations, video or music to the presentation.

4.	 What is a slide
Ans:		 A slide is an individual page of a presentation. It is the container of information present in the form of text, 

pictures, diagrams, charts, etc. 

5.	 What is a PowerPoint view? What are the different types of view in PowerPoint?
Ans:	 PowerPoint view is the mode in which the presentation appears on the screen.  The different views available in 

PowerPoint are Normal view, Slide Sorter view, Master views, Slide Show view, Presenter view and Reading view.

6.	 What is a reading view?
Ans: 	 Reading view is used to deliver your presentation to someone viewing your presentation on their own computer. 

7.	 What are transitions?
Ans:	 Transitions are special effects used to introduce a slide during the slide show. 

8.	 What is animation?
Ans:	 Animation is a special visual effect that you can add to parts of the slides that enable the presenter to focus on 

important points as they are being presented. Animation, or movement, on the slide can be used to draw the 
audience’s attention to specific content or to make the slide easier to read. 
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Chapter Review
1.	 State whether the following statements are true or false. 
a.  	 PowerPoint 2010 helps you to quickly create presentations for many purposes, 

including lectures, research reports, meeting handouts and agendas, speaker 
introductions, and other events.

b.	 Handouts are the compressed version of presentations given to the audience.
c.	 Slide view is the main editing view, where you write and design your presentations. 
d.	 Transitions are special effects used to introduce a slide during the slide show. 
e.	 The Slide Show view allows you to show a presentation using a computer. 
 
2.	 Fill in the blanks. 

a.  	 A ________________________is a computer software package used to display 
information, normally in the form of a slide show. 

b.	 A______________________is the presentation output that contains text, charts, 
graphics, audio and video. 

c.	 A_____________________is a set of colors, fonts, effects, and more that can be 
applied to your entire presentation to give it a consistent, professional look. 

d.	 ________________________ is an outline is the summary of a slide displaying only 
title, subtitles and a part of main text.

e.	 _______________________view is a key slide show-based view that you can use 
while delivering your presentation.

3.	 Match the following.

	 Group A							       Group B
	 Slide Show view	 The main editing view, where you write and design 

your presentations. 
	 Transitions 	 Used to deliver your presentation to your audience. 
	 Presenter view	 The special effects used to introduce a slide during the 

slide show.
	 Reading view 	 A key slide show-based view that you can use while 

delivering your presentation.  
	 Normal view 	 Used to deliver your presentation to someone viewing 

your presentation on their own computer.
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4.		 Select the best answer from the list of choices.

a.		 A computer software package used to display information, normally in the form of a 
slide show.

		 i.	 Wordprocessing 	 ii.	 Presentation
		 iii.	 Spreadsheet	 iv.	None of the above

b.	 The Microsoft PowerPoint has the following advantages.
	 i.	 The PowerPoint allows to animate objects and add narrations, video or music to 

the presentation. 
	 ii.	 You can also use content controls to create PowerPoint templates that other users 

in your organization can use.
	 iii.	 The PowerPoint can create paper printouts of the individual slides, outlines and 

speaker notes. 
	 iv.	 All of the above

c.	 __________________are the compressed version of presentations given to the 
audience. 

		 i.	 Slide	 ii.	 Handout	
		 iii.	 Outlines	 iv.	None of the above

d.	 ___________________view displays all the slides in your presentation in small size.
		 i.	 Normal view	 ii.	 Slide Sorter view 		
		 iii.	 All of the above	 iv.	None of the above

5.	 Answer the following questions.
a.	 What is a presentation software?	
b.	 What is Microsoft Office PowerPoint 2003?
c.	 State any three advantages of Microsoft Office PowerPoint 2003?
d.	 What do you understand by PowerPoint view? What are the three main views of 

Microsoft Office PowerPoint 2003?
e.	 What is normal view? Name the three working areas of normal view.
f.	 What is the difference between slide view and slide shorter view?
g.	 What is a placeholder? What is it used for?
h.	 What do you understand by AutoShapes and WordArt?	
i.	 What is meant by animation? 
j.	 What is meant by transition?
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Lab Exercises
1.	 Create a new, blank presentation.

2.	 Use the Title Slide AutoLayout for the first slide. The title should read: Why Microsoft 
Office 2007? and the subtitle should read: Are You Ready?.

3.	 Apply the Expedition design template to the presentation.	

4.	 Add a new slide using the Bulleted List AutoLayout. The bullet slide should read: 
What is Office 2007? Key the following as separate bullets: Word, Excel, PowerPoint, 
Access.

5.	 Add a clip art image to the slide, and then resize and move the image as needed.

6.	 Use the WordArt style and add the following text: Microsoft Office 2007.

7.	 Add a blank slide at the end of the presentation for a WordArt object.

8.	 Use the first WordArt style in the first row, first column. Add the following text: 
Office 2007 Is Here!

9.	 Change the WordArt font to Times New Roman, Bold and the font size to 60.

10.	 Change the shape of the WordArt object to Can Down.	

11.	 Change the WordArt fill colour to Tan (Follow Accent Scheme Color) and the WordArt 
line colour to Brown (Follow Title Text Scheme Color). Resize the WordArt object 
as needed.	

12.	 Add custom animation with the Swoosh sound to the series of a chart slide.

13.	 Add any sound clip from the data disk to a slide in the presentation.

14.	 Hide and animate the sound clip to play throughout the presentation.

15.	 View the slide show.

16.	 Save the presentation as Office With Custom Effects.	

17.	 Print the presentation as a six-slides per page handout, and then close it. 
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Objectives

After completing this chapter, you will be able 
to:

	Define Information and Communication 
Technology.

	Explain the usage of ICT in various fields

	Define computer ethics and list the ten 
commandments of computer ethics.
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Introduction of 
ICT 
and

Computer Ethics

Concept: Information and Communication Technology
ICT stands for “Information and Communication Technologies.” It refers to all the 
technology used to handle telecommunications, broadcast media, intelligent building 
management systems, audiovisual processing and transmission systems, and network-
based control and monitoring functions. This includes the Internet, wireless networks, 
cell phones, and other communication mediums.
Modern information and communication technologies have created a “global village,” in 
which people can communicate with others across the world as if they were living next 
door. For this reason, ICT is often studied in the context of how modern communication 
technologies affect society.

 Although we normally think of computers as the ones we use in our everyday 
lives to surf the web, write documents etc, small computers are also 
embedded into other things such as mobile phones, toys, microwaves and 
MP3 players. We use computers all the time, often without even knowing it! 
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A look to Future

My Computer Friend
How will people and computers communicate in the 
future? Some computers already have speech recognition 
programmes and can understand spoken words. You talk, 
your words come up on screen, and the computer responds. 
Perhaps the future computer will look more human, with a 
robot-like body. It will understand what you say, walk and 
talk, even laugh at your joke. It could become your best friend!

Some of the important advantages of Information and Communication Technology are 
listed below:
a. 	 Technology such as mobile phones, the Internet and instant messaging has made it 

easy for customers and colleagues to reach you, whether you’re in the office or on the 
road. 

b.	 With the Internet and the World Wide Web, a wealth of learning materials in almost 
every subject and in a variety of media can now be accessed from anywhere at anytime 
of the day and by an unlimited number of people.

c.	 Information communication technology has proved helpful security wise in the 
creation of devices such as hidden cameras, webcam etc which is used in offices, 
organizations, homes.
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Information and Communication Technology in our World
Information and Communication Technology is making a significant impact in many 
different areas of our world. They have become so deeply embedded in information 
processing and communication systems that almost no activity would be possible without 
them. A broad classification of its uses in varied fields are explained below:

ICT in Education
Information and Communication technology is helping educators make significant changes 
to the learning process. Many schools now have computers that are connected to internal 
networks and the Internet, allowing students to easily communicate with one another. 
New computer-based education and training programs offer interactive instruction on a 
one-to-one basis and can be automatically modified to suit the user’s level of ability. It is 
used to store vital student and staff data that assists in self evaluation and improvement in 
addition to contributing to improved learning and teaching.

ICT in Medicine
Information and Communication technology has helped to improve the delivery of patient 
care in a number of different ways. It has reduced the barriers of distance and time via 
telemedicine and on-line access to laboratory test results and medical research. It has 
improved the delivery of health care by making health care information more accessible 
to patients. It has also helped to contribute to the design of better health care programs. 
The use of computerized patient records has helped to reduce errors in prescriptions and 
diagnoses. Information and Communication technology is also helping to improve the 
training and education of medical staff and patients.

ICT at Home
Information and Communication technology has already changed our lives at home. New 
gadgets such as automatic washing machines, dishwashers and microwaves have made 
our lives easier. It also offers a new form of entertainment. It is used for playing computer 
games. Information technology is used to check our bank accounts and order goods via 
the Internet and even do our work at home.

ICT in Business
Businesses use ICT by using computers, software application and the internet to reduce 
the cost of doing business, save and hence make profit. Databases can be used to store 
information on employees or goods which makes the access and retrieval of this kind 
of data faster. Other accounting software monitors the revenue and costs and generates 
reports on the current financial status as well as historical data to enhance data analysis 
and inform decision making. The internet is used by businesses to advertise their goods, 
make payments and also to order goods.
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Ethical Issues in Computing
In the industrialized nations of the world, the “Information Revolution” has significantly 
altered many aspects of life. Advances in computer technologies have placed tremendous 
new capabilities in the hands of everyday people. As computer technology gives us 
wonderful new powers, we are faced with many ethical dilemmas. 
Computer ethics is set of moral principles that regulate the use of computers. Some 
common issues of computer ethics include intellectual property rights (such as copyrighted 
electronic content), privacy concerns, and how computers affect society. As technology 
advances, computers continue to have a greater impact on society. Therefore, computer 
ethics promotes the discussion of how much influence computers should have in areas such 
as artificial intelligence and human communication. As the world of computers evolves, 
computer ethics continues to create ethical standards that address new issues raised by 
new technologies. The computer ethics institute in Washington DC, has proposed the ten 
commandments of computer ethics. They are:
•	 Do not use a computer to harm other people.
•	 Do not interfere with other people’s computer work.
•	 Do not copy or use proprietary software for which you have not paid.
•	 Do not snoop around in other people’s computer files. 
•	 Do not use a computer to steal.	
•	 Do not use a computer to bear false witness.
•	 Do not use other people’s computer resources without authorization or proper 

compensation.
•	 Do not use other people’s intellectual output.
•	 Always think about the social consequences of the program you are writing or the 

system you are designing.
•	 Always use a computer in ways that demonstrate consideration and respect for your 

fellow humans.

A look to Future

Flat and wide screens will come, and probably go. The next 
stage may be TV with pictures in three dimensions and no 
screen. Instead, a small box containing a hologram projector 
will shine laser beams into the air, to make moving, 3D 
colour images that you can walk round. You could view a 
whole sports stadium in miniature, watch the action from 
any viewpoint and cheer on your favourite team - all in the 
privacy of your own bedroom.
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ICT	 :	 The study or business of developing and using technology to 
process information and aid communications. 

Internet	 :	 A worldwide, noncommercial, freely accessible network of 
networks.

World Wide Web	 :	 A system of interlinked hypertext documents accessed via the 
Internet.

Computer ethics 	 :	 A set of moral principles that regulate the use of computers. Some 
common issues of computer ethics include intellectual property 
rights (such as copyrighted electronic content), privacy concerns, 
and how computers affect society. 

Web cam	 :	 A video camera that feeds or streams its image in real time to or 
through a computer or computer network.

Tricky Terms

Let 
Us Revise
•	 ICT stands for “Information and Communication Technologies.”
•	 ICT refers to all the technology used to handle telecommunications, broadcast media, 

intelligent building management systems, audiovisual processing and transmission 
systems, and network-based control and monitoring functions.

•	 Modern information and communication technologies have created a “global village,” 
in which people can communicate with others across the world as if they were living 
next door. 

•	 New computer-based education and training programs offer interactive instruction on 
a one-to-one basis and can be automatically modified to suit the user’s level of ability.

•	 Information and Communication technology is also helping to improve the training 
and education of medical staff and patients.

•	 Information and Communication technology is also helping to improve the training 
and education of medical staff and patients.

•	 Information technology is used to check our bank accounts and order goods via the 
Internet and even do our work at home.

•	 The internet is used by businesses to advertise their goods, make payments and also 
to order goods.

•	 Computer ethics is set of moral principles that regulate the use of computers.
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Solved Exercises
1.		 What is ICT?
Ans:	 ICT stands for “Information and Communication Technologies.” It refers to all the technology used to 

handle telecommunications, broadcast media, intelligent building management systems, audiovisual 
processing and transmission systems, and network-based control and monitoring functions.	   

2.	 What are the advantages of Information and Communication Technology?
Ans:	 Some of the important advantages of Information and Communication Technology are listed below:
	 a. 	 Technology such as mobile phones, the Internet and instant messaging has made it easy for customers and 

colleagues to reach you, whether you’re in the office or on the road. 
	 b.	 With the Internet and the World Wide Web, a wealth of learning materials in almost every subject and in a 

variety of media can now be accessed from anywhere at anytime of the day and by an unlimited number of 
people.

	 c.	 Information communication technology has proved helpful security wise in the creation of devices such as 
hidden cameras, webcam etc which is used in offices, organizations, homes.

3.		 What is the role of ICT in education?
Ans:	 Information and Communication technology is helping educators make significant changes to the learning 

process. Many schools now have computers that are connected to internal networks and the Internet, allowing 
students to easily communicate with one another. New computer-based education and training programs offer 
interactive instruction on a one-to-one basis and can be automatically modified to suit the user’s level of ability. 
It is used to store vital student and staff data that assists in self evaluation and improvement in addition to 
contributing to improved learning and teaching.

4.		 What is computer ethics?
Ans:	 Computer ethics is a branch of practical philosophy which deals with how computing professionals should make 

decisions regarding professional and social conduct. 

5.		 What are the ten commandments of computer ethics?
Ans:	 The ten commandments of computer ethics are:	
	 •	 Do not use a computer to harm other people.
	 •	 Do not interfere with other people’s computer work.
	 •	 Do not copy or use proprietary software for which you have not paid.
	 •	 Do not snoop around in other people’s computer files. 
	 •	 Do not use a computer to steal.	
	 •	 Do not use a computer to bear false witness.
	 •	 Do not use other people’s computer resources without authorization or proper compensation.
	 •	 Do not use other people’s intellectual output.
	 •	 Always think about the social consequences of the program you are writing or the system you are designing.
	 •	 Always use a computer in ways that demonstrate consideration and respect for your fellow humans.
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Chapter Review
1.	 State whether the following statements are true or false. 
a.  	 Modern information and communication technologies have created a “global village,” 

in which people can communicate with others across the world as if they were living 
next door. 

b.	 With the Internet and the World Wide Web, a wealth of learning materials in almost 
every subject and in a variety of media can now be accessed from anywhere at 
anytime of the day and by an unlimited number of people.

c.	 Educational institutions use ICT by using computers, software application and the 
internet to reduce the cost of doing business, save and hence make profit. 

d.	 Computer ethics is set of moral principles that regulate the use of computers. Some 
common issues of computer ethics include intellectual property rights (such as 
copyrighted electronic content), privacy concerns, and how computers affect society. 

 
2.	 Match the following. 
  	 Web cam		 The study or business of developing and using technology 

to process information and aid communications. 
	 Computer ethics		 A worldwide, noncommercial, freely accessible network 

of networks.
	 Internet	 A system of interlinked hypertext documents accessed 

via the Internet.
	 World Wide Web		 A set of moral principles that regulate the use of 

computers. Some common issues of computer ethics 
include intellectual property rights (such as copyrighted 
electronic content), privacy concerns, and how computers 
affect society. 

	 ICT		 A video camera that feeds or streams its image in real 
time to or through a computer or computer network.

3.	 	Answer the following questions.
a.	 What is ICT?
b.	 What are the important advantages of Information and Communication Technology?
c.	 What is the use of ICT in education?
d.	 What is the role of ICT in medicine?
e.	 What is the importance of ICT in business?
f.	 What is computer ethics?
g.	 What are the ten commandments of computer ethics?
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Objectives

After completing this chapter, you will be able 
to:

	Define computer virus and explain how 
computer viruses spread. 

	Explain the different types of computer 
viruses.

	Enumerate some symptoms of a virus 
infection.

	List some precautions that must be observed 
to avoid virus infection.

	Define antivirus software. 

Computer
Virus
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Concept: Biggest Threat
Computer virus is one of the biggest threats to computers today. A computer virus is 
a relatively small software program that is attached to another larger program for the 
purpose of gaining access to information or to corrupt information within a computer 
system. A computer virus needs another program in order to be able to be activated and 
infect other computers files. Essentially, a computer virus rides piggyback on another 
file into your computer - once it is executed, the virus will continue to replicate and 
attach itself to other program files and continue to spread. Some computer viruses may 
be relatively harmless. For example, some of them just cause a certain message to pop 
up on a user’s computer screen. Other viruses can be deadly to the computers they infect, 
erasing information and hard drives, stealing data, and slowing down the entire computer 
system. Like other software programs, someone must create and write a computer virus; 
once they are created, viruses can multiply rapidly and spread themselves from computer 
to computer. 

With the advent of the personal computer, floppy disk drives, and other 
portable information storage devices, it became easier to program and 
transfer viruses from one machine to another. Fred Cohen is often cited as 
the first person to use the term “computer virus” in an academic paper in 
1984.
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A look to Future

Maximum Security
The computer of the future could have a maximum security 
system, so that only you can use it. It has a touch pad to 
recognize your unique fingerprint, a vision sensor to detect 
the patterns in the iris (coloured part) of your eye, and a 
microphone to pick up the sounds of your voice. If all these 
checks are passed, the computer recognizes you and grants 
you access.

Some of the features of a computer virus are listed below:
a. 	 The computer virus may cause problems immediately.
b		 It may count specific occurrences, for example, how many times it is copied, and then 

cause damage.
c. 	 It may look at the computer’s clock and cause damage on a specific date.
d.	 It may reproduce itself and then cause damage.
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Who Creates a Virus and why?
Although anybody with minimal programming skills can create a virus, the level of 
programming skills required to create a virus depends upon the extent of damage that 
a virus is expected to cause. It is difficult to understand the underlying motivation of 
a programmer who creates a virus because most virus programmers hide their identify 
and are anonymous. Usually, the motive behind creating a virus also remains unknown 
because of anonymity of virus programmers.

An infinite series of viruses found over the Internet are designed for different objectives, 
some of these objectives are listed below:

•	 To gain control of or hack a computer and use it for specific tasks,

•	 To generate money by using such malware as a cash machine,

•	 To steal sensitive information, 

•	 To prove that they are capable of writing a virus,

•	 For revenge against a company,

•	 To cripple a computer or network.

How do Computer Viruses spread?
Computer viruses are small software programs that are designed to spread from one 
computer to another and to interfere with computer operation. It is usually activated when 
the program or file to which it is attached is executed or accessed. It can only spread from 
one computer to another when its host is taken to the uninfected computer. It can spread 
through the following media:
• 	 By opening an infected e-mail attachment,
•	 By downloading an infected program from the Internet,
•	 By using infected removable disks,
•	 By transferring an infected program over a network and executing it.  

Types of Computer Virus
Computer viruses come in a wide variety. The level of destructiveness of viruses varies 
widely. Virus behaviour can range from annoying to destructive. Computer viruses are 
categorized by their infection targets. They are of the following types: boot sector viruses 
and file infecting viruses.

Facts Corner
 There are currently over 10,000 known computer viruses worldwide. Over 200 new viruses are 
being discovered every month. 
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Boot Sector Virus
Boot sector virus is a type of virus that infects the first sector, i.e. the boot sector of a 
floppy disk or hard drive. Boot sector viruses can also infect the MBR (Master Boot 
Record). It either replaces or modifies the instruction in the boot sector by some different  
code. This prevents the hardware from loading system software when the computer is 
turned on. Boot sector virus activates only when you turn on or restart your computer. 
Disk Killer, Stoned and Michelangelo are the examples of boot sector viruses. 

File Infecting Viruses 
File infecting viruses are designed to infect executable program files having extensions 
.exe, .com, or .dll. These viruses either overwrite or modify the contents of executable 
files. When these infected files are executed, other files on the computer also get infected. 
File viruses can spread by using floppy disks, pen drives and CDs. Friday the 13th, Enigma 
and Nemesis are the examples of file infecting viruses. 

Warning Signs of a Virus Attack
Some of the warning signs of virus attack are listed below:
•	 Suspicious graphics appear without any user input.
•	 Hard disk space seems to be less than it should be.
•	 The system becomes slow and loading a program takes much longer than usual.
• 	 Folder and file sizes changes inexplicably.
•	 Folder and files sizes changes inexplicably.
•	 Files get extension names that you do not recognize.

Tips for Safe Computing
Today, we are more dependent on computers and the information that they store than 
ever before.  From spyware, viruses, and Trojans to identity theft and computer hardware 
malfunctions-any disruption can have a huge impact on our lives. The spread of computer 
virus infections can be stopped through the practice of safe computing. The following are 
a list of some recommendations for safe computing: 
•	 Always check a removable disk for viruses before using it. 
•	 Install software from the original optical disk. If the originals are not available, scan 

the secondary media for viruses before installation.
•	 Do not use illegal software. The illegal software contain viruses.
•	 Ensure that the antivirus package scans all system and boot files at start-up.
•	 Always scan files downloaded from the Internet or transferred over the network 

before executing them on your machine.
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AntiVirus Software
Anti-virus software is a utility that searches 
a hard disk for viruses and removes any that 
are found. If and when a virus is detected, 
the computer displays a warning asking 
what action should be done, often giving 
the options to remove, ignore, or move the 
file to the vault. Most antivirus programs 
include an auto-update feature that enables 
the program to download profiles of new 
viruses so that it can check for the new 
viruses as soon as they are discovered. 
Some popular anti-virus software available 
are: Norton AntiVirus, McAfee VirusScan, 
Microsoft Security Essentials.
Antivirus software typically performs the following tasks:
•	 Scans files and folders for viruses.	
•	 Provides information when a virus is detected.
•	 Cleans virus-infected files.
•	 Continuously monitors memory to protect the computer from memory-resident 

viruses.

Facts Corner
Microsoft Security Essentials (MSE) is an antivirus software (AV) product that provides 
protection against different types of malware such as computer viruses, spyware, rootkits and 
Trojan horses.

Trojan Horse
Trojan Horse is a program in which malicious or harmful code is contained inside 
apparently harmless programming or data in such a way that it can get control and do its 
chosen form of damage, such as ruining the file allocation table on your hard disk.  Some 
of the common trojan horse are Netbus (by Carl-Fredrik Neikter), Subseven or Sub7(by 
Mobman), Back Orifice (Sir Dystic), Beast and Zeus.

Computer Worms
Computer worm is a standalone malware computer program that replicates itself in order 
to spread to other computers. Often, it uses a computer network to spread itself, relying 
on security failures on the target computer to access it. Worms use parts of an operating 
system that are automatic and usually invisible to the user. It is common for worms to be 
noticed only when their uncontrolled replication consumes system resources, slowing or 
halting other tasks.
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Computer virus	 :	 A program or piece of code that is loaded onto your computer 
without your knowledge and runs against your wishes.  

Boot sector virus 	 :	 A computer virus designed to infect the boot sector of the disk. 

Antivirus software	 :	 A program designed to detect and remove viruses from the 
infected programs or files in the computer system.	

Computer Worm	 :	 A malicious software application designed to spread via computer 
networks. 

File infecting virus 	:	 A computer virus designed to infect executable program files 
having extensions .exe, .com, or .dll. 

Tricky Terms

Let 
Us Revise
•	 A computer virus is a software program that can generate multiple copies of itself. 
•	 Computer viruses can spread through the following media: physical storage devices, 

E-mail and Internet.
•	 Computer viruses are categorized by their infection targets. They are of the following 

types: boot sector viruses and file infecting viruses.	    
•	 Boot sector viruses are designed to infect the boot sector of the disk. Disk Killer, 

Stoned and Michelangelo are the examples of boot sector viruses.	
•	 The boot sector is the first sector of a disk which directs the computer to the location 

of the operating system. 	
•	 File infecting viruses are designed to infect executable program files having extensions 

.exe, .com, or .dll. Friday the 13th, Enigma and Nemesis are examples of this type of 
viruses. 

•	 The impact of a computer virus infection can range from disruption in work by 
flashing messages on a computer screen to causing serious damages worth millions 
of dollars to an organization.

•	 Antivirus software is a program designed to detect and remove viruses from computer 
system.

•	 Some popular anti-virus software available are: Norton AntiVirus, McAfee VirusScan, 
Microsoft Security Essentials.
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Solved Exercises
1.	 What is a computer virus? What are the different types of computer viruses?
Ans: 	 A computer virus is a software program that can generate multiple copies of itself. Computer viruses are categorized 

by their infection targets. They are of the following types: boot sector viruses and file viruses.

2.	 What are the different media through which computer viruses spread?
Ans: 	 Computer viruses can spread through the following media:
		 • 	 By opening an infected e-mail attachment,
		 •	 By downloading an infected program from the Internet,
		 •	 By using infected floppy disks, pen drives and CDs,
		 •	 By transferring an infected program over a network and executing it.  

3.	 What is a file infecting virus? Give any two examples of a file infecting virus.
Ans:	 File infecting virus is a computer virus that infects executable program files having extensions .exe, .com, or .dll. 

It can spread by using floppy disks, pen drives and CDs. Friday the 13th, Enigma and Nemesis are the examples of 
file infecting viruses.

4.	 What are the warning signs of virus attack?
Ans:	 Some of the warning signs of virus attack are listed below:
		 • 	 Decreasing the speed of the computer by decreasing the memory,
		 •	 Causing strange movements or patterns on the screen,
		 •	 Frequent hanging of the system,
		 •	 Showing abnormal write protect error.

5.	 List out some of the precautions that must be observed to avoid virus infection.
Ans:	 Some of the precautions that must be observed to avoid virus infection are:
	 •	 Never load an unknown disk into your system unless you make sure that it is virus free.
	 •	 Do not use illegal software. The illegal software contain viruses. 
	 •	 Scan all e-mail attachments before executing them on your machine.

6.	 What is an anti-virus program? List out some of the popular anti-virus software.
Ans:	 Antivirus software is a program designed to detect and remove viruses from the infected programs or files in 

the computer system. Some popular anti-virus software available are: Norton AntiVirus, McAfee VirusScan and 
SmartDog.
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Chapter Review
1.	 State whether the following statements are true or false. 
a.  		 A computer virus is a program designed to infect and potentially damage files on a 

computer that receives it. 
b.	 A boot sector virus activates only when you turn on or restart your computer. 
c.	 Disk Killer, Stoned and Michelangelo are the examples of file infecting viruses.
d.	 Most antivirus programs include an auto-update feature that enables the program to 

download profiles of new viruses so that it can check for the new viruses as soon as 
they are discovered.

e.	 Trojan Horse is a malicious software application designed to spread via computer 
networks.

 
2.	 Fill in the blanks. 
a.  		 _________________ is a small software programs that are designed to spread from 

one computer to another and to interfere with computer operation. 
b.	 ________________ is a type of virus that infects the first sector, i.e. the boot sector 

of a floppy disk or hard drive.
c.	 _______________ is a program designed to detect and remove viruses from the 

computer system. 
d.	 _________________ is a program in which malicious or harmful code is contained 

inside apparently harmless programming or data in such a way that it can get control 
and do its chosen form of damage, such as ruining the file allocation table on your 
hard disk.

e.	 _________________ is a malicious software application designed to spread via 
computer networks. 

3.		 Select the best answer from the list of choices.
a.		 A computer virus can spread through: 
		 i.	 Email attachment	 ii.	 Internet
		 iii.	 Pen drives	 iv.	All of the above
	
b.		 Disk Killer, Stoned and Michelangelo are the examples of _____________ viruses.
		 i.	 Boot sector	 ii.	 File infecting
		 iii.	 None of the above	 iv.	All of the above
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c.		 _____________ is a program designed to detect and remove viruses from the 
computer system.

		 i.	 Computer virus	 ii.	 Computer worm		
		 iii.	 Antivirus 		  iv.	None of the above
	
d.		 ________________ is a malicious software application designed to spread via 

computer networks. 
		 i.	 Computer virus	 ii.	 Computer worm		
		 iii.	 Trojan Horse 		 iv.	All of the above
		
e.		 ___________________ is the popular antivirus software.
		 i.	 Norton Antivirus	 ii. 	Microsoft Word 	
		 iii. 	 Microsoft Excel	 iv.	All of the above
	   
4.	 Give an appropriate technical term for each of the following.
a.	 A small software program that is designed to spread from one computer to another 

and to interfere with computer operation. 
b.	 A type of virus that infects the first sector, i.e. the boot sector of a floppy disk or hard 

drive.
c.	 A type of virus that infects executable files having .exe, .com, .ovl, .drv, .sys, or .dll.
d.	 A program designed to detect and remove viruses from the computer system. 
e.	 A malicious software applications designed to spread via computer networks. 

5.	 Answer the following questions.
a.		 What is a computer virus? 
b.	 Who creates a computer virus? Why do they create computer viruses?
c.	 How does a computer virus spread from one computer to another?
d.	 What is a boot sector virus? Give any two examples of a boot sector virus.
e.	 What is a file infecting virus? Give any two examples of a file infecting virus.
f.	 List any three warning signs of a computer virus attack.
g.	 List any three precautions that must be observed to avoid computer virus infection.
h.	 What is an antivirus program? Give an example.
i.	 What is Trojan Horse?
j.	 What is Computer Worm?



12

Objectives

After completing this chapter, you will be 
able to: 

	Define Internet and explain the uses of the 
Internet.

	Identify the items necessary to connect to 
the Internet.

	Define World Wide Web and search engine.

	Discuss the freebies provided on the Web.

The
Internet
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Internet
The Internet is one of the major tools in the 
Information Age. It has made a profound impact 
in different areas of learning and communicating. 
It has shrunk the world and brought people 
together. The Internet is an inter-connection of 
several computers of different types belonging to 
various networks all over the globe. It is an ocean 
of information accessible to people across the 
world. It is the mother of all computer networks. 
Internet stands for Internet worked Networks.

A look to Future

Aliens Calling
Our communications equipment here on Earth works using 
radio waves. But radio waves are also produced naturally 
by objects in space, such as stars. A whole branch of science, 
called radio astronomy, is dedicated to observing them. 
Deep in space, maybe aliens are also using radio waves. 
As they explore the Universe, and our own radio-based 
communications improve, perhaps one day we could chat to 
them on mobile phone

Uses of the Internet
Today, the Internet connects millions of computers around the world. The Internet is 
a combination of several media technologies and an electronic version of newspapers, 
magazines, books, catalogs, bulletin boards, and much more. This versatility gives the 
Internet its power. The major advantages provided by the Internet are listed below:
•		 Provides the fastest means to access and provide information.
•	 Allows to locate and download free computer software and other programs 

available.	
•	 Allows to play the multimedia games, listen to music and watch movies.
•	 The latest means and items of education and entertainment can be posted on and 

downloaded from the Internet. 
•	 Acts as a vast virtual market place where people can advertise and order their products. 
•	 Sends files, data and information through electronic mail.

Facts Corner The World Wide Web (WWW) was created in 1990 by the British CERN physicist Tim Berners-Lee.
On 30 April 1993, CERN announced that the World Wide Web would be free to use for anyone.
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World Wide Web
The World Wide Web (WWW) is the leading information-exchange service of the 
Internet. It is the information store of the Internet. It contains a large collection of linked 
text, image, sound, and video files. The World Wide Web has gained popularity largely 
because it has a graphical interface and multimedia capabilities. The World Wide Web is 
often referred to as the Web. The Web includes:
•	 shopping malls filled with virtual retail outlets 
•	 private and public repositories of software 
•	 libraries 
•	 magazines 
•	 newspapers 
•	 online cafes and meeting spots
•	 forums

Internet Connection
The following items are necessary to connect to the Internet:

•	 A multimedia computer with a special communication software known as the browser 
such as Internet Explorer and Mozilla Firefox. A browser is a software application 
used to locate, retrieve and display content on the World Wide Web, including Web 
pages, images, video and other files.

•	 A telephone line or cable connection.	

•	 A modem or cable modem. Modem is used for conversion of data from digital to 
analog and vice versa.

•	 An account with an Internet Service Provider. The companies who provides services 
for Internet application are the Internet Service Providers (ISP).
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Surf the Net
The World Wide Web is a collections of millions of information sources within the 
Internet. It is extremely difficult to locate the needed information on the Internet. In such 
cases, you can take the help of search engines. Search engines are software programs that 
searches for Web sites based on keywords or a combination of keywords. Search engines 
look through their own databases of information in order to find what it is that you are 
looking for. A number of search engines are available on the Internet and sometimes they 
are called spiders of the net. Some popular search engines are:
•	 www.yahoo.com
•	 www.excite.com
•	 www.altavista.com
•	 www.google.com

Freebies on the Web
The Internet is the large group of millions of computers around the world that are all 
connected to one another. There are various web sites on the Web that provides different 
kinds of facilities such as e-mail, chat rooms and business forums. Here are a few of the 
free services you can access through the Web. 

Electronic Mail
Electronic mail, often abbreviated as email or e-mail, is the most widely used service 
on the Internet. It has become an important means of communication for personal and 
business use. It is the  method of transmitting data, text files, digital photos, or audio 
and video files from one computer to another over the Internet. A computer, a modem or 
network connection and an e-mail address are needed for using e-mail. All online services 
and Internet Service Providers (ISPs) offer e-mail account promptly after you sign up. All 
on-line services and Internet service providers offer e-mail to subscribers. E-mail is fast, 
flexible, and reliable. The most popular Web-based email services are www.hotmail.com 
and www.yahoo.com.

Knowledge Update

Raymond Samuel Tomlinson (born 1941) is a programmer 
who implemented an email system in 1971. The first e-mail 
was sent between two computers that were actually sitting 
besides each other. However, the ARPANET network was used 
as the connection between the two. The first email message 
was “QWERTYUIOP”.
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Web Chat
Web chat is one of the important services provided by the Internet. It is a program that 
enables you to communicate with others in real-time through text messages. The user 
can log on to certain websites and communicate with various other users online by using 
an Internet chat software. Chat software is an interactive software that allows the user to 
type some comment in one window and receive replies in another from someone who 
is accessing the same software. The technology has improved so much that it is now 
possible to make voice chat as well as video chat through the Internet using Web cameras 
and audio equipment.

E-Learning (Electronic Learning) 
E-Learning is electronic learning, in which the learner uses a computer to learn a task, 
skill, or process. It is also referred to as computer-based training, web-based training, and 
online learning. It can be self-paced or instructor-led and includes media in the form of 
text, image, animation, streaming video and audio. Content is delivered via the Internet, 
intranet/extranet, audio or video tape, satellite TV, and CD-ROM.

Some of the unique features of E-Learning are:
a.	 Learning is self-directed, allowing students to choose content and tools appropriate 

to their differing interests, needs and skill levels.
b.	 Learning is self-paced and gives students a chance to speed up or slow down as 

necessary.
c.	 Accommodates multiple learning styles using a variety of delivery methods geared to 

different learners; more effective for certain learners.
d.	 Fosters greater student/instructor contact.
e.	 Enhances computer and Internet skills.
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Searching for Information on the Web
Web search engine is a software system that is designed to search for information on the 
World Wide Web. The search results are generally presented in a line of results often 
referred to as search engine results pages (SERPs). The information may be a specialist 
in web pages, images, information and other types of files. Web search engines are 
actually databases that contain reference to thousands of resources. These databases are 
maintained by special programs called agents, spiders, or bots. They automatically search 
for new information on the Web and update the databases. A number of search engines 
are available on the Internet and sometimes they are called Web crawlers or Web spiders. 
Some of the popular search engines are: Google, WebCrawler, Yahoo! and AltaVista.

1.	 Type URL for search site.

2.	 Type keywords here and 
press Enter.

3.	 The matching sites are listed 
here and click on the link to 
display the page.

Are you going to use a search tool to locate some information? Here are a few tips that 
might help.
a. 	 Start with the right tool. For general information, use an index like Yahoo. For specific 

information, use a search engine like Hotbot.	
b.	 Be as precise as possible. Use specific key words that relate directly to the topic.
c.	 Use multiple words. Use quotation marks to identify key words.
d.	 Check your spelling.
e.	 Look only at the first page of search results. If necessary, try another search engine 

using different key words.

Tips



146 Computer Zone - Book 6

Internet 	 :		 A worldwide, noncommercial, freely accessible network 
of networks.

Browser	 :		 A software that acts as an interface between the user and 
the inner workings of the Internet.

World Wide Web 	 :		 The information store of the Internet.

Search Engines 	 :		 Software programs that searches for Web sites based on 
keywords or a combination of keywords.

E-Mail	 :		 A system for sending and receiving messages electronically 
over a computer network, as between personal computers.

Tricky Terms

Let 
Us Revise
•	 The computer network  is a group of computers that are connected together to share 

data as well as resources stored in one computer with another.
•	 The Internet is the largest network of computers spread all over the world.
•	 World Wide Web is the interconnected collection of information sources within the 

Internet that allow users to view images, look at film clips, hear sound recordings, and 
find valuable and interesting information.

•	 Search engines are software programs that searches for Web sites based on keywords 
or a combination of keywords. 

•	 Search engines look through their own databases of information in order to find what 
it is that you are looking for.

•	 E-mail is a system for sending and receiving messages electronically over a computer 
network, as between personal computers.

•	 Chat software is a software that allows the user to type some comment in one window 
and receive replies in the same window from someone who is accessing the same 
software.	

•	 The World Wide Web provides an exciting new opportunity for distance teaching and 
learning.

•	 Using teleconferencing method a teacher at a distant place can teach students in 
another place. 

•	 A web page is a document or resource of information that is suitable for the World Wide 
Web and can be accessed through a Web browser and displayed on a computer screen.
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Solved Exercises
1.		 What is the Internet, and how did it begin?
Ans: 	  The Internet is a global collection of millions of computers of different types belonging to various networks. The 

Internet began life in 1969 when the United States Department of Defence started a network called ARPAnet. In 
1986, the National Science Foundation created NSFNET to connect research universities. These networks formed 
the basis for the worldwide system of computers, giving birth to the Internet. 

2.		 What are the advantages of the Internet?
Ans: 	 The major advantages provided by the Internet are listed below:
	 •	 Provides the cheapest and fastest means to access and provide information.
	 •	 Allows to locate and download free computer software and other programs available.	
	 •	 Allows to play the interactive multimedia games, listen to music and watch movies.
	 •	 The latest means and items of education and entertainment can be posted on and downloaded from the 

Internet. 
	 •	 Acts as a vast virtual market place where people can advertise and order their products. 
	 •	 Sends files, data and information through electronic mail.

3.	 What is a browser? What are some of the most popular browsers?
Ans:  	 A browser is a software program that runs on your computer and helps you access Web pages. It provides a set 

of tools for viewing Web pages and navigating from one Web page to another. The most popular browsers are 
Mosaic, Netscape Navigator and Internet Explorer. 

4.	 What is Web surfing?
Ans:  	 A user can click any of the links in a Web page and can move to another Web page. From there the user can visit 

another Web page in a different Web site and this process can repeat. The process of moving through different 
Web pages is called Web surfing or Web navigation.

5.	 What is E-Learning (Electronic Learning) 
Ans:	 E-Learning is electronic learning, in which the learner uses a computer to learn a task, skill, or process. It is 

also referred to as computer-based training, web-based training, and online learning. It can be self-paced or 
instructor-led and includes media in the form of text, image, animation, streaming video and audio. Content is 
delivered via the Internet, intranet/extranet, audio or video tape, satellite TV, and CD-ROM.

6.	 What is a search engine? What are some of the search engines available on the Web?
Ans:  	 Search engines are Web sites that allow the users to search information based on keywords or a combination of 

keywords. Some of the popular search engines are: HotBot, WebCrawler, Yahoo! and AltaVista.



148 Computer Zone - Book 6

Chapter Review
1.	 State whether the following statements are true or false. 
a.  	 The Internet is a combination of several media technologies and an electronic version 

of newspapers, magazines, books, catalogs, bulletin boards, and much more.
b.	 Modem is used for conversion of data from digital to analog and vice versa.
c.	 E-Mail is a program that enables you to communicate with others in real-time through 

text messages.
d.	 Chat software is an interactive software that allows the user to type some comment in 

one window and receive replies in another from someone who is accessing the same 
software.

e.	 A number of search engines are available on the Internet and sometimes they are 
called spiders of the net.

 
2.	 Fill in the blanks. 
a.  	 The____________________is an inter-connection of several computers of different 

types belonging to various networks all over the globe.
b.	 A_____________________is a software application used to locate, retrieve and 

display content on the World Wide Web, including Web pages, images, video and 
other files.

c.	 The______________________is the leading information-exchange service of the 
Internet. 

d.	 ________________________is the  method of transmitting data, text files, digital 
photos, or audio and video files from one computer to another over the Internet. 

e.	 _____________________is electronic learning, in which the learner uses a computer 
to learn a task, skill, or process.

3.	 Match each term with the statement that best describes it. 
	 Browser 			 A worldwide, noncommercial, freely accessible network of 

networks.
	 Internet			 A software that acts as an interface between the user and 

the inner workings of the Internet.
	 Search Engines 			 The information store of the Internet.
	 E-Mail 			 Software programs that searches for Web sites based on 

keywords or a combination of keywords.
	 World Wide Web			 A system for sending and receiving messages electronically 

over a computer network, as between personal computers.
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4.	 Give the appropriate technical term for each of the following statements.

a.	 An inter-connection of several computers of different types belonging to various 
networks all over the globe.

b.	 A software application used to locate, retrieve and display content on the World Wide 
Web, including Web pages, images, video and other files.

c.	 The leading information-exchange service of the Internet that contains a large 
collection of linked text, image, sound, and video files.

d.	 The  method of transmitting data, text files, digital photos, or audio and video files 
from one computer to another over the Internet. 

e.	 A program that enables you to communicate with others in real-time through text 
messages. 

5.	 Give the full forms of the following abbreviations.

	 a.	 ISP				    b. WWW	  		  c. URL

	 d.  SERPs				   e.  CD-ROM			 

6.	 In your own words, briefly answer the following questions.

a.		 What is a computer network?

b.	 What is the Internet? 

c.	 What are the advantages provided by the Internet?	

d.	 What are the requirements for getting online?

e.	 Define a web browser? Name any two popular web browsers.	

f.	 What is world wide web? What does it include?

g.	 What are search engines? Name some popular search engines.	

h.	 What is electronic mail? Name any two popular electronic mail.	

i.	 What is Web chat?

j.	 What is e-learning? What are the unique features of e-learning?
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Objectives

After completing this chapter, you will be 
able to:

	Define graphic software.

	State the advantages of Microsoft Paint.

	Explain the different components of a new 
Paint window.

	Explain the uses of different paint tools.

	Explain the steps to draw lines and shapes 
in Paint.
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Concept-Graphics Software
Graphic software is a kind of software which is usually used to manipulate visual images 
or creating, editing and managing 2D computer graphics. These computer graphics include 
clip arts, web graphics, digital photos, logos, backgrounds and headings. Most graphics 
programs have the ability to import and export one or more graphics file formats. It also 
can export files to one or more files. Some of the graphics software are Adobe Photoshop 
and Paint. SuperPaint (1973) was one of the earliest graphics software applications. 

Paint (formerly Paintbrush for Windows) is a simple graphics painting program that has 
been included with all versions of Microsoft Windows. It is often referred to as MS Paint 
or Microsoft Paint. The program opens and saves files as Windows bitmap, JPEG, GIF, 
PNG, and TIFF. It is present in the Accessories menu. It allows you to draw beautiful 
pictures and colour them. This is done by using the various tools and colours present in 
the Toolbox and Color box respectively.

A look to Future

Computer Takeover
Computers communicate with each other all the time. They 
exchange billions of items of data every second, around the 
world. But they do this according to computer programs 
created by humans. If computer became truly intelligent, 
they could start creating their own programs. They may start 
forming their own ideas and building their own robots. They 
could even capture us and turn us into slaves!

The advantages of Microsoft Paint are as follows:
•	 The advantages of MS Paint are simplicity, user-friendliness and cost-effectiveness 
•	 The program has always been free and users have never had to pay for upgrades, 

enhancements or bug fixes. Since Paint is part of the Windows operating system, Paint 
updates are included whenever Microsoft releases a new version of Windows. 

•	 The program has a small set of brushes, pens and other drawing tools. Paint also has a 
convenient text tool that overlays text objects on top of images. The program supports 
many popular image formats, such as JPEGs and GIFs.

•	 Extensive documentation, including hints, tips and tutorials available online makes it 
extremely user-friendly. 

•	 Enhancements to the Windows 7 version include a new ribbon, similar to the one 
used within the Office products. This simplifies navigation and gives users optimal 
experiences with a cleaner, much more ergonomic interface. 
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Getting started with Paint
Paint is a feature in Windows that you can use to draw, color, and edit pictures. You can 
use Paint like a digital sketch pad to make simple pictures, creative projects, or to add text 
and designs to other pictures, such as those taken with your digital camera.

Open Paint by clicking the Start button, clicking All Programs, clicking Accessories, and 
then clicking Paint.

When you start Paint, you’ll see an empty window; drawing and painting tools are located 
in the ribbon at the top of the window. The following illustration shows the different parts 
of the Paint window:

Quick Access Toolbar

Paint button

Ribbon

Drawing Area

The different components of a new Paint window are:
Quick Access Toolbar	 The Quick Access Toolbar is the small row of icons, 

found above the ribbon, on the upper left of the screen. 
It contains common commands that you use over and 
over again every day, such as Save, Undo, Redo, etc.

Paint Button	 Below the Quick Access toolbar and on the left side, 
there is button called Paint button. Clicking on this 
button opens the main menu of Paint. 

Tabs	 There are two tabs: Home Tab and View Tab in the 
Paint.

		  The Home tab contains the Ribbon, from which tools 
and colors are selected.

		  The View tab contains Zoom In/Zoom Out, Full 
Screen mode options.
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Color Palette 
The Color boxes indicate the current Color 1 (foreground color) and Color 2 (background 
color) colors.

The Color 1 box shows the active colors or foreground color. To change the foreground 
color, click on Color 1 box and then click on the desired color palette.

The Color 2 box is the background color. The background color is the default color of any 
new image that you create. To change the background color, click on Color 2 box and then 
click on the desired color in the Color palette.

Color 1 box

Color 2 box

Tools in Paint
Paint contains a different tools to draw and insert shapes into your drawing. The different 
types of tools in Paint are: 
Pencil Tool 	 The pencil tool is used to draw straight, wavy and 

curved lines. It is used as a normal pencil. Freehand 
drawing can be done using this tool.

Eraser Tool 	 The eraser tool is just like your normal eraser which is 
used to erase a drawing or a part of it.

Brush Tool	 The brush tool is used for drawing freehand drawings 
using coloured brush.

Line Tool 	 The line tool is used to draw horizontal, vertical or 
slanting or straight lines of different thickness.

Rectangle Tool 	 The rectangle tool is used for drawing rectangles or 
squares. 	

Circle Tool 	 The circle tool is used for drawing oval shapes and 
circles.

Rounded Rectangle Tool	 The rounded rectangle tool is used for drawing 
rectangles with rounded corners.

Polygon Tool	 The polygon tool is used for drawing 
polygons.	

Curve Tool	 The curve tool is used to draw curved shaped objects.
Text Tool 	 The text tool is used to write text on the Paint screen. 
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Drawing Lines
Some tools and shapes, such as the Pencil, Brush, Line, and Curve let you make a variety 
of straight, and curved lines.
To draw lines, do the following:	
a.	 On the Home tab, in the Shapes group, click the tool for the type of line you want to 

draw. 
b.	 In the Colors group, click Color 1, and then click the color you want to use.
c.	 To draw, drag the pointer across the drawing area.

Drawing Shapes
Paint lets you draw many different shapes. For example, you can draw ready-made, 
defined shapes such as rectangles, circles, squares, triangles, and arrows.
To draw shapes, do the following:	

a.	 On the Home tab, in the Shapes group, click a ready-made shape, such as the 
Rectangle‌.

b.	 To add a ready-made shape, drag the pointer across the drawing area to make the 
shape.

c.	 To change the outline style, in the Shapes group, click Outline, and then click an 
outline style. 

	 If you don’t want your shape to have an outline, click No outline.
d.	 In the Colors group, click Color 1, and then click a color for the outline.
e.	 In the Colors group, click Color 2, and then click a color to use to fill the shape.
f.	 To change the fill style, in the Shapes group, click Fill, and then click a fill style.
	 If you don’t want your shape to be filled, click No fill.
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Draw a squiggly line
Some tools and shapes, such as the Pencil, Brush, Line, and Curve, let you make a variety 
of straight, curved, and squiggly lines. What you draw is determined by how you move 
the mouse as you draw. You can use the Line to draw a straight line, for example.
a.    On the Home tab, in the Shapes group, click the Line   Picture of the Line .
b.	 In the Colors group, click Color 1, and then click the color you want to use.
c.    To draw, drag the pointer across the drawing area.

Add text
You can also add text to your picture. The Text tool lets you add a simple message or title.
a.    On the Home tab, in the Tools group, click the Text tool Picture of the Text tool.
b.    Drag the pointer in the drawing area where you want to add text.
c.    	Under Text Tools, on the Text tab, click the font face, size, and style in the Font 

group.

d.	 In the Colors group, click Color 1, and then click a color. This is the text color.
e.	 Type the text that you want to add.

Erase part of your picture
If you make a mistake or need to change part of a picture, use the eraser. By default, 
the eraser changes any area you erase to white, but you can change the eraser color. For 
example, if you set the background color to yellow, anything you erase turns to yellow.
a.	 On the Home tab, in the Tools group, click the Eraser tool Picture of the Eraser tool.
b.    	In the Colors group, click Color 2, and then click the color that you want to erase 

with. If you want to erase with white, you don’t have to select a color.
c.    	Drag the pointer over the area you want to erase.
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Resize and Skew
Resize command is used to change the size of the drawing by making it taller or shorter. 
Skew command is used to twist the drawing.
Resizing an image
a.	 Click on Home tab.
b.	 Click on Select.
c.	 Select the image by dragging the mouse over it.
d.	 Click on Resize. Resize and Skew dialog box appears.

e.	 Select the Maintain aspect ratio check box.
f.	 Select the radio button of pixels.
g.	 Type the horizontal value (width) or vertical value (height).
h.	 Click on OK. The new size of the image appears.

Skew an image
a.	 Click on Home tab.
b.	 Click on Select.
c.	 Select the image by dragging the mouse over it.
d.	 Click on Resize. Resize and Skew dialog box appears. 
e.	 Type the amount of skew in the Horizontal and Vertical boxes.
f.	 Click on OK. The skew of the image appears.
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Flip and Rotate
Paint allows you to flip or rotate your drawing. Flip command is used to create a mirror 
image of the picture either horizontally or vertically. Rotate command is used to change 
the position of image at different angles.
a.	 Click on Home tab.
b.	 Click on Select.
c.	 Select the image by dragging the mouse over it.
d.	 Click on Rotate. Rotate and Flip options appears.

e.	 Click on rotation direction you want.  

Cropping a Picture
The Crop tool is used to crop a picture so only the part you selected appears in your 
picture. Cropping lets you change the picture so only the selected object or person is 
visible.

a.	 Click on Home tab.

b.	 Click on Select.

c.	 Select the image by dragging the mouse over it.

d.	 Click on Crop. Only the selected part of the image appears. 

Copying an Image
Copying image allow you to make duplicate image in the drawing area. It can save your 
time by not drawing the same image again and again. The Copy and Paste command is 
used to copy the image from one place  and paste it at another place.
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a.	 Click on Home tab.
b.	 Click on Select.
c.	 Select the image by dragging the mouse over it. 
d.	 Click on Copy. 
e.	 Click on Paste. The duplicate image appears in the drawing area.
f.	 Now place the mouse pointer on the selected image and drag it to anywhere in 

drawing area.

Cutting an Image
The Cut command removes the selected data from its original position. paste it at another 
place.
a.	 Click on Home tab.
b.	 Click on Select.
c.	 Select the image by dragging the mouse over it.
d.	 Click on Cut. 
e.	 Click on Paste. The image appears in the drawing area.
f.	 Now place the mouse pointer on the selected image and drag it to anywhere in 

drawing area.

Zoom In and Zoom Out
The Zoom in and Zoom out is used to see a larger or smaller view of your image. For 
example, you might be editing a small part of it and need to zoom in to see it. Or the 
opposite might be true; your picture might be too large to fit on the screen, so you need to 
zoom out to view all of it.
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In Paint, there are few different ways to zoom in or out, depending on what you want to 
do.
a.	 To increase the zoom level, on the View tab, in the Zoom group, click Zoom in.
b.	 To reduce the zoom level, on the View tab, in the Zoom group, click Zoom out.
c.	 To view the picture in the Paint window at its actual size, on the View tab, in the 

Zoom group, click 100%.

Saving and Opening your picture
Save a picture for the first time
When you save a new picture for the first time, you’ll need to give it a file name.
a.	 Click the Paint button, and then click Save.
b.	 In the Save as type box, select the file format you want.
c.	 In the File name box, type a name, and then click Save. 

Open a picture
Instead of starting with a new picture, you might want to open an existing picture and edit 
in Paint.
a.	 Click the Paint button, and then click Open.
b.	 Find the picture you want to open in Paint, click it, and then click Open. 
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Graphic software	 :	 A kind of software which is usually used to manipulate visual 
images or creating, editing and managing 2D computer 
graphics.

PAINT 	 :	 A simple graphic program that you can use to create drawings 
on a blank canvas or on top of other pictures. 

Flip command 	 :	 The command used to create a mirror image of the picture 
either horizontally or vertically. 

Crop tool 	 :	 The tool used to crop a picture so only the part you selected 
appears in your picture.

Accessories	 :	 Additional programs that help us doing various jobs such as 
painting, creating documents, etc.	

Tricky Terms

Let 
Us Revise
•	 Graphic software is a kind of software which is usually used to manipulate visual 

images or creating, editing and managing 2D computer graphics.
•	 Paint is a feature in Windows that you can use to draw, color, and edit pictures. 
•	 The Quick Access Toolbar is the small row of icons, found above the ribbon, on the 

upper left of the screen. 
•	 The Color boxes indicate the current Color 1 (foreground color) and Color 2 

(background color) colors.
•	 The pencil tool is used to draw straight, wavy and curved lines.
•	 The brush tool is used for drawing freehand drawings using coloured brush.
•	 The rectangle tool is used for drawing rectangles or squares. 
•	 The circle tool is used for drawing oval shapes and circles.
•	 The polygon tool is used for drawing polygons.
•	 The curve tool is used to draw curved shaped objects.
•	 Some tools and shapes, such as the Pencil, Brush, Line, and Curve, let you make a 

variety of straight, curved, and squiggly lines. 
•	 Resize command is used to change the size of the drawing by making it taller or 

shorter.
•	 Flip command is used to create a mirror image of the picture either horizontally or 

vertically. 
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Solved Exercises
1.	 What is a graphic software?
Ans: 	 Graphic software is a kind of software which is usually used to manipulate visual images or creating, editing and 

managing 2D computer graphics.

2.	 What is Microsoft Paint? 
Ans: 	 Paint (formerly Paintbrush for Windows) is a simple graphics painting program that has been included with all 

versions of Microsoft Windows. It is often referred to as MS Paint or Microsoft Paint. 

3.	 What are the advantages of Microsoft Paint?
Ans:	 Microsoft Paint has the following advantages:
	 •	 The advantages of MS Paint are simplicity, user-friendliness and cost-effectiveness 
	 •	 The program has always been free and users have never had to pay for upgrades, enhancements or bug fixes. 

Since Paint is part of the Windows operating system, Paint updates are included whenever Microsoft releases 
a new version of Windows. 

	 •	 The program has a small set of brushes, pens and other drawing tools. Paint also has a convenient text tool 
that overlays text objects on top of images. The program supports many popular image formats, such as 
JPEGs and GIFs.

4.	 What is the use of the following tools in Paint?
Ans:	 Pencil Tool 	 The pencil tool is used to draw straight, wavy and curved lines. It is used as a normal pencil. 

Freehand drawing can be done using this tool.
	 Eraser Tool 	 The eraser tool is just like your normal eraser which is used to erase a drawing or a part of it.
	 Brush Tool	 The brush tool is used for drawing freehand drawings using coloured brush.

5.	 Write the steps to draw shapes in Paint.
Ans:	 Paint lets you draw many different shapes. For example, you can draw ready-made, defined shapes such as 

rectangles, circles, squares, triangles, and arrows.
	 To draw shapes, do the following:	
	 a.	 On the Home tab, in the Shapes group, click a ready-made shape, such as the Rectangle‌.
	 b.	 To add a ready-made shape, drag the pointer across the drawing area to make the shape.
	 c.	 To change the outline style, in the Shapes group, click Outline, and then click an outline style. 
		  If you don’t want your shape to have an outline, click No outline.
	 d.	 In the Colors group, click Color 1, and then click a color for the outline.
	 e.	 In the Colors group, click Color 2, and then click a color to use to fill the shape.
	 f.	 To change the fill style, in the Shapes group, click Fill, and then click a fill style.
	 g.	 If you don’t want your shape to be filled, click No fill.
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Chapter Review
1.	 State whether the following statements are true or false. 

a.  	 Paint (formerly Paintbrush for Windows) is a simple graphics painting program that 
has been included with all versions of Microsoft Windows. 

b.	 The pencil tool is used for drawing freehand drawings using coloured brush.

c.	 Resize command is used to change the size of the drawing by making it taller or 
shorter.

d.	 Flip command is used to change the position of image at different angles.

e.	 The Zoom in and Zoom out is used to see a larger or smaller view of your image. 

 

2.	 Fill in the blanks. 

a.  	 ______________________is a kind of software which is usually used to manipulate 
visual images or creating, editing and managing 2D computer graphics. 

b.	 The__________________color is the default color of any new image that you create.

c.	 The__________________tool is used to draw horizontal, vertical or slanting or 
straight lines of different thickness.

d.	 The______________________tool is used for drawing rectangles or squares. 	

e.	 The_________________________tool is used for drawing oval shapes and circles.

3.	 Match each term with the statement that best describes it. 

	 PAINT	 A kind of software which is usually used to manipulate 
visual images or creating, editing and managing 2D 
computer graphics.

	 Graphic software 	 A simple graphic program that you can use to create 
drawings on a blank canvas or on top of other pictures. 

	  Crop tool	 The command used to create a mirror image of the picture 
either horizontally or vertically. 

	 Accessories 	 The tool used to crop a picture so only the part you selected 
appears in your picture.

	 Flip command	 Additional programs that help us doing various jobs such as 
painting, creating documents, etc.
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4.	 Answer the following questions.
a.	 What is a Paint program?
b.	 What are the different components of a new Paint window?
c.	 What does Color box indicate?
d.	 	What does the following tools help you to do?
	 i. Line Tool
	 ii. Brush Tool
	 iii. Airbrush Tool
e.	 What is the use of Color picker tool?
f.	 Why do we use Zoom tool?

Lab Exercises
a.	 Draw a rectangle using the tool box and select the same using select tool.
b.	 Draw the following picture using Paint. Select the marked portion and use the Copy 

command. Now use the Paste command to paste it in another location and see what 
happens to your drawing.

c.	 Draw the following figures in different colours using Paint.
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Objectives

After completing this chapter, you will be 
able to:

	Define multimedia. 

	State the advantages of using multimedia.

	Identify the elements of multimedia.

	Identify the hardware and software 
requirements of multimedia.

	Describe the application areas of 
multimedia.

Multimedia
Technology
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Concept: World of Creativity
The computing carried out by the personal computers during the middle of the 20th 
century was based only on text and was suitable for routine tasks such as word processing 
and calculations. This type of computing came to be known as monomedia. But over the 
years, a number of new technologies have emerged and changed the way of computing. 
This new technology uses  a computer-delivered electronic system that allows the user 
to control, combine, and manipulate different types of media, such as text, sound, video, 
computer graphics, and animation. Collectively this new technology came to be known 
as multimedia. 

Hypermedia is an extension to what is known as hypertext, or the ability to 
open new Web pages by clicking text links on a Web browser. Hypermedia 
extends upon this by allowing the user to click images, movies, graphics and 
other media apart from text to create a nonlinear network of information. 
The term was coined by Fred Nelson in 1965. 
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The advantages of multimedia are as follows:

a.	 Multimedia reduces training costs and also makes learning easier, attractive and 
effective.

b.	 Multimedia can be used in classrooms or workplaces as training tools and allows the 
trainer to provide higher quality lessons. 

c.	 The students can hear and see the subjects that they are learning about and bring it to 
life through technology. 

d.	 Multimedia provides high-quality video images and audio. 

e.	 Multimedia offers system portability.

A look to Future

Computer Booths
We are used to telephones in boxes or booths on street corners. 
One day, computers could be as widespread. Computer 
booths could provide you with all the input and output 
devices you need. Go into any booth, insert your disk, scan 
in your photographs, print out your documents. Payment is 
automatic, from money stored electronically on your disk. But 
be quick, other people are waiting!
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Elements of Multimedia
Multimedia is media that uses content in different forms. The six major elements of 
multimedia include text, audio, graphics, animation and video.	

Text
Text is the basic element of multimedia. It involves the use of text types, sizes, colours 
and background colour. It is used to give directions and communicate information, text-
based menus and buttons help guide users through the multimedia application. Text can 
be combined with other media to present information.

Audio
Audio is sound within the acoustic range available to humans. This may include speech, 
audio effects, ambient sound and music. It is the only medium that can accurately provide 
information such as the heartbeat or the sound of the ocean.

Graphics
Computer graphics are graphics created using computers and the representation of image 
data by a computer specifically with help from specialized graphic hardware and software. 
It includes drawings, scanned photographs and images. It helps in making the concepts 
more clear through illustrations and charts. For example, in a multimedia application a 
photograph of a horse along with its textual description makes the illustration much more 
effective.	

Animation
Animation is a series of images that are displayed in rapid succession, giving the illusion of 
movement. In multimedia, digital animation is used. Digital animation can be categorised 
into two broad area: 2D (2 Dimension) and 3D (3 Dimension) animations. It is especially 
useful for illustrating concepts that involve movement. Concepts such as playing a 
guitar or hitting a cricket ball are difficult to explain using a text or a single photograph. 
Animation makes it easier to portray these aspects of the multimedia application.

Video
Video provides a powerful impact in a multimedia program. Video deals with the recording 
and display of a sequence of images at a reasonable speed to create an impression of 
movement. It is an excellent way of conveying the message to the user in a very limited 
time. It is very useful for illustrating concepts that involve movement.
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Basic Multimedia Requirements
A multimedia computer system is a computer equipped with special hardware and 
software that makes multimedia possible. Multimedia computer systems require the 
following components: 
• 	 120MHz Intel Pentium processor or equivalent (audio only) 
•	 16MB of RAM 
•	 28.8Kpbs modem 
•	 16-bit sound card and speakers 
•	 65,000-color video display card (video) 
•	 Windows 95, Windows 98, Windows 2000, Windows 2000 ME (final release version 

only) or Windows NT 4.0 with Service Pack 4 
•	 IE 4.0.1 or Netscape 4.0 or later 

The most commonly used software for creation of graphics, animation, etc. are:	

•	 Corel Draw

•	 Picture Publisher

•	 Photo Magic

•	 Animation Pro

•	 Designer

Facts Corner CorelDraw (styled CorelDRAW) is a vector graphics editor developed and marketed by Corel 
Corporation of Ottawa, Canada.
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Areas of Multimedia
Multimedia is a type of media that provides different content forms such as audio, video, 
text, images, and animations. Multimedia is important in the society for use in business, 
education, and entertainment purposes. It is important in school and business presentations 
by providing learning, especially in group of individuals. In the times to come,  multimedia 
will give a new dimension and a complete new face to this computer industry in the world. 
The following sections examine few uses of multimedia technologies.

Multimedia in Education
Multimedia is extensively used for education and training in schools, businesses and 
in homes. It is extensively used for education to produce computer-based training and 
reference books like encyclopaedia. Computer based training lets the user go through a 
series of presentations and associated illustrations in various information formats. It allows 
the students to learn different subjects at their own pace. It also brings presentations alive 
with sounds, movies, animations, and motivates students to become active participants 
in the learning process. Interactive multimedia programs bring concepts to life and help 
students integrate critical-thinking and problem-solving skills.

Multimedia in Medicine
Multimedia is normally used for different types of presentations and briefings. In medicine, 
multimedia is being used at large scale for training the doctors on surgeries. Multimedia 
is also used for training the doctors in real world operations live from operation theatres. 
Multimedia is also getting more and more grounds in medicine and other high tech fields.

Multimedia in Entertainment Industry
Multimedia is heavily used in the entertainment industry, especially to develop special 
effects in movies and animations. The new breed of games is better designed to take 
advantage of new form of computing. These games are more interactive, using both 
digitized video and standard computer animation.

Knowledge Update

Multimedia classroom simulate classrooms by providing interactive 
learning. Multimedia based education allow visualization of different 
objects, thus making the process of learning easier.  It helps the students 
to find topic on the various subjects and learn at their own pace. 
Multimedia atlases contains maps and illustrations. They present the 
information in a more dynamic way. It produces an animated display 
of the chief characteristics of that country- population, currency, cities, 
water-resources, etc.
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Multimedia at Home
Multimedia Applications are commonly used by people at home for their own 
entertainment, hobbies and leisure. The main categories are
Games
Home entertainment is a rapidly expanding multimedia area due to the development of 
broadband and high-speed processors.  Home users can now enjoy online games, video 
and audio. 
Leisure Pursuits
Leisure pursuits refer to any topic of interest that users may access at home using a 
personal computer.  There are various multimedia software packages that can assist in 
leisure areas such as photography, editing videos, designing graphics or listening to music

Multimedia in Business
Multimedia plays an important role in today’s business. The role of multimedia in 
business can include promoting sales to external clients/customers, through a multimedia 
based presentations; staff training through a multimedia based training/learning media; 
shareholders meetings, where the company (for examples, board members) make 
presentation to their stakeholders and shareholders; and internal meetings on various 
subject matters. 

Virtual Reality
Virtual Reality is an artificial reality that 
projects the user into a 3D space generated 
by the computer. The user wears a headset 
that contains two screens-one in front of 
each eye. The brain combines the screen 
images to create a three-dimensional (3D) 
scene. The headset plays stereo sounds-one 
into each ear-which the brain combines for 
a surround-sound effect. In addition, many 
systems make use of gloves, shoes and 
even whole suits with sensors to detect the 
user’s movement. VR is currently used in 
applications such as aircraft pilot training, 
medical rehabilitation, training for surgical 
procedures, engineering and scientific 
visualization, manufacturing design, the 
control of remote (tele-operated) vehicles, 
and computer games.
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Multimedia	 :	 The combination of multiple media such as text, high-quality 
sound, two and three dimensional graphics, animation, photo 
images and full-motion video. 

Graphics 	 :	 The creation and manipulation of picture images in the computer. 

Animation	 :	 A series of images that are displayed in rapid succession, giving 
the illusion of movement.	

Resolution 	 :	 The degree of sharpness of a displayed or printed character or 
image. 

Virtual Reality	 :	 A technology that allows people to enter and interact with three-
dimensional computer graphics world. 

Tricky Terms

Let 
Us Revise
•	 Multimedia is the use of computers to present text, graphics, video, animation, and 

sound in an integrated way.
•	 Computer graphics are graphics created using computers and the representation of 

image data by a computer specifically with help from specialized graphic hardware 
and software.

•	 Animation is a series of images that are displayed in rapid succession, giving the 
illusion of movement.

•	 A multimedia computer system is a computer equipped with special hardware and 
software that makes multimedia possible. 

•	 Multimedia system requires faster CPU for quicker processing of large amount of 
data.

•	 Multimedia is extensively used for education and training in schools, businesses and 
in homes. 

•	 Computer based training lets the user go through a series of presentations and 
associated illustrations in various information formats. 

•	 In medicine, multimedia is being used at large scale for training the doctors on 
surgeries.

•	 Multimedia is heavily used in the entertainment industry, especially to develop special 
effects in movies and animations.

•	 Virtual Reality is an artificial reality that projects the user into a 3D space generated 
by the computer.
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Solved Exercises
1.	 What is multimedia? What are the main elements of a multimedia program?	
Ans: 	 Multimedia is a computer-delivered electronic system that allows the user to control, combine and manipulate 

different types of media. The main elements of a multimedia program are text, images, movies, animation, sound 
and user controls.

2.	 State two advantages of multimedia technology.	
Ans: 	 The two advantages of multimedia technology are listed below:
	 •	 Multimedia reduces training costs and also makes learning easier, attractive and effective
	 •	 Multimedia can be used in classrooms or workplaces as training tools and allows the trainer to provide higher 

quality lessons. 
	 •	 The students can hear and see the subjects that they are learning about and bring it to life through technology.  

3.	 What is a multimedia computer system? What are the components of multimedia setup?	  
Ans: 	 A multimedia computer system is a computer equipped with special hardware and software that makes 

multimedia possible.	 The components of multimedia setup are listed below:
	 • 	 Faster CPU (for quicker processing),
	 • 	 Larger storage devices (for storing large data files),
	 • 	 Larger main memory (for running programs with large data size),	
	 • 	 Super VGA monitors with high resolution for displaying graphics, animation and video, and 
	 • 	 Sound card and speakers to play any audio associated with a multimedia application program.

4.	 What is the role of multimedia in education?	
Ans: 	 Multimedia is extensively used for educational training in schools. It allow students to function as designers, using 

tools for analyzing the world, accessing and interpreting information, organizing their personal knowledge, and 
representing what they know to others. Multimedia applications engage students and provide valuable learning 
opportunities. Multimedia based education provides the student with options of individual attention at his own 
pace. 

5.	 What is virtual reality? Where is it used?	
Ans: 	 Virtual reality is an artificial world that consists of images and sounds created by a computer and that is affected 

by the actions of a person who is experiencing it. Virtual reality is currently used in applications such as aircraft 
pilot training, medical rehabilitation, training for surgical procedures, engineering and scientific visualization, 
manufacturing design, the control of remote (tele-operated) vehicles, and computer games.
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Chapter Review
1.	 State whether the following statements are true or false. 
a.  	 The computing carried out by the personal computers during the middle of the 20th 

century was based only on text and was suitable for routine tasks such as word 
processing and calculations. 

b.	 Computer animations are graphics created using computers and the representation of 
image data by a computer specifically with help from specialized graphic hardware 
and software. 

c.	 Multimedia is important in the society for use in business, education, and entertainment 
purposes. 

d.	 Multimedia is heavily used in the entertainment industry, especially to develop 
special effects in movies and animations.

e.	 VR is currently used in applications such as aircraft pilot training, medical 
rehabilitation, training for surgical procedures, engineering and scientific 
visualization, manufacturing design, the control of remote (tele-operated) vehicles, 
and computer games.

 
2.	 Fill in the blanks. 
a.  	 ____________________is the use of computers to present text, graphics, video, 

animation, and sound in an integrated way.
b.	 _______________________is a series of images that are displayed in rapid 

succession, giving the illusion of movement. 
c.	 A__________________is a computer equipped with special hardware and software 

that makes multimedia possible. 
d.	 Multimedia is heavily used in the__________________, especially to develop special 

effects in movies and animations.
e.	 ___________________is an artificial reality that projects the user into a 3D space 

generated by the computer. 

3.		 Give the appropriate technical term for each of the following statements.
a.	 The combination of multiple media such as text, high-quality sound, two and three 

dimensional graphics, animation, photo images and full-motion video. 
b.	 The creation and manipulation of picture images in the computer. 
c.	 A series of images that are displayed in rapid succession, giving the illusion of 

movement.	
d.	 A technology that allows people to enter and interact with three-dimensional computer 

graphics world. 
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4.	 Select the best answer from the list of choices.

a.	 A type of media that provides different content forms such as audio, video, text, 
images, and animations. 

		 i. 	 Monomedia  				    ii.  Multimedia

	 iii. Hypermedia				    iv. All of the above

b.		  The process of displaying still images in a rapid sequence to create the illusion of 
movement. 

		  i. 	Text				   ii.  Graphics 

		  iii. Video				   iv.  Animation	

c.		  In order to work with multimedia, a personal computer typically requires the 
following hardware components:	

		  i. 	Faster CPU			   ii. Large main memory

		  iii. All of the above			   iv. None of the above

d.		  An artificial world that consists of images and sounds created by a computer and 
that is affected by the actions of a person who is experiencing it.	

		  i.	Multimedia Kiosks			   ii. Virtual Computer

		  iii. Virtual Reality			   iv. None of the above

5.	 In your own words, briefly answer the following questions.

a.		 What is multimedia? 

b.	 What are the different types of media in a multimedia? 

c.	 What do you mean by animation? Why is it important in multimedia application?

d.	 What is a multimedia computer system? What are the  hardware components of 
multimedia system?

e.	 What is the role of multimedia in education?

f.	 How is multimedia useful at home?

g.	 What is the importance of multimedia in business?

h.	 What is virtual reality?



15 QBASIC
Programming

Objectives

After completing this chapter, you will be 
able to:

	Explain the different QBASIC menu 
options.

	Identify and explain the important 
elements of QBASIC programming.

	Explain the precedence of operators.

	Explain the purpose and syntax of QBASIC 
statements.
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Introduction
BASIC (Beginners’ All Purpose Symbolic Instruction Code) is one of the easiest 
high level programming languages. It allows the usage of English-like language and 
uses mathematical notation. It was developed in 1964 at Dartmouth College, U.S.A. 
by Professors John Kemeny and Thomas Kurtz. Originally, it was developed as an 
interactive language for mainframes. Since, its development BASIC has undergone many 
modifications and improvements and now many versions of BASIC are available, each 
version having some extra features. Some of the versions of BASIC are GW-BASIC, 
QBASIC and Visual BASIC. 

QBASIC is a high level computer language published by Microsoft. QBASIC environment 
includes a full screen syntax checking, multi-file and multi-window editing, full debugging 
facilities, pull-down menus, syntax-checking editor and a simple yet a powerful menu 
structure that can be driven through either by a keyboard or a mouse. Once you are in the 
QBASIC environment you can edit, run, debug, and rerun the program without switching 
programs. 

Program Area

Horizontal Scroll Bar

Status Bar

Immediate Mode Area

Vertical Scroll Bar

Menu Bar

Visual Basic is a third-generation event-driven programming language 
and integrated development environment from Microsoft for its COM 
programming model first released in 1991. Visual Basic was derived from 
BASIC and enables the rapid application development (RAD) of graphical 
user interface (GUI) applications.
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Elements of QBASIC Programming
The important elements of QBASIC program are:
•	 QBASIC character set	
•	 Variable	
•	 Constant
•	 Operator and expression
•	 Keywords (Reserved words)

Character Set
The QBASIC character set is a set of symbols used to frame the various components of a 
program. The character set consists of digits, letters and special characters that are valid 
in QBASIC. The QBASIC has the following character set:
•	 Alphabets	 :	 A to Z (small and capital letters)
•	 Numbers	 :	 0 to 9
•	 Special characters	 :	 ;  = + -* / ^ ( ) % $ # ! , .’ “ :	 & ? < > \ -

Variable
Variables are programmer-defined areas in the computer’s memory for storing data. 
The data stored in a variable can change during the execution of the program as per the 
requirements and functionality of your program. However, the name of the variable in a 
program remains unchanged. This is the reason why variables are very easy to use. The 
variables are of two types: numeric variable and string variable depending on the kind of 
data item they represent.

Numeric variable
The numeric variable has a number as its value. It must begin with an alphabet and the 
remaining characters, if used, may be alphabets or digits or both. Some of the valid 
numeric variables are a1, area and weeks7.

String variable
The string variable has a string of characters or alphanumeric as its value. It must begin 
with an alphabet and end with a dollar($) sign. Mathematical calculations cannot be 
performed using string variables. Some of the valid string variables are A$ AND t1$.
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Constant
Constant is a data item whose value does not change during the execution of a program. 
It is also called literal. Constants are of two types: numeric constant and string constant. 

Numeric constant
Numeric constant is a sequence of positive or negative numbers on which mathematical 
operations can be performed. They are entered in the same form.  Commas are not allowed 
in a numeric constant. Some of the valid numeric constants are 52, -20, +74 and 29.

String constant
 String constant is a sequence of characters which may include numbers, letters, and 
certain special characters enclosed in quotation marks. It is used to represent non-numeric 
information such as names, addresses, class, sections, etc.

REM “This program has constant and variable”

apples = 20

PRINT “Today we sold “; apples; “ bushels”;

PRINT “ of apples.”

ENDSo
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Operator and Expression
Operators are the symbols representing the operations they perform. Operator helps to 
convert one or more values into a single value. The values on which the operators work 
are referred to as operands.
A combination of an operator and its operands is referred to as an expression. Operators 
are used in expressions to store or return a value. Look at the following statement:
	 sum = 21 + 6
Since 21 + 6 has a value, it is an expression. Its value, 27, is stored in the variable sum. 
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Expressions do not have to be in the form of mathematical operations. In the following 
statement, 3 is an expression.
number = 3
QBASIC offers different classes of operators: arithmetic, relational, logical and string 
operators.

Arithmetic operators
Arithmetic operators are the operators that operate on numeric constants and variables. 
They are used to perform various mathematical operations. The general format of 
arithmetic operator is: 

operand1 arithmetic_operator operand2 

The arithmetic operators, in order of precedence, are listed below:	

Note: 
Operations within parenthesis are performed first. Inside the parenthesis, the usual order 
of precedence is maintained. It is always a good idea to put parenthesis around the 
expression. Some advanced operators will produce unexpected results otherwise.

The table given in the next page shows sample algebraic expression and their BASIC 
counterparts:

 Operator	 Description	 Example

^ 	 Raises a number to the power of another	 x = y^z

*	 Multiplies the operands	 x = y * z

/	 Divides the left operand by the right operand	 x = y/z

\	 Divides an integer and returns the number of	 x = y\z

	 times one integer can be evenly divided into 

	 another

Mod	 Divides the left operand by the right operand	 x = y mod z 

	 and returns the remainder	

+	 Adds the operands	 x = y + z

-	 Subtracts the right operand from the left 	 x = y - z

	 operand
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 Algebraic Expression	 BASIC Expression

5a + 6b	 5*a + 6*b

a2 + b2	 a^2 + b^2

2 (l + b)	 2*(l + b)

(3a - 4b)/c	 (3*a - 4*b)/c	

4x2+3	 4 * x^2 + 3	

( 2a )b	 ( 2*a ) ^ b

Relational operators
Relational operators are used to compare two values of same type, either both numeric or 
both string. The general format is: 

operand1 relational_operator operand2
The relational operators supported by QBASIC are:

 Operator	 Description	 Example
=	 Compares two numbers and evaluates	 A = B
	 them to true if the operands are equal		
<	 Compares two numbers and evaluates	 A < B
	 them to true if the left operand is 
	 less than the right operand	
>	 Compares two numbers and evaluates	 A > B
	 them to true if the left operand is 
	 greater than the right operand		
<=	 Compares two numbers and evaluates	 A < = B
	 them to true if the left operand is 
	 less than or equal to the right operand	
>=	 Compares two numbers and evaluates	 A > = B
	 them to true if the left operand is 
	 greater than or equal to the right operand	
<>	 Compares two numbers and evaluates	 A < > B
	 them to true if the operands are not equal
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Logical operators
Logical operators are used to connect two or more relational expressions to evaluate a 
single value as True or False. The general format is: 	

Operand1 logical_operator operand2

The logical operators supported by QBASIC are:

 Operator	 Description	 Example

AND	 Evaluates to true when both conditions	 A>B AND

	 are true	 A>C

OR	 Evaluates to true when one or both 	 A>B

	 conditions are true	 OR A>C

NOT	 Reverses a condition. It makes a true 	 A NOT B

	 expression false, and a false expression true.

Concatenation operators
An expression involving string variables and constants are called string expression. 
Concatenation operators connect multiple strings into a single string. QBASIC use the 
plus sign (+) as a string concatenation operator.

Keywords (Reserved words)
Keywords are the words that convey a special meaning to the language. These are 
reserved for special purpose and must not be used as normal identifier names. Some of 
the QBASIC keywords are: REM, CLS, INPUT, LET, PRINT and END.

A$ = “Programming”

B$ = “great fun.”

C$ = A$ + “is” + B$	 ‘Plus sign (+) connects multiple 
strings.

PRINT C$

END

So
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Program Output
Programming is great fun.
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QBASIC Statements
QBASIC statement is a meaningful expression or an instruction in a source language. 
Each statement is followed by a RETURN key. These statements are first stored in the 
memory and executed only when the command RUN is given. It is either executable or 
non-executable. Executable statements are program instructions that tell BASIC what 
to do during the execution of a program. Non-executable statements do not cause any 
program action. The statements can be divided into four categories: declaration statement, 
assignment statement, input/output statement and control statement.

REM Statement
The REM statement is a non-executable statement. It is used to include explanatory 
remarks to be inserted in a program, which are very useful to explain what a program does 
and what specific lines of code do. This statement can be used anywhere and any number 
of times in a program. They are intended for people who may be reading the source 
code. This statement can be used anywhere and any number of times in a program. An 
apostrophe ( ‘ ) may be used instead of REM. The general format of REM statement is:

REM <remark>  or  ‘ <remark>

CLS Statement
CLS statement is used to clear the output screen. It makes the screen completely blank. 
This command is generally given before the start of any program so that there is a fresh 
screen and any left over from the previous program is cleared completely. The general 
format of CLS statement is:

CLS

REM “This program calculates the area of a circle” 

PI = 3.14159

LET R = 8

‘ Calculates the area of circle.

Area = PI * (R ^ 2)	

‘ Displays the area of circle.

PRINT “The area of circle is:::”; Area	

END
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INPUT Statement
The INPUT statement is used to accept input from the keyboard during program execution. 
It facilitates the use of same program for various sets of data to obtain different results 
in different executions. During the execution of a program, when the control comes to 
INPUT statement, a question mark appears on the screen and waits for data to be input on 
the keyboard. Unless a response is entered, the control does not move to the next line. The 
type of data item in the response (numeric or string) must agree with the type specified 
by variable and the number of data items supplied by the user must be the same as the 
number of variables listed in the statement. The general format of INPUT statement is:

INPUT [“definer”; | ,] list of variables

INPUT “Enter the side of a cube”;l

volume = l ^ 3

tsa = 6 * l ^ 2

PRINT “Volume of a cube”;volume

PRINT “Total surface area”; tsa

END
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LET Statement
LET is an assignment statement used to assign the value of an expression to a variable. 
LET is an optional keyword i.e., the equal sign is sufficient when assigning an expression 
to a variable name. The type of the expression (string or numeric) must be the same as the 
type of the variable. Otherwise a “Type mismatch” error will occur. The general format 
of LET statement is:

LET <variable> = <expression>

CLS	 ‘ Clears the screen

REM “Calculate the area of a rectangle”

LET length = 30

LET breadth = 20

LET area = length * breadth	 ‘ Calculates the area of rectangle

PRINT “The area of rectangle is’’ ; area

END
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PRINT Statement
PRINT statement is used to display data on the screen. This statement will print constants, 
variables or expressions. A question mark (?) may be used instead of the word PRINT. 
The general format of PRINT statement is:	

PRINT [list of expressions] [, | ;] 

	         or

? [list of expressions] [, | ;]

Print positions
BASIC divides the line into print zones of 14 spaces. The position of each item displayed 
on the screen is determined by the punctuation used to separate the items in the list. 
The separator and print position is described below:

INPUT “Enter a student’s name:”;n$

INPUT “Enter marks in subject1”; m1

INPUT “Enter marks in subject2”; m2

INPUT “Enter marks in subject3”; m3

total = m1 + m2 + m3

avg = total / 3

PRINT “The student’s name is:”;n$

PRINT “The marks in subject1:”;m1

PRINT “The marks in subject2:”;m2

PRINT “The marks in subject3:”;m3

PRINT “The average score is:”;avg

END

Separator	 Print Position

,	 Zonewise 

;	 Side by side

space(s)	 Immediately after the last value
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END Statement
END statement denotes the end of the program. Once the program encounters the END 
statement, the computer stops processing any further as it has reached the termination 
point. It must be written as the last statement in every program. The general format of the 
END statement is:	  

END

Control Statements
A computer program is a set of statements which are normally executed in the 
sequential order i.e. they appear in order from top to bottom. The programs in which 
these statements are sequentially executed are called sequential control structure 
programs. Sometimes it becomes necessary to change the order of execution of 
the statements, or to repeat a particular series of statements until certain specified 
conditions are met. This facility is provided by means of control statements. Some of 
the control statements available in QBASIC are GOTO, IF...THEN and FOR...NEXT.

GOTO Statement
The GOTO statement is the simplest of all the control statements. It allows an unconditional 
transfer of control from one part of the program to the other without performing a test. 
The general form of the GOTO statement is:	 

GOTO <line number | line label>

INPUT “Enter the length of a rectangle”; l	

INPUT “Enter the width of a rectangle”; w	

Area = l * w

PRINT “The area of the rectangle is:::”; Area	

ENDSo
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x = 1
top:
y= x^2
PRINT y
x=x+1
GOTO top
ENDSo
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IF...THEN Statement
The IF...THEN statement is used for making decisions or comparisons. It allows us to 
specify a condition with the IF keyword. If the condition evaluates to true the control of 
execution is transferred to the statement that lies immediately after the THEN keyword 
otherwise next executable statement following the IF...THEN statement will be executed. 
The general form of the IF...THEN statement is:

IF <condition> THEN <statement>

dis = 0
INPUT “Enter quantity”; q
INPUT “Enter rate”; r
IF (q > 1000) THEN dis = 10
total = (q * r) - (q * r * dis / 100)		  ‘Calculates the total expenses
PRINT “Total Expenses = “; total
ENDSo
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FOR...NEXT Statement
The FOR...NEXT statement is used to repeat a series of instructions for a given number of 
times. The FOR statement is placed at the beginning of the loop and the NEXT statement 
at the end of the loop. The general format of the FOR...NEXT is:

FOR <counter variable>=<initial value> TO <final_ value> STEP <n>

	 <statements to be repeated>

NEXT <control variable>

FOR x = 1 TO 25

PRINT x ;

NEXT x

END
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In the above program, the counter variable x is assigned the initial value of 1. This value 
of the counter variable x is compared with the final value 25. If it exceeds the final value, 
control skips to the statement following the NEXT statement (i.e., to the END statement). 
The statement between the FOR and the NEXT statements, i.e, the 2nd statement is 
executed if x is less than or equal to 25. The counter variable is incremented by the step 
value, i.e.,1.
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Variable	 The named storage location in the computer’s memory.

Constant	 The values stored in a program, which do not change during 
the program execution.

Operator	 The special symbols or words used to describe an operation 
or an action, which is to be performed between two or 
among more than two values.

Syntax	 A formal rule governing the construction of valid statement 
in a language.

Keyword	 A word carrying special meaning and purpose for a language.

Tricky Terms

Let 
Us Revise
•	 ASIC was developed in 1964 at Dartmouth College, U.S.A. by Professors John 

Kemeny and Thomas Kurtz.
•	 QBASIC is a popular, easy to learn high level programming language developed by 

Microsoft Corporation.
•	 Variables are the named storage location in the computer’s memory.
•	 Constants are the values stored in a program, which do not change during the program 

execution.
•	 Operators are special symbols or words used to describe an operation or an action, 

which is to be performed between two or among more than two values.
•	 Precedence is the order in which a program performs/evaluates the operation in a 

formula.
•	 An expression is any valid combination of operators and operands.
•	 A keyword is a word carrying special meaning and purpose for a language.
•	 A statement is a group of BASIC keywords generally used in program lines as part 

of a program.
•	 The REM statement is used to include remarks in a program.
•	 The CLS statement clears the screen.	  
•	 The LET statement is used for storing a value in a variable.
•	 The INPUT statement is used to accept input from the keyboard during program 

execution.
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Solved Exercises
1.	 Write a program that calculates the area of a circle. The formula for the area of a circle is pi times the radius 

squared.	
Solution:
	 CONST PI = 3.14159
	 LET R = 8
	 Area = PI * (R ^ 2)
	 PRINT “The area is :::”; Area
	 END

2.	 Write a program that calculates the area of a rectangle. The formula for the area of a circle is length multiplied by 
breadth.

Solution:
	 INPUT “Enter the length of a rectangle”; L	
	 INPUT “Enter the breadth of a rectangle”; B	
	 A = L * B  
	 PRINT “The area of a rectangle is’’ ; A
	 END 

3.	 Write a program to find the perimeter of a rectangle supplying the length and breadth.
Solution:
	 INPUT “Enter a length “; L
	 INPUT “Enter a breadth”; B
	 Perimeter = 2 * (L + B)
	 PRINT “Perimeter is “; Perimeter
	 END

4.	 Write a program to input three numbers and find the greatest number.
Solution:
	 INPUT “Enter first number”; a
	 INPUT “Enter second number”; b
	 INPUT “Enter third number”; c
	 IF a > b AND a > c THEN
                PRINT a; “ is the greatest number”
		 ELSEIF b > c THEN
                PRINT B; “is the greatest number”
	 ELSE
                PRINT C; “is the greatest number”
	 END IF
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5.	 Write a program to input three sides of a triangle and determine whether a triangle can be formed or not.
Solution:
	 INPUT “Enter sides of a triangle”;a,b,c
	 IF (a+b)>c and (b+c)>a AND (c+a)>b THEN
		 PRINT “The triangle exists” 
	 ELSE 
		 PRINT “The triangle does not exist”
	 END	
	
6.		 Write a program to generate the following pattern:	
	 1
	 11
	 111
	 1111
	 11111
Solution:
	 a = 1
	 FOR i = 1 TO 5
		 PRINT a
		 a = a * 10 + 1
	 NEXT
	 END
	
7.	 Write a program to generate the following pattern:
	 1
	 121
	 12321
	 1234321
	 123454321
Solution:
	 DEFDBL A
	 a = 1
	 FOR i = 1 TO 5
		 PRINT a * a
		 a = a * 10 + 1
	 NEXT
	 END	
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Chapter Review
1.	 State whether the following statements are true or false. Rewrite each false 

statement to make it a true statement.	
a.	 The ________________ statement is used for storing a value in a variable.
b.	 The  ________________ statement is used to accept input from the keyboard during 

program execution.
c.	 The ________________ statement is used to display data or the results of calculation 

on the screen.
d.	 The ________________ statement is used for making decisions as well as 

comparisons.
e.	 The ________________ statement is used to execute a series of instructions for a 

given number of times. 	

2.		 Write QBASIC expressions for the following algebraic expressions:	
	 a. 4x + 5y		 b. x3 + y3	 c. nr2+KT	 d. 2b + 4c(k3)		 e. ut + gt2 

3.	 Write assignment statements for the following.	
a. 	 Add 3 to a and stores the result in b.
b.	 Multiply b times 2 and stores the result in a.
c.	 Divide a by 3.14 and stores the result in b.
d.	 Subtract 5 from b and stores the result in a.
e.	 Join the strings “PUB” and “LISHERS” and store them in X$. 

4.	 Answer the following questions.
a.	 What is a BASIC program?  Who developed BASIC program?	
b.	 What are the important elements of QBASIC programming language?
c.	 What are variables and constants?
d.	 Differentiate between a numeric variable and a string variable.
e.	 What are operators? State the rules of logical operators.	
f.	 What is a statement? 
g.	 Differentiate between executable and non-executable statements.
h.	 What is the difference between LET and INPUT statements?
i.	 What is a control statement? List some of the control statements available in QBASIC.
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5.	 What will each of the following programs display?	
a. 	 LET p = 50	 b.	 LET L = 5
	 LET r = 2		  LET B = 2
	 LET t= 5		  LET A = 2 * (L + B)
	 LET i = (p * r * t)/100		  PRINT S
	 PRINT i		  END
	 END		

c.	 FOR I =10 TO 1 STEP -1	 d.	 FOR J = 2 TO 8
	 PRINT I, I*I		  PRINT J
	 NEXT I		  NEXT J
	 END		  END

6.	 The sales tax on an article is 25% of its price. Write a program to find the sales tax on 
an article priced at Rs. 200.

7.	 Write a program to find the simple interest on Rs.3000 for 5 years at the rate of 5% 
per annum. 

8.	 Write a program to calculate the area of a triangle. (area = 1/2 * base *height)

9.	 Write a program to input the side of a cube.  Print the volume of a cube. (Hint: 
Volume of Cube =  Length ^ 3 )

10.		 Write a program to compute the area and perimeter of a circle for a given radius r.

11.		 Write a program to input principal, rate and time and find the simple interest.

12.		 While purchasing certain items, a discount of 10% is offered if the quantity purchased 
is more than 1000. If quantity and price per item are input through the keyboard, 
write a program to calculate the total expenses.

13.		 Write a program to print the first ten natural numbers. (Use FOR...NEXT)

14.	 Write a program to print the first ten even numbers. (Use WHILE...WEND)

15. 		Write a program to print out the multiplication table of 2. (Use DO...LOOP)

16.		 Write a program to generate the following series: (Use all the looping statements)

	 a.	 1, 4, 9, 16, 25

	 b.	 1,.3,.05,.007,.0009

	 c.	 5, 25, 125, 625, 3125	
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Lab Exercises
Lab Exercise 1
1.		 Write a program to input the values of two angles and find out the third angle of a 

triangle. (Hint: The sum of all the three angles of a triangle is 180°.) 
2.	 Write a program to input a student’s name and marks in three subjects. Write a 

program to calculate the average score and print all this information in separate line 
with proper prompt. 

3.	 Write a program that displays the following information, each on a separate line: 
Your name, address, telephone number and school name.

Lab Exercise 2
1.	 he room is 5 m long, 3 m wide and 2 m high. Write a program to find the cost 

of painting its four walls at Rs. 130 per square metre. (Area of four walls = 2h(l 
+b).	

2.	 The cost of a book is Rs 500. What will be the cost of 5 such books. Write a simple 
program.

3.	 The metre charges for a taxi is Rs. 320 per km. Write a program to input the distance 
and calculate the taxi fare.

Lab Exercise 3
1.	 Write a program to input sales amount for a salesman. Print sales commission using 

the following ranges of values.
	 Sales Amount	 Commission
	 Below 5000	 10%   
	 >=5000 and <10000	 15%
	 >=10000	 25%
2.	 Write a program to print natural numbers from 1 to 20.	
3.  	 Write a program to print all odd numbers between 1 and 25.	

Lab Exercise 4
1.	 Write a program to input marks in English, Computer and Mathematics. Calculate 

the total and percentage. If the percentage is equal to or greater than 40, then print 
“PASSED” otherwise print “FAILED”.

2.	 Write a program to print all the odd numbers from 1 to 100 and display them. 
3. 	 Write a program to print out the multiplication table of 5.	
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Ty
ps

ha
la

Introduction

Touch typing is a popular technique for using the computer keyboard much quicker and 
more accurately. Specifically, a touch typist will know their location on the keyboard 
through muscle memory. Touch typing typically involves placing the eight fingers in a 
horizontal row along the middle of the keyboard (the home row) and having them reach 
for other keys. Touch typing can be done using two hands or possibly only with one.

On a standard keyboard for English speakers the home row keys are: “ASDF” for the left 
hand and “JKL;” for the right hand. The keyboard is called a QWERTY keyboard because 
these are the first six letters on the keyboard. Most modern computer keyboards have a 
raised dot or bar on the home keys for the index fingers to help touch typists maintain and 
rediscover the correct position on the keyboard quickly with no need to look at the keys.
Typshala is a typing tutor that provides free hand typing and entertains the user with a 
game.
To start typshala,  follow these steps:
a. 	 Click on Start.
b. 	 Click on Typshala. Typshala program appears on the screen.
c.	 Click on Home.
d.	 Choose ‘Level 1’. 
e.	 Click on OK.
f.	 Choose writing script. 
g.	 Start typing.
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Lesson Exercise 1
a.	 Choose English Script from the Options menu.

b.	 Choose Lessons | Home Row | Level 1. Now, start typing

	

c.	 Choose Lessons | Home Row | Level 2. 

d.	 Choose Lessons | Home Row | Level 3. 
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Lesson Exercise 2
a.	 Choose English Script from the Options menu.

b.	 Choose Lessons | Top Row with Home Row | Level 1. Now, start typing

	

c.	 Choose Lessons | Top Row with Home Row | Level 2 

d.	 Choose Lessons | Top Row with Home Row | Level 3
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Lesson Exercise 3
a.	 Choose English Script from the Options menu.

b.	 Choose Lessons | Bottom Row with Home Row | Level 1. Now, start typing

	

c.	 Choose Lessons | Top Row with Home Row | Level 2 

d.	 Choose Lessons | Top Row with Home Row | Level 3


